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Chapter 1

Using Documaker Studio

Documaker Studio is a multi-user forms development 
system that promotes workgroup and team-based 
development methodologies. Documaker Studio 
tackles the complex development process for building 
and maintaining large electronic forms libraries.

Documaker Studio is designed for forms and business 
analysts who work to meet the requirements defined 
the compliance group and create the dynamic 
document applications that are provided to the 
production operations teams.

This document includes information on these topics:

• Introduction on page 2

• Creating a Multi-user Development Environment 
on page 6

• Starting Studio on page 10

• Using System Menus on page 14

• Creating Workspaces on page 24

• Joining a Workspace on page 30

• Working with Settings and Users on page 33

• Working with Business Units on page 65

• Working with Group Forms on page 77

• Managing Forms on page 87

• Working with Images on page 113

• Working with Logos on page 139

• Creating Scripts on page 157

• Managing Resources on page 171

• Using Dictionaries on page 259

• Creating Tables on page 265

• Converting Files on page 271

• Printing Reports on page 287

• Handling Fonts on page 293

• Testing Your Forms on page 297

• Deploying a Library on page 319
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INTRODUCTION Documaker Studio provides a new and integrated way to create and maintain the 
images, logos, fields, and other objects you use in your form sets. Studio also provides 
tools for managing these objects in libraries and for testing and deploying form sets.

NOTE: Licensed users of Documaker (RP) Server or Documaker (RP) Workstation, and 
Docucreate (RP) are eligible to receive Documaker Studio as part of their 
maintenance agreement. The Documaker product has a high degree of 
compatibility with the DAP (Document Automation Platform) Solution Suite. 
DAP users should check with their account representative to explore the 
advantages of upgrading to Documaker.

The main features and benefits of Studio include:

• Seamless workbench. While its predecessor provided a menuing system to access 
all of the graphical tools and many of the conversion tools, Studio greatly 
enhances the way the tools work together. For example, you can now drag and 
drop a field database entry onto an image. Furthermore, you can have several 
tools, and even multiple copies of those tools, open at the same time.

• Editing Forms. Studio makes it easy to edit forms by providing easy access to both 
the tree view and graphical view of the selected form components, as well as a 
Trigger wizard for specifying trigger logic. SetOrigin specification of the absolute 
or relative placement of image sections (FAP files) is now done visually. Header, 
body, and footer images are automatically organized into a easier to manage tree 
view. Image and form attributes are easier to access and modify. Recipients are 
easier to specify. Multi-user development is easier since each developer can work 
on one or more forms at a time without impacting other developers.

• Configuring INI options. You can now load and maintain the INI options which 
control your system from inside Studio. You can maintain these options at the 
global (system), local (unique to a developer), or deployment (specifying unique 
platforms, data sources, locations, and devices) level.

• Creating DAL Scripts. DAL (Document Automation Language) offers a high degree 
of power and flexibility for form and section triggering logic and also for data 
manipulation and formatting. While other means of triggering sections and 
manipulating data are still supported, you’ll enjoy the benefits and ease of use 
DAL offers. Studio includes a powerful new script editor for maintaining DAL 
libraries, including effective date version control and check-in and check-out.

• Visual Debugger. Dynamic documents cannot truly be viewed without running the 
rules against test data. Studio includes a new visual testing tool that makes it easy 
to see how documents will look when run against real data. The ability to set break 
points and view internal variables while watching the document assemble visually 
makes it easy to debug problems in the form design.

• Import Wizards. The version 11.0 runtime works with older configurations, 
however, taking advantage of the new Studio and its new files requires a forward 
migration. Studio includes powerful wizards to make it quick and easy to move an 
existing implementation forward to version 11.0 library members.
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• Form-level effective dates. Effective date based version control (including check-
in, check-out, and expiration) can now be applied to forms. Previously this 
capability applied only to sections of forms, such as FAP files, and their related 
DDT files. Many implementations creatively combined a large number of physical 
images into a more complex logical form, and the need for effective date 
versioning at the true form level became apparent. Adding this capability requires 
a new library member: the form (FOR) file and a new tool to maintain the objects 
and attributes of that file.

• Multi-user form development. Versions prior to 11.0 stored form level attributes in 
a number of places: the FORM.DAT file, the SETRCPTB.DAT file, other supporting 
tables, and DDT files. By consolidating logical form attributes into a single file, not 
only is it possible to do effective date version control on a form, but it is also easier 
to facilitate multi-user form development. 

• New files. The elimination of the FORM.DAT and SETRCPTB.DAT files and the 
introduction of FOR files also resulted in the addition of two new types of resource 
members: the base definition (BDF) file which defines the combinations of keys 
that represent the business units into which the forms are assembled, and the 
group (GRP) file which provides the default ordering sequence for the form 
candidates that are available to each business unit. 

• Eliminating DDT files. DDT files were introduced as a way to isolate variable data 
tag information that would be applied to static form overlays. By separating this 
information from the FAP files, it was possible to achieve a higher degree of 
performance in simpler implementations. Over time, as advanced formatting 
capabilities were devised to meet customer needs, it became necessary for the 
FAP files to be available at runtime because more and more documents began to 
be subject to dynamic composition at runtime. The DDT file became less of an 
advantage, and even a stumbling block within implementations.

In spite of synchronization facilities in the tools, some implementations struggled 
to keep DDT and FAP files in sync. With version 11.0 and the introduction of the FOR 
file, DDT files are eliminated. Image and field-level DDT rules previously stored in 
the DDT file are now either unnecessary or are stored in the FAP file. Having image 
level rules (such as SetOrigin) in the FOR file makes it easier to do visual form 
design. Having field level rules in the FAP file eliminates synchronization worries.

The following pages discuss some of these enhancements in more detail.
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STUDIO OPTIONS Most options in Documaker Studio are used to create the resource objects that make 
up a Master Resource Library (MRL). The options appear when you open a workspace:

These resource objects are eventually used during the form entry process (Documaker 
Workstation) or in the forms processing cycle (Rules Processor). In some cases, the 
objects are used during both processes.

The options you can use are 
listed here

You can also select these 
options from the Manage 
menu

Used during form

Option Used to Entry Processing Required?

Business units Define valid key combinations. Yes Yes Yes

Group forms Define the list of forms available to 
a business unit.

Yes Yes Yes

Forms Create a list of the images that 
comprise the form and to store 
triggering information.

Yes Yes Yes

Images Create and manage the images 
that make up the forms.

Yes Yes Yes

Logos Resize, reverse, rotate, and 
manipulate bitmap graphics used 
on images.

Yes Yes No

Scripts Create scripts to automate tasks. 
You create these scripts using the 
Document Automation Language 
(DAL).

Yes Yes No
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Libraries Manage the libraries that contain 
the forms, images, logos, and 
other resources.

Yes Yes Yes

Dictionaries Create and maintain mapping 
information for runtime data files 
and common field information so 
setting up and creating variable 
fields is easier.

 Extract No Yes ?

Rule No Yes No

Fields Yes Yes No

Tables Define the format and create the 
tables you use.

Batch No Yes No

Entry Yes No No

Definitions Yes Yes No

Conversion Yes Yes No

Fonts Create and maintain the table 
which serves as the bridge 
between the system and your 
fonts.

Yes Yes Yes

Tests Define and process test situations 
that simulate your production 
environment.

Yes Yes No

Deploy Help you move your finished 
libraries into production mode.

Yes Yes No

Used during form

Option Used to Entry Processing Required?
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CREATING A
MULTI-USER

DEVELOPMENT
ENVIRONMENT

Documaker Studio provides for multi-user development cycles. For several users to 
work on a given set of resources, the system must be able to manage the resources to 
prevent conflicts.

The key to effectively managing libraries of resources is in the files used to store 
information. These files are designed to facilitate multiple users throughout the life 
cycle of a project so you can move resources from development to testing and into 
production.

The FORM.DAT file defined the basic lines of business and the available list of forms for 
each of those lines. As such, there was too much information in this one file for it to be 
useful in a multi-user development environment. Therefore the FORM.DAT file, along 
with the SETRECIP.DAT (the trigger file), have been split into multiple components.

FORM.DAT file

Group file

(*.GRP)

Base definition 
file

(*.BDF)

Form file

(*.FOR)

Information about the lines of business

A list of the forms used for a lines of 
business and the order in which they 
should appear.

Information about the form itself, such 
as a list of the images that comprise the 
form and triggering information

SETRECIP.DAT 
file
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NOTE: File names, types, and extensions, as well as menu names, options, and screen 
names may change during the development cycle.

Base definition files The first component is a new file where you maintain what was formerly known as the 
lines of business. The extension and library type given to this file is BDF, which stands 
for base definition file. In Studio, you will see this listed in the workspace tree as 
business units.

A base definition file defines a valid key combination comprised of a Key1, a Key2, and 
eventually a Key3. These keys are typically known as Company, Lines of Business, and 
usually State, within the Insurance industry.

When you need to add a new line of business or business unit to a set of resources, you 
first check out the BDF file and then make the necessary changes to define a new 
business unit.

This file is relatively simple in design because there are not many options at this level. 
But because it is now a file type you can manage, you can now introduce new business 
units starting at a given date, which was not possible before.

See Working with Business Units on page 65 for more information.

Group files The next new file type in the workspace tree is called the group file. Once you define 
your business units, you then associate each business unit with a list of candidate 
forms. This file is where you define the list of forms available to a given business unit. 
And you can arrange the forms in the order in which you provide them.

The extension and library type for these files is known as GRP.

To add or remove a form from a business unit, you simply check out the appropriate 
group (GRP) file and make those changes.

Since unit form order files are versioned and given effective dates, the list of candidate 
forms can vary based upon the date associated with a given transaction.

See Working with Group Forms on page 77 for more information.

Form files The final new file type created from the FORM.DAT is known as the form file. These files 
have the extension and library type of FOR, which stands for form.

As a new file type in the library, you can maintain versions and revisions of a form. 
Effective dates are used to make sure you get the correct rendition of the form for that 
date.

In addition to form files containing the list of images that comprise the form, these files 
also contain the triggering information formerly stored in the SETRECIP.DAT file. This 
means that in addition to maintaining the image components, by checking this file out 
and back in, you automatically maintain the list of triggers used to generate specific 
layouts of the document.

The form file maintains the image options associated with the images that comprise 
the form and maintains the specific location (SetOrigin) information used to place the 
images correctly on the form.
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As mentioned, via the Libraries option, Studio supports these new file types (BDF, GRP, 
and FOR). This means you can check the files in and out and provide effective dates for 
when each are to become available (or expire).

The date associated with a transaction is used to select the appropriate version/
revision of the files to build the document set and each transaction can therefore differ 
if they have differing dates.

See Managing Forms on page 87 for more information.
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INSTALLING
STUDIO

If your system supervisor has not installed the system on your computer, you can do so 
easily, once you have made sure your computer has the correct hardware and software. 
Simply insert the CD-ROM into the appropriate drive and follow the instructions that 
appear on your screen.

NOTE: In most cases, the system supervisor will set up Studio on your computer for 
you. If you install the system yourself, check with your system supervisor to 
make sure any custom settings are configured correctly for your computer.

During installation, sample resource files are stored in the FMRes master resource 
library. Although you will likely set up your own resource libraries, do not delete these 
resources because the system may continue to use some of the files, such as the font 
cross-reference files (FXR).

Keep in mind...

• You must have Windows 2000 or later installed on your computer to run Studio.

• Installed under the \DLL directory are files needed to display INI configuration and 
help information. These files will continue to be updated with subsequent patch 
releases.

• There is a separate installation for Documaker RP and Documaker Studio.

• You can always find the latest installation information on the DOSS site.
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STARTING STUDIO When you first start Studio, the following window appears. 

The first step is to open an workspace or create a new workspace.

NOTE: For detailed instructions on creating a workspace, see Creating Workspaces on 
page 24. For more information on joining a workspace, see Joining a 
Workspace on page 30.
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You’ll find the options to open or create workspaces on the File menu and on the 
toolbar.

Once open, Studio shows the tools you can use to work in that workspace:

You can open or create 
a workspace two ways

The last five 
workspaces you have 
had open appear here

Here are the tools you can use. Click on a tool 
to open it.

The Status bar shows messages from the 
system.
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You can use these tools: 

Having the tools displayed in a tree arrangement provides an easy way to see the files 
you checked out from the library. It also serves as a most recently opened file list for 
all files, including those not in the library.

You can remove a file from this list by highlighting the file then right clicking to display 
the context menu. Use the...

• Check In option to check the file into the library

• Drop option to remove it from the list.

Tool Choose this tool to...

Business Units Define the various business units.

Group Forms Define the characteristics of a specific group of forms. For instance all 
of the forms which comprise a specific type of loan or insurance policy 
would be listed.

Forms Define the selection and arrangement of images that comprise the 
form set.

Images Create and manage the images you use to make up forms.

Logos Work with the bitmap graphics you use in your images. This gives you 
an easy way to resize, reverse, rotate, and manipulate the logo to fit 
your needs.

Scripts Create scripts to automate certain tasks. You create these scripts 
using the Document Automation Language (DAL).

Libraries Manage the libraries that contain the forms, images, logos, and other 
resources which comprise the form set.

Dictionaries

Extract Manage information about the extract files you use to merge 
information into variable fields on a form.

Rule

Fields Store common variable field information to make setting up and 
creating FAP files faster and more consistent.

Tables Create lookup tables for the variable fields you create.

Batch

Entry

Definitions

Fonts Organize your fonts into sets of fonts you use for image creation and 
printing.

Tests Test your forms in a simulated production environment.
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If you right click in this area, the following menu appears: 

The green check mark shows this file is checked out of the 
library.

This file was opened from disk and has not been checked into 
the library.

Option Description

New Use to create a business unit, group form, form, image, script, dictionary or 
table entry, or font.

Open Use to open a business unit, group form, form, image, logo, script, library 
dictionary or table entry, conversion, report, font, or test.

Save Use to save your work.

Save As… Used to save your work with another name.

Check In Use to save the changes and check in the item you are working on.

Check Out Use to check out an item from the library.

Unlock Use to unlock an item that is open when you want to release it back to the 
library without saving changes.

Drop Use to temporarily remove an item that appears in the list that is a library 
item. Permanently remove from the list an image that is not a library item. 
Unlock or check in permanently removes a library member from the 
working list. 

Properties Use to display properties of the item.
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USING SYSTEM
MENUS

This topic discusses the pull down menus available when you are working in 
Documaker Studio. The following topics discuss the options on these menus. When 
you first start Studio, you see these menus: 

These menus can change, depending on which tool you are working with. For instance, 
if you are working with images, you have these additional menus to choose from:

In addition, some of the options on the standard menus change. For instance, if you are 
working with images you will find additional Edit menu options which let you bold or 
italicize text. The chapters that discuss working with images or form, for example, 
document the addition menus and options that become available.

Select To

File Create, open, close, save, check in, check out, unlock, and print files. 
You can also use this menu to exit the system.

Edit Perform normal editing functions such as undo, redo, cut, copy, 
paste, and delete.

View Set to turn on or off the display of the toolbar, workspace, output bar 
and status bar.

Manage Work with various aspects of the project, including settings, 
libraries, dictionaries, scripts, fields, form sets, and other resources 
such as fonts, logos, help, tables, and users. You can also use this 
menu to convert files, print reports, test forms, and work with user 
profiles.

Window Use to control the display of your windows. You can elect to have the 
windows display in tile, stack, or cascade format. You can also open 
a new window or arrange icons.

Help Display Help contents, how to topics, shortcuts, the glossary, and 
product information.

Select To

Insert Insert the various objects that comprise an image, such as boxes, 
text labels, text areas, charts, lines, logos, fields, shade, and so on.

Format Align or space objects, convert objects into text labels or areas, or 
specify the formatting for paragraphs, including setting tabs, 
defining columns, numbering, specifying shading and borders, and 
so on.

Tools Run a spell or grammar checker, run a data entry check or an image 
report, or compile or convert the image.
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Using the Control menu In addition in the top, left corner of most windows you can click on the Control menu 
icon:

This menu provides these options:

Click here to display the 
Control menu

Option Description

Restore Restores the window to a smaller view

Move In the smaller view, the Forms icon appears in the upper left hand corner 
by the form name. The Move option lets you move the Forms window 
around.

Size Lets you resize the window.

Minimize Minimizes the window.

Maximize Maximizes the window.

Close Closes the window.

Next Moves to the next open item, such as the next form or image.
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FILE MENU

The File menu controls creating, opening, closing, saving, checking in or out, and 
printing your files. You also exit the system and return to your operating system from 
the File menu. When you select File, this menu appears:

A brief summary of each option appears below.

Select To

New Workspace Create a new workspace (DXM file).

Import Workspace 
Files

Import a workspace file.

Open Workspace Open a workspace.

Close Workspace Close the current workspace. The system prompts you to save your 
work.

New Create a new object, such as an image.

Open Open as object, such as an image.

Import Import an object.

Close Close the open object window. The system prompts you to save the 
object if changes have been made.

Close All Close all object windows. The system prompts you to save each 
object if changes have been made.

Save Save the object you are working with.
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Save As Save the object under a new name. This option lets you make a 
copy, without changing the original.

Export Export an object

Save All Save all open windows.

Check Out Retrieve an object from a library and lock it, so no other user can 
check it out while you work with it.

Check In Return an object to a library and unlock it. Other users can then 
check out the object.

Unlock Remove the lock placed on a document when you retrieved it with 
Check Out, but did not use the Check In option to return it to the 
library.

Scan for Locked 
Files

Check the library index and update the workspace tree to reflect 
those documents you have checked-out from the library.

Language Select the language appropriate for the forms you are working on.

Log On as a 
Different User

Log onto the system under another user ID.

Print Setup Select the printer you will print to and set up printer-specific 
options.

Print Print the current image or page. 

(recently opened 
files)

Choose from a list of the last five files you had open. This lets you 
quickly reopen a workspace, for instance.

Exit Close and exit Studio.

Select To
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EDIT MENU

The Edit menu lets you make changes to objects. You can undo, copy, cut, delete, and 
paste individual objects or select all the objects for editing. When you select Edit, this 
menu appears:

The options on the Edit menu can vary, depending on which tool you are using. This 
example shows you the standard Edit menu options. Here is a brief summary of these 
options:
Undo

Select… To…

Undo Cancel or reverse your last action or choice.

Redo Repeat the most recent change.

Cut Remove a selection and place it on the clipboard. Use Paste to insert 
the selection into, for instance, another part of the image or into a 
different image.

Copy Make a copy of the selection and place it in the clipboard. Use Paste to 
insert the selection into, for instance, another part of the image or into 
a different image.

Paste Insert the contents of the clipboard at the cursor location.

Delete Erase the selection. The selection is not stored on the clipboard so you 
must immediately select Undo if you change your mind.
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VIEW MENU

The View menu controls lets you quickly turn on or off the display of the toolbar, 
workspace, output, or the status bar. When you select View, this menu appears:

A brief summary of each option appears below:

NOTE: Depending on the tool you are using, other view windows may appear on the 
menu. The ones shown here are for the main view windows and are always 
available.

Select… To…

Toolbar View the toolbar.

Workspace View the workspace.

Output View output.

Status Bar View the status bar.

Options Specify grid and ruler settings.
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MANAGE MENU

The Manage menu lets you work with the various items which make up a project, such 
as libraries and scripts. When you select Manage, this menu appears: 

A brief summary of each option appears below.

Select… To…

Settings Define the INI and other configuration settings used by the system.

Business Units Define the various business units.

Group Forms Define the characteristics of a specific group of forms. For instance all 
of the forms which comprise a specific type of loan or insurance policy 
would be listed.

Forms Define the selection and arrangement of images that comprise the 
form set.

Images Create and manage the images you use to make up forms.

Logos Work with the bitmap graphics you use in your images. This gives you 
an easy way to resize, reverse, rotate, and manipulate the logo to fit 
your needs.

Scripts Create scripts to automate certain tasks. You create these scripts 
using the Document Automation Language (DAL).

Libraries Manage the libraries that contain the forms, images, logos, and other 
resources which comprise the form set.

Dictionaries Create and maintain mapping information for runtime data files.

Extract Create and maintain the XDB.DBF file.
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Rule Create and maintain the MASTER.DDT file.

Fields Create and maintain the FDB.DBF file.

Tables

Batch Create and maintain tables (TBL files) used in a batch processing.

Entry Create and maintain tables used in an entry processing.

Definitions Define tables used by both the batch and entry processing.

Conversion Convert files from one type to another, such as RTF to FAP and to 
change characteristics, such as a font ID) on multiple FAP files.

Reports Print base definition, group, form, or image reports.

Fonts Organize your fonts into sets of fonts you use for image creation and 
printing.

Tests Test your forms in a simulated production environment.

Users Create or work with user profiles.

Deploy Put resources into production.

Select… To…
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WINDOW MENU

Use the Window menu to control the way the system displays multiple windows. You 
can cascade or tile the windows. When you select Window, the following menu 
appears:

A brief summary of each option appears below.

Select… To…

Cascade Display multiple form or image windows in a layered fashion. The 
system stacks the forms one behind another so you easily see the 
name or title of each window or form.

Tile Display multiple form or image windows on your screen.

(file list) Jump to an open window. The system lists the windows you currently 
have open.
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HELP MENU

The Help menu controls access to Help screens. When you select Help, this menu 
appears: 

A brief summary of each option appears below. 

Select… To…

Contents See a general table of contents to the Help system.

How To Find step-by-step instructions for a variety of tasks.

Shortcuts See a list of keyboard shortcuts.

Glossary Review definitions of terms used in the system.

Using Help Find an explanation of how to use help.

About Documaker 
Studio

Review product information such as the version and patch 
number. You may need to refer to this information if you contact 
Customer Support.
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CREATING
WORKSPACES

Follow these steps to create a workspace for multiple users:

1 Choose the File, New Workspace option.

This turns on the Workspace wizard. The first page of the wizard asks whether you 
are creating a new workspace or joining an existing workspace.

2 Choose the Create New Workspace option. Then enter the name and location 
where you want the workspace to be created. If the path you specify does not 
exist, the subdirectories you specify will be created (if possible). For others to join 
the workspace, it will have to be located on a network or in a shared directory that 
allows access by the other users.

NOTE: The name you enter for the workspace cannot begin with a space or any of 
these characters: \ / : * ? " < > |

3 Click the Allow Other Users to Join field. Then click Next.

Select the New Workspace option.
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4 On the MRL Setup page, you first identify whether you are creating a new 
workspace or intend to import files from an existing MRL (Master Resource 
Library). Remember if you choose to create a new workspace, you can still 
manually import existing resource files later.

If you choose to import existing resources, you can browse to a working directory 
and an INI file (usually named FSIUSER.INI) that identifies the components of the 
resources you wish to import.

NOTE: Remember, in some setups, the working directory and the location of the INI 
file for a resource library setup are different. If the INI file uses relative paths, 
the working directory must be set correctly, or the components of the library 
may not be found.

Relative paths are those that have dots to represent the current or prior directory 
locations, as shown here:

Click here
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..\DEFLIB\

.\DEFLIB\

Two dots means to back up a directory from the current working directory. One dot 
means that the next value is relative to the working directory. It is important to set 
the working directory correctly if you use these types of relative path settings in 
the INI file.

If you choose to import from a resource library, the wizard asks addition 
questions. If you select the Create a New MRL option, the following field appears:

5 Use the FXR File field to enter the font cross-reference (FXR) file you want to use 
with this new workspace setup.

If you have installed the product according the default procedures, the system 
scans for and displays a font cross-reference (FXR) file. If the file shown is not the 
one you want, use the Browse button to locate that FXR. Once located, click Next.

The following page appears:



Creating Workspaces

27

6 Here you define the library management method you will use. The default method 
uses a separate index and compressed library file. This is the method used by 
many legacy environments. You can also use...

An ODBC table as the index and location to store the compressed resource 
data

A DB/2 SQL table as the index and location to store the compressed resource 
data

Documanage, Docucorp’s powerful document management repository. 

NOTE: Depending upon your library management choice, additional questions may 
be asked.

7 Use the Effective Date field to specify the default date for resources that may be 
imported or created for this new workspace. Remember that transactions are 
assumed to have a date-of-record — sometimes referred to as the run date, 
effective date, or policy date. Library management uses this transaction date to 
locate the proper resource version/revision that was effective on that date.

NOTE: When creating a new workspace, it is important to set the date on this page 
back far enough to cover the transaction date range that you expect to process.

Click Next when finished. The following page appears:

Click here to display 
the calendar.

Use the arrows to 
scroll through the 
months.

Then click on the date 
you want.
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This page shows what steps the creation process has registered to activate. In this 
example, there are only two entries:

Creating the new directory structure for the workspace

Saving the workspace file

NOTE: If you had chosen to import resources from an existing setup, this page would 
list additional tasks to accomplish the creation of the new workspace.

8 Click Next. The tasks listed on the window are checked off as they occur. You may 
notice some additional messages appear in the Output window.

This page appears after the creation tasks finish to ask if you would like to specify 
an alternate location to keep your local files.
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Make your choice and then click Finish.

Once created, you are designated as the administrator of the user database 
(USERINFO). As administrator, you can set security rights for other users who join the 
workspace. You do not, however, have to predefine additional users. New users who 
join a workspace are automatically inserted into the user database and inherit the 
attributes of USER1. Therefore, as administrator, you should change USER1 to have the 
level and security rights you want new users to have.

If you select The system

Yes Prompts you to enter or browse to the location where your local 
workspace files should be stored.

No Creates a subdirectory using your user ID in the network path where 
the shared workspace was created. This will be the location where 
files you check out are stored.
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JOINING A
WORKSPACE

To join a workspace created for multi-user development, follow these steps:

1 Choose the File, New Workspace option.

This turns on the workspace creation wizard which leads you through the steps 
necessary to join an existing workspace.

2 The first page of the wizard asks whether you want to create a new workspace or 
to join an existing workspace. Think of joining an existing workspace as you do 
creating a shortcut on your Windows desktop. You are creating a local reference to 
a shared workspace.

Select the Join Existing Workspace option.

Select the New Workspace option.

Click here
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3 Next, specify the location of the shared workspace you want to join in the Location 
field. You can use the browse button to pick the location, or simply enter the path 
and file name.

NOTE: When selecting the workspace to join, specify the DXM file and not the DXS file.

Click Next. This page appears:

4 On this page, you specify whether you want a local scratch pad (where your 
checked-out resources are maintained) or whether you want to have the scratch 
pad stored in the shared location.

Click Finish. The system creates your local directory, if necessary, and opens the 
workspace.

A new user in a workspace, may not have sufficient security rights to do certain tasks. 
It is up to the administrators to assign security rights to users, including what rights 
new users inherit.

If you accidentally choose to create a new workspace on the first wizard window and 
then enter a location that already has a workspace in it, you will see a message similar 
to this one.

Choose If you want to

Yes Specify an alternate location, such as a local drive path, where your 
reference files should be stored.

No Create a user subdirectory in the shared location that will maintain your 
reference files.
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You can open the workspace if you are already a member, or you can join the 
workspace and be prompted for the location to store your files. You can also choose to 
re-create the workspace. This last option only applies if you are the administrator of the 
workspace. If you are not the administrator, the system makes you start over.
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Chapter 2

Working with Settings and 
Users

Use the Settings option on the Manage menu to work 
with INI options and tool settings. INI options let you 
specify default values and other user-defined 
parameters.

Tool settings let you define how your forms appear on 
your screen. For instance, you can choose the display 
units and colors for the rulers that border forms, 
images and logos. You can also define the grid settings 
and specify colors for different elements in DAL scripts. 

This chapter discusses...

• Working With INI Options on page 34

• Defining Tool Settings on page 54

• Managing Users on page 63
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WORKING WITH
INI OPTIONS

INI options tell the system how you want it to operate. These options are stored in INI 
files. An INI file is simply a text file consisting of control groups and options. A control 
group organizes the various options and is denoted by brackets (< > ) or braces ( [ ] 
). The individual INI options appear below each control group. The settings for each 
option appear after an equals sign (=). Here is an example:

< ControlGroup >

Option1 = Parameters

Option2 = Parameters

...

OptionN = Parameters

Instead of editing the text file, Studio lets you modify your INI settings without leaving 
the system. Your changes are applied as soon as you click Ok.

How INI files are used Each resource library uses two INI files: FSIUSER.INI and FSISYS.INI.

• FSIUSER.INI - controls settings which can vary between resource libraries, such as 
sorting options, archival mode, and import/export ability, as well as individual 
user options.

To work with these options in Studio, you click the Local tab.

• FSISYS.INI - controls information related to the entire system, such as system 
settings and program function calls.

To work with these options in Studio, you click the System tab.

The system loads the FSIUSER first, then finds the name and location of the FSISYS file 
from the ENVIRONMENT group, and loads it. Since the FSIUSER is loaded first, the 
options within this group usually override the FSISYS options.

In a multi-user environment, you may not want to let all users change system-level 
settings. In some cases, you may not want some users to change individual settings. 
The system lets you determine which configuration options are available to a specific 
user. This is done via security definitions which are assigned to these options by the 
system administrator. For instance, you may allow a user to change local settings 
(FSIUSER), but not change the system settings (FSISYS). Or, you may let a user review 
these settings (local and system, but not change them.
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SETTING INI OPTIONS

When you choose the Manage, Settings option, the Settings window appears:

The initial view lists the groups of settings to the right and shows the security settings 
for the current user ID. 

NOTE: You can use the File, Log On As Different User option to change to another user 
ID.

You can find individual INI options a number of ways:

• By locating the control group. This way is useful if you already know the name of 
the control group.

• By clicking on the appropriate category
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For instance, if you expand Import and Export, you see the following options:

To make an entry for an INI option, click in the entry area beside the option. For some 
options, you simply enter text. For others, an icon appears to let you browse for a file, 
choose from a list of pre-set options, or to specify a parameter comprised of several 
elements.

Click the plus sign (+) to 
expand the category.

The control 
groups are shown 
on a gray 
background.

Click the +/- 
symbol to show or 
hide the options 
in the control 
group.

The name of the 
option appears in 
the left column. 
Your entry goes in 
the right column.
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Here are some examples:

Browsing for a file

Choosing from a list of
options

Specifying a parameter
comprised of several

elements

NOTE: You can find information about individual INI options on the DOSS site.

Studio groups the INI options into these categories:

Click here to display the Browse for File window.

Click here to display the list of pre-set options.

To See

Set archive/retrieval options Defining Archive Options on page 39

Specify how to split an archive 
(CAR) file

Defining ArcSplit Options on page 40

Click here to display the Option List window.
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Work with common system 
settings

Defining Common Options on page 41

Set up database options Defining Database Handlers on page 42

Set development tool options Setting Development Tool Options on page 43

Configure data entry Defining Entry Options on page 44

Specify import and export 
settings

Defining Import and Export Options on page 45

Configure your libraries Setting Up Resource Libraries on page 46

Set up printers and batches Defining Print Batches and Printers on page 48

Specify where resources are 
stored

Defining Resource Paths on page 50

Set rules processing options Defining Rules Processing Options on page 51

Set work-in-progress options Defining WIP Options on page 52

Work with options not covered 
above

Defining Uncategorized Options on page 53

To See
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DEFINING ARCHIVE OPTIONS

Here you can define options common to...

• Archive-related utilities

• All archives

• The GenArc program

• Archiving via Documaker Workstation

• Archive/Retrieval vial Documaker Workstation

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING ARCSPLIT OPTIONS

Use these options to define what should happen when you split an archive (CAR) file. 
You can perform this task from within Documaker Workstation or using the ARCSPLIT 
utility. The INI options are grouped based on those two approaches.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING COMMON OPTIONS

This is where you define settings common to all facets of Studio. This includes interface 
options, miscellaneous options, and print options.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING DATABASE HANDLERS

Some of the information you work with, such as archive information, must be stored in 
database tables. The system lets you use several types of databases, such as ODBC, 
DB2 and Oracle. To define the type of database tables you will use, click Database 
Handlers. The following window appears:

From this window you can add and delete database handlers. You can also customize 
the properties of these handlers. When adding a database handler, the system 
provides a wizard to guide you through the setup process.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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SETTING DEVELOPMENT TOOL OPTIONS

These options let you control how you work with Studio. The following window 
appears:

From this window you can set how often Studio should automatically save your work 
or if it should automatically run a spell check when you close an applicable object. You 
can also set the default colors for the objects you place on images, such as boxes and 
barcodes.

NOTE: This is where you set the Locale option. The Locale options determines the 
default units of measure, date format, and so on.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING ENTRY OPTIONS

This is where you define how the data entry facilities work.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING IMPORT AND EXPORT OPTIONS

This is where you define importing and exporting options.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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SETTING UP RESOURCE LIBRARIES

Libraries store the resources you use as you build and process information on form 
sets. When you click Libraries, this window appears:

Here you can choose the library you want to work with. Libraries contain the resources 
you use to build form sets. These resources include images, logos, and forms. Other 
tabs on this window let you work with...

NOTE: The descriptions for Modes, Status Codes, Classes, and Projects reflect a 
typical use of these tabs and the system defaults to settings that support that 
usage. You can, however, define these concepts differently if your needs differ.

Tab Description

Modes Indicates what stage of development a resource is in, such as 
development, testing, or production mode.

Status 
Codes

Indicate the status of a resource, such as whether it needs testing, must 
be modified, or should be promoted. 

Classes Let you categorize resources based on your needs. For instance, 
resources used in a single line of business or geographical area could 
comprise a class.

Projects Let you associate a resource with a particular job or task.

Library Logs Track what happens to a resource. For instance, here you can see what 
resources have been added, modified, or deleted.
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When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING PRINT BATCHES AND PRINTERS

Click the Print Batches & Printers options to set up the print batches and printer 
options you will use to publish your forms.

You have several categories of options:

Category Description

Print Options This is where you define the print type and if you will want to produce 
transaction or batch banner pages

Print Batches Typically print batches are grouped by recipient, but you can set up 
print batches to meet your needs, such as by page count. Studio 
includes a wizard to guide through the process of creating a new 
print batch.
To insert a print batch, right-click on Print Batches and choose Insert. 
To delete a print batch, right-click on the Print Batch item you want 
to delete and choose Delete. 

BatchingByRecip 
Options

These options work with the BatchingByRecipINI and 
BatchingByPageCountINI rules.
To insert an option, right-click on BatchingByRecip Options and 
choose Insert.
To delete an option, right-click on the option you want to delete and 
choose Delete.

Logical Output 
Devices

Studio displays all logical output devices already defined.
To insert an output device, right-click on Logical Output Devices and 
choose Insert.
To delete an output device, right-click on the output device you want 
to delete and choose Delete.
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When you right-click on any field on this screen, you can choose from these options:

Print Types Print types refer to the printer language uses, such as PostScript, 
AFP, Metacode, or PCL. Studio displays all logical output devices 
already defined. 
To insert a print type, right-click on Print Types and choose Insert.
To delete a print type, right-click on the print type you want to delete 
and choose Delete.

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.

Category Description
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DEFINING RESOURCE PATHS

This is where you tell Studio where to find the resources you will work with and it will 
use to build form sets.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING RULES PROCESSING OPTIONS

This is where you define options that affect how rules are processed via the GenData 
and GenTrn programs.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING WIP OPTIONS

This is where you define options that affect work-in-progress. This includes options for 
the GenWIP program and options that affect how WIP is handled via a workstation.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING UNCATEGORIZED OPTIONS

This is where you define miscellaneous options.

When you right-click on any field on this screen, you can choose from these options:

Option Description

Print Print a copy of the settings.

New Tells Studio to add a new INI option. Studio asks for the name of the control 
group, the name of the option, and the value you want to assign to the 
option.

Remove Tells Studio to remove this INI option.
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DEFINING TOOL
SETTINGS

Defining tool settings is often one of the first tasks you will do. These settings affect 
how all documents appear on your screen. You can define tool settings by choosing 
Settings from the Manage menu. Then choose Tool Settings.

To work with common document viewing settings, click Common/Document View. This 
window appears:

This table explains your options:

When you right-click on any field on this screen, you can choose from these options:

Option Description

Measurement

Display Units Select unit of measurement in which display will be made - 
centimeters, FAP units (2400 per inch), inches, picas, 
points

Ruler Settings

Ruler color Click the icon in this field to display the Color Selection 
screen and select the color you want to use.

Ruler text color Click the icon in this field to display the Color Selection 
screen and select the color you want to use.

Grid Settings

Show Horizontal Grid Check to display the horizontal grid.

Show Vertical Grid Check to display the vertical grid
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From Tool Settings you can also work with options that control the following:

Option Description

Print this Window Prints the contents of the window.

Apply Changes Lets you apply your changes.

Default Settings Restores the default settings.

To See

Work with form options Working with Form Options on page 56

Work with image options Working with Image Options on page 57

Work with logo options Working with Logo Options on page 60

Work with script options Working with Script Options on page 61
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WORKING WITH FORM OPTIONS

Choose this option to define how you view documents on your screens. This includes 
setting up the grid and rulers. This window appears:

This table explains your options:

When you right-click on any field on this screen, you can choose from these options:

Option Description

Ruler Settings

Show horizontal ruler Check to show the horizontal ruler.

Show vertical ruler Check to show the vertical ruler.

Use a ruler in this tool Check to use a ruler when working with forms.

Grid Settings

Show Horizontal Grid Check to display the horizontal grid.

Show Vertical Grid Check to display the vertical grid

Option Description

Print this Window Prints the contents of the window.

Apply Changes Lets you apply your changes.
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WORKING WITH IMAGE OPTIONS

The image options fall into two categories:

• Filter settings

• Document view options

The following topics discuss these options.

Setting Image Filter Options

Choose Filter Settings to define the filter settings that apply when you are working with 
images. This window appears:

When you right click on any field on this screen, the following option is shown:

The filter options are divided into these categories:

Default Settings Restores the default settings.

Option Description

Option Description

Print this Window Print a copy of the settings.

Apply Changes Tells Studio to record the changes you have made.

Default Settings Tells Studio to restore the default settings.
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• Selection filters

• Display filters

Selection Filter For each type of object, you can choose from these filter settings:

Display Filter For each type of object, you can choose from these filter settings:

Setting Document View Options

These options control how Studio displays documents. For instance, you use these 
options to turn on or off rulers, show or hide the grid, and turn on or off automatic spell 
and grammar checking.

When you click Document View, this window appears:

Option Description

Cannot move Check this option if you do not want to allow anyone to move this 
kind of object.

Non-selectable Check this option if you do not want to allow anyone to select this 
kind of object.

Selectable Check this option to let people select this kind of object.

Option Description

Hide Tells Studio to list the object in the object tree but hide it in the work 
area.

Show Tells Studio to show the object as you create it.

Placeholder Tells Studio to display a placeholder instead of the actual object.
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This table explains your options:

Option Description

Ruler Settings

Show horizontal ruler Check to show the horizontal ruler.

Show vertical ruler Check to show the vertical ruler.

Use a ruler in this tool Check to use a ruler when working with images.

Grid Settings

Show horizontal grid Check to display the horizontal grid.

Snap to horizontal line By checking, the object entered will snap (be placed) 
to the closest horizontal line below it.

Show vertical grid Check to display the vertical grid.

Snap to vertical line By checking, the object entered will snap (be placed) 
to the closest vertical line to the left of it.

Save

Spell check on Save Check this option to have Studio automatically check 
spelling when you save an image.

Grammar check on Save Check this option to have Studio automatically check 
grammar when you save an image.
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When you right-click on any field on this screen, you can choose from these options:

WORKING WITH LOGO OPTIONS

These options control how Studio displays logos (bitmap graphics). For instance, you 
use these options to select the unit of measurement, turn on or off rulers, set ruler 
colors, and so on. When you click Document View, this window appears:

This table explains your options:

Option Description

Print this Window Print a copy of the settings.

Apply Changes Tells Studio to record the changes you have made.

Default Settings Tells Studio to restore the default settings.

Option Description

Ruler Settings

Show horizontal ruler Check to show the horizontal ruler.

Show vertical ruler Check to show the vertical ruler.

Use a ruler in this tool Check to use a ruler when working with logos.

Grid Settings
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When you right-click on any field on this screen, you can choose from these options:

WORKING WITH SCRIPT OPTIONS

Use these options to set up the color for the various elements of a DAL script. For 
instance, for readability purposes you can define different colors for the following:

• Keywords and functions

• Numeric constants

• String constants

• Comments

When you choose Scripts, this window appears:

Show Horizontal Grid Check to display the horizontal grid.

Show Vertical Grid Check to display the vertical grid.

Option Description

Print this Window Print a copy of the settings.

Apply Changes Tells Studio to record the changes you have made.

Default Settings Tells Studio to restore the default settings.

Option Description
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This table explains the syntax color options:

When you right-click on any field on this screen, you can choose from these options:

Option Description

Keywords & 
Functions

Click the icon in this field to display the Color Selection screen and select 
the color you want to use.

Numerical 
Constants

Click the icon in this field to display the Color Selection screen and select 
the color you want to use.

String 
Constants

Click the icon in this field to display the Color Selection screen and select 
the color you want to use.

Comments Click the icon in this field to display the Color Selection screen and select 
the color you want to use.

Option Description

Print this Window Print a copy of the settings.

Apply Changes Tells Studio to record the changes you have made.

Default Settings Tells Studio to restore the default settings.
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MANAGING USERS Choose the Manage, Users option to work with the user profiles you have set up. Here 
is an example of the window that appears if you are authorized to work with user 
profiles:

Expand Users to see a list of users currently set up to use Studio.

Studio shows you information about...

• The user’s name and ID

• Who the user reports to

• Access rights and In Use status

It also tells you if there is a message set up to appear to the user when he or she logs in.

NOTE: Your default user ID is the same as your Windows NT user ID.

Click here to expand the list 
of users
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To change a user’s information, simply type into the appropriate field. Note these tools 
on the toolbar:

Here is an example of the login window:

Click here to add a user

Click here to delete a user Click here to restore the previous values
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Chapter 3

Working with Business 
Units

Click Business Unit to maintain lines of business or 
business units. For example, suppose you are creating 
forms for an insurance company which underwrites 
automobile and homeowner's insurance. Each 
different insurance type could be considered a 
separate line of business or business unit.

This chapter discusses the following topics:

• Overview on page 66

• Defining a Business Unit on page 69

• Storing Recipient Information on page 72

• Defining Categories on page 73

• Defining Transaction Types on page 74

• Generating Reports on page 75
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OVERVIEW The business unit file defines the key combinations used to locate a specific form set. 
These key combinations are comprised of a Key1 and Key2 (sometimes referred to as 
Unit1 and Unit2; or Group1 and Group2). To continue with the insurance analogy, these 
keys are typically called: Company and Line of Business (LOB).

To add a new line of business or business work unit to a set of resources, you first check 
this file out and then make the necessary changes to define a new business unit. Here 
is an example of the window you use to select a Business Unit from the library:

Once you select the business unit, the Business Units view appears:

A toolbar similar to this one 
appears above most property 
views.
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Notice the toolbar above the properties. You will see similar toolbars throughout 
Studio. 

Other global information is also stored in the Business Unit file.

The plus sign lets you add an 
entry in the tree, list, or 
database. Here, it lets you add 
a new group name.

Click the green check mark to 
commit your changes to the 
properties options without 
leaving the item. If you click on 
another item or try to close the 
window, the property options 
are committed back to the tree 
or list automatically.

Click here to add library items into the design. For instance, from here you can 
select from group (GRP) files already defined in your library list.
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THE BUSINESS UNIT FILE

The Business Unit file (BDF - Business Unit Definition File) defines the combinations of 
keys (groups) that represent the business units under which forms are assembled. 
These key combinations are comprised of Key1 and Key2. To continue with the 
insurance analogy, these keys are typically called Company (Key1) and LOB (Key2).

Other information stored in the BDF file includes the list of recipients, form categories 
(if used), and transaction type information. In addition, the business unit file identifies 
the primary extract dictionary (XDD) file (if used), as well as the font cross-reference 
(FXR) file preferred by this setup. Here is an example of a BDF file. 

NOTE: This example is included for illustrative purposes. You should always let 
Studio create and maintain BDF files. Do not manually edit this file.

NOTE: There is no category information in this example.

<DOCUMENT TYPE="RPWIP" VERSION="11.0">

<DOCSET NAME="SAMPLE_0000100001_19800101">

<FXRFILE NAME="rel103sm"/>

<XDDFILE NAME="Symbol"/>

<RECIPIENT NAME="Client" COPYCOUNT="0" CODE="001" SEQUENCE="1">

<DESCRIPTION>Client Copy</DESCRIPTION>

</RECIPIENT>

<RECIPIENT NAME="Office" COPYCOUNT="0" CODE="002" SEQUENCE="2">

<DESCRIPTION>Office Copy</DESCRIPTION>

</RECIPIENT>

<GROUP NAME="Sample_Business" NAME1="Sample" NAME2="Business"/>

<TRANSACTION TRNCODE="NB" DESCRIPTION="New Business" 
DLLFUNC="TRNW32-&gt;TRNNEW"/>

<TRANSACTION TRNCODE="EN" DESCRIPTION="Endorsement" 
DLLFUNC="TRNW32-&gt;TRNEndorse"/>

<TRANSACTION TRNCODE="RN" DESCRIPTION="Renewal" DLLFUNC="TRNW32-
&gt;TRNRenew"/>

<TRANSACTION TRNCODE="QU" DESCRIPTION="Quote" DLLFUNC="TRNW32-
&gt;TRNRenew"/>

</DOCSET>

</DOCUMENT>
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DEFINING A
BUSINESS UNIT

The Business Unit tab shows you the properties defined for the business unit you have 
selected.

For each business unit you must define a font cross-reference (FXR) file and the primary 
extract dictionary (XDD) file.

Field Description

FXR File Name Enter the name of the font cross-reference file you want to use with 
this business unit definition. The font cross-reference file lets you 
organize the fonts you use for display and printing.
The FXR provides all necessary font information. It does not contain 
the actual font files; rather, it contains information about the font 
attributes. Font attribute information includes formatting styles 
(bold, italic, and so on), point size (10 point,14 point, and so on), 
and font stroke eight (heavy, light, and so on). 
When you click in this field, a browse icon appears which you can 
use to browse to the FXR file you want to select.
Note: If an FXR file is specified in your INI files, Studio will use that 
file instead of the one you name in this field.

Primary Extract 
Dictionary (XDD)

Enter the name of the XDD file you want to use with this business 
unit definition.
The XDD file contains information on how to transfer the data from 
external files (sometimes called extract files) into fields defined 
within your documents. If your setup is not a batch implementation, 
you would not normally need an XDD file.
When you click in this field, a browse icon appears which you can 
use to browse to the XDD file you want to select.
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If you click on a specific business unit definition, the view changes to show you the 
appropriate fields for that definition. Here is an example:

The toolbar changes to provide some additional options.

If you click a top level item (under the root), you can define or modify a Unit 1 level 
name. Clicking on a second level item lets you define the Unit 2 name. This item is 
subordinate to the Unit 1 defined as its parent.

The property area lets you define the unit names, and for level two items, you also must 
define the external (library) file name that contains the available forms list for this 
particular combination. This file is referred to as a Group (GRP) Forms file.

In the Filename field you can enter a name or select the GRP file from the library by 
clicking on the associated button. Remember that certain platforms can have file 
naming requirements that are not automatically enforced by Studio. You must make 
sure the file names you assign are compatible with the platform you will eventually 
process on.

Click the X to 
delete a business 
unit group 
definition

To Click

Delete a business unit group definition

Change the order of an item (if the item can be ordered). Press the up arrow 
to move the item higher in the tree. Press the down arrow to move the item 
lower in the tree. The order of the groups defined within the BDF will be the 
same order used when form selection is shown within the Entry program. For 
batch processing, the order of the groups at the BDF level is not usually 
important, but you may experience a minor improvement in performance if 
the groups that are most often used are defined closer to the top of the tree. 
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If you click on an item in the business unit group definition, Studio adds the Extract 
Dictionary Override field.

Use the Extract Dictionary Override field to define a different XDD than the primary XDD 
defined at the BDF (root) level. You can leave the name blank, if you want this business 
unit to use the primary XDD definition. Otherwise, you should enter the appropriate 
name or browse the library for the appropriate XDD file to use.

During batch processing, when the system maps fields it checks the associated group 
level for a defined symbol (XDD) file. If one is not defined, it queries the BDF (root) level 
for the primary XDD. If one is not defined there, it chooses the one specified in this INI 
option:

< MasterResource > 

DictionaryFile = 
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STORING
RECIPIENT

INFORMATION

Click the Recipients tab to manage the list of recipients for your documents. Here is an 
example:

Here you define the recipient type name, such as Insured or Customer; the sorting 
code, which is used by batch implementations; and a brief description that will display 
in Send Copy To fields defined in your document when you print that document for that 
recipient.

Understanding the System There are two parts to the recipient definition in the Recip_Names control group. The 
first part is a code and the second is a description. The code is only used in batch 
processing (the GenData program) and is a unique value written to the batch files to 
the system will know which recipient to queue at print time.

The second part is the description field. This is used any time a SendCopyTo field is 
printed. This is where the text like Insured's Copy comes from when you print. This is 
used by both entry systems like Documaker Workstation or iDocumaker and the 
GenPrint program.

When a batch cycle begins, the list of recipients defined in the Business Definition file 
is inserted into the Recip_Names control group used by several of the Documaker RP 
programs.

Field Description

Name Enter the name of the recipient you want to add.

Code Assign a code to the recipient.

Description Enter a description of the recipient.
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DEFINING
CATEGORIES

Click the Categories tab to define form categories. 

Form categories are optional. If you define them, the form categories appear when you 
edit a group (GRP) file. The category definitions can help you organize large sets of 
forms by letting you associate similar forms to make the list more manageable. 
Categories are not the same as the higher level key groups (Key1 and Key2) and are not 
used during form triggering or selection.

Field Description

Name Enter the name of the category you want to add.

Description Enter a description of the category.
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DEFINING
TRANSACTION

TYPES

Click the Transactions tab to define transaction types and optionally assign an Entry 
Workstation-affiliated hook function associated with form selection.

NOTE: Batch implementations do not use the associated hook function.

Transaction codes are sometimes used in batch processing as one level of form 
filtering. Transaction codes are also used in Entry/WIP situations to identify the type of 
transaction being created.

Also in Entry, the DLL and Function declarations define internal or external hook 
functionality that must be executed on that transaction type to validate the list of forms 
selected.

Field Description

Transaction Code Enter the transaction code you want to add.

Description Enter a description of the transaction code.

DLL Enter the name of the DLL you want the Entry system to execute to 
validate the list of forms.

Function Enter the name of the function you want the Entry system to execute 
to validate the list of forms.
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GENERATING
REPORTS

To generate a report which shows the options defined for this business unit, click the 
Report tab and follow these steps:

1 This window appears when you click the Report tab. Click Generate Report.

The Reports window appears

2 Highlight the report you want to generate, in this case a Base Definition Report, 
and Click Next. The Generate Report window appears.

Click here to generate a report
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3 Click Finish to generate the report. A sample report appears below:

Click here to print the report.
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Working with Group Forms

Click Group Forms to define a list of the forms that 
apply to each business unit and to maintain form-level 
triggering information. You can also define the order in 
which these forms should be provided.

Information about each group of forms is stored in a 
file with a GRP extension. For each group (Key1/Key2), 
you have a separate GRP file. Group name (Key1/Key2) 
information is stored in the BDF file, whereas specific 
information for each of the forms that make up the 
group is stored in a GRP file.

This topic discusses:

• Creating a Group on page 78

• Opening a Group on page 81

• Setting Up Triggers on page 82

• SetRecip Options on page 84
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CREATING A
GROUP

To begin the process of grouping forms, you must first create a group. Follow these 
steps:

1 To create the group, double click on Group Forms. Then click New on the Open File 
screen.

You can also right click on the Group Forms option and select New, leave Group 
Forms highlighted on the next screen and click Ok.

The screen below appears.

Double click on 
Group Forms.

Then click New.
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2 Enter the following information to set up the forms you want included in the group 
in the following fields on the Forms tab. Keep in mind that the forms do not have 
to exist at this point, you are merely creating a list of form names and defining 
some of the options that apply to those forms.

Field Description

Form Name Enter the name of the form you want to include in the group. You can 
enter up to 100 characters. This name appears on the Forms 
Selection window in Documaker Workstation

Form 
Description

Enter a description of the form. You can enter up to 100 characters. 
This description appears in the object tree beside the form name. 
This description can help a Documaker Workstation user select the 
correct form.

Dec Options Choose the appropriate declaration page option. Your choices are: 
None - Any page other than a policy declaration page
Dec Page - A policy declaration page
Master Dec - A master declaration page for the form set (package 
policy)
Sub Dec - A sub dec page for one group in the form set
This option is only used by Documaker Workstation. What you 
select here determines the manner in which Documaker 
Workstation presents declaration pages during entry.This option is 
ignored during batch processing.

Pre-selected Check this option if you want Documaker Workstation to 
automatically select this form during entry.

Filename Enter a file name for this form. Usually, you would keep the form 
name and the file name the same, but some platforms will not let 
you use certain characters in file names.
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NOTE: Because Dec Options and the Pre-selected fields are stored at the group level, 
you can reuse the same form in different groups.

3 Choose File, Save to save your work. The Save As window appears.

Enter the name of the group in the Filename field.

Understanding the System Another way to create a new group forms list is to select the Edit File option from the 
Key2 (LOB) level while working with business units. This option will create a new file if 
one does not exist.
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OPENING A GROUP To modify a group file, follow these steps:

1 Click the plus sign (+) to the left of Group Forms and then select the group you 
want to work with.

The following window appears. 

2 Make any necessary changes.

Click here.

Then select the group list you 
want to work with.
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SETTING UP
TRIGGERS

You can create triggers at both the form and image level. Form level triggers are stored 
at the group level and specify the condition that would cause a form to be included (or 
triggered) with a transaction. You should always specify a trigger for a form.

Understanding the System Image level triggers are stored at the form level and specify the condition that would 
cause the image to be included on the form. Only set up image level triggers if the 
image's presence on the form is conditional.

Studio assumes you do not want to trigger any of the images that comprise a form if 
the form level trigger is false. Therefore, image level triggers are automatically ignored 
when the form level trigger for the transaction being processed is false. This makes the 
use of an M occurrence flag unnecessary if you want the system to only evaluate image 
level triggers when the form level trigger is true, as was the case in Docucreate’s Image 
Editor. 

If you omit a form level trigger, the system does not operate as efficiently since every 
image level trigger must then be evaluated by the system.

Follow these steps to add form level triggers.

1 Highlight Group Forms, right click and select Open.

2 Select the group file in which the form is located and click Open.

3 Click the Triggers tab. 

4 Highlight the form to which you wish to add a trigger and right click. Select Add. 
The SetRecip table appears.
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5 Use the Trigger Options fields to set up the triggers for your form.

Editing a trigger If you need to modify a trigger, right click on the trigger and select Edit Trigger File. The 
SetRecip table appears. 

You can also highlight the trigger and click on this icon:

Click here to open the 
SetRecip table.
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SETRECIP
OPTIONS

The SetRecip Table lets you specify the conditions under which a form or an image will 
get triggered. Depending upon the requirement, not every field is completed. This table 
discusses each field:

Section Field Description

SetRecip Transaction Codes
<TRANSCDS>

By including one or more Transaction codes in this 
field, you trigger a particular form (or image) only if the 
extract file record includes that particular Transaction 
Code.

<RECIPS>

Search Mask (Counter)
<MASK1>

Lets you set the criteria to determine whether or not a 
form (or image) belongs in the form set. The criteria 
allows the Rules Processor to get specific data from the 
extract file. 
Adds one form (or image) for every occurrence of the 
search mask per transaction. The Occurrence Flag 
must be set to one (1) for the search mask to act as a 
counter.

Occurrence Flag
<OCCURRENCE>

To use the search mask as a counter, the Occurrence 
Flag (overflow) must be set to one (1). Use with the 
Search Mask Counter, Records on Different First 
Image, and Records Per Overflow Image fields. (0=no 
overflow and 1=overflow)
Performance issue flags in this field include:
- Master (M) form level trigger flag
- Form (F) form level trigger flag
- Subordinate (S) image level trigger flag 

Records on different first 
image
<RECSPER1ST>

Lets you indicate the number of records that appear on 
the first image before overflowing to a new image.

Records per overflow image
<RECSPERIMG>

Lets you specify the number of records matching the 
search mask that will fit on the specified overflow 
image. If the value is zero (0) and the Occurrence Flag 
is set to one (1) with the Search Mask Counter set, the 
system automatically sets this flag to one (1) to 
perform the overflow calculations.

Search Mask (True/False)
<CONDITIONAL>

Similar to Search Mask (Counter), but only one form (or 
image) is triggered, regardless of how many 
occurrences of the condition exists.

Custom Rule Name
<FUNCTIONNAME>

Normally used for custom implementation 
requirements. Only exceptions are RECIPIF and 
RECIPCONDITION rules.
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Custom Rule Parameters
<DATA>

Specifies parameters for the custom rule used in the 
Custom Rule Name field.

Recipient Form Level Trigger
Recipient Copy Count
<RECIPCPYCT>

 Image Level Trigger
Recipient Copy Count
<RECIPCPYCT>
Recipient names listed with 
no check or a check

Defaults the recipient copy of each recipient defined at 
the form level
If recipient was eligible in the form file, it is checked 
here.

Section Field Description
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Chapter 5

Managing Forms

Click Forms to work with the list of images that 
comprise the form and maintain image-level triggering 
information. The triggering information determines 
what criteria must exist for this form to be included in 
a form set.

This chapter discusses the following topics:

• Overview on page 88

• Using the Screen on page 90

• Creating a Form on page 97

• Modifying Forms on page 100

• Setting Up Triggers on page 104

• SetRecip Options on page 107
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OVERVIEW A form is a single document containing one or more pages or images. Most forms 
contain multiple pages that are usually printed on both sides of a single sheet (duplex). 
Some forms are printed only on one side (simplex). Typical forms include insurance 
policies, tax returns, and mortgage documents.

The information for a form is stored in a file with an FOR extension. For each form you 
create, you have a separate FOR file. A form is listed in a GRP file, whereas the specific 
information for each form is stored in a separate FOR file.

A form includes two types of data: fixed and variable.

• Fixed data is the same on every copy of the form. This includes items such as 
logos. This information remains constant regardless of the data entry.

• Variable data may differ from form to form. This includes items such as individuals' 
names, addresses and policy numbers. This information relates to the specific 
data processed on each form.

A single form consists of one or more images. Since multiple forms and images make 
up a form set, you can view and navigate through each form and image individually.

A form may consist of multiple images, and consequently you can view the varying 
images within a form by displaying different pages of the form.

An image can contain varying sections on one page. For example, an automobile 
insurance application form could consist of three images. The first image or page may 
contain three separate sections: a section for listing the automobiles you want to 
insure, a section for recording household driver information, and a section for selecting 
the type and amount of coverage you want for each vehicle. Using the page display 
options, you can zero in on and view the beginning of a particular section of the 
insurance application image.

Forms consist 
of one or more 
images

Image A

Image B

Image C

Image D

Image E

Image F

Form 1

Form 2
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Objects Objects are the individual items which comprise your image. Examples of objects are 
boxes, barcodes, lines, graphics, and text. All objects have unique attributes within the 
image. Attributes include items such as position, size, font type, and color.

Image A

Image B

Image C

Form 1

Section 1

Section 2

Section 3

Images consist 
of one or more 
sections
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USING THE
SCREEN

Studio places all the tools you need to manage your forms at your fingertips. The 
screen is your forms work area. It is important to become familiar with the general 
screen layout and parts of the screen. Understanding the screen layout will help you 
work quickly and efficiently.

The first window that appears when working with forms is shown here.

Title bar

Menu bar

Tool bar

Workspace

Status bar

Image tree Work area
Form or image properties

Item Description

Title bar The title bar displays the name of the workspace you have open, 
followed by Documaker Studio, and then the name of the form you have 
open. 

Menu bar The menu bar provides the list of available pull-down menus.

Tool bar The tool bar contains a row of icons that provide quick access to 
common options.

Status bar The Status bar gives the coordinates of the mouse pointer in the work 
area. The mode of operation, such as ready or edit, also appears here.

Workspace The workspace lets you quickly access different items. It also shows 
which specific resources that are checked out (green check mark), 
which resources are checked out by another user that you would only 
have read-only access to (red check mark), and which resources are 
open in read-only mode or have never been checked into the library.
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USING THE MENU BAR

This section introduces you to the pull-down menus which include additional options 
or are only available when you are working with forms. A summary of each of these 
menu appears below. The menus are listed in the order they appear on the menu bar.

NOTE: For information on the standard menus and menu options which are always 
available, see Using System Menus on page 14.

Using the Image Menu

The Image menu provides options useful when you are adding an image to a form.

Image tree Shows the images that comprise the form.

Form or image 
properties

Depending upon whether you highlighted a form or an image, if you 
click the Properties tab, Studio shows you the properties for that form 
or image.
If you click the Triggers tab, Studio shows you the triggers for that form 
or image.

Work area This is where you add, delete, or re-arrange the images that comprise 
the form. You can also test entering data onto the form.

Menu Description

Image The Image menu lets you add, delete or move images on the form.

Trigger The Trigger menu lets you add, delete or rearrange the triggers that tell the 
system when to include or exclude a form.

Option  Description

Add

Page Adds a page to the form.

Image Adds an image to the form.

Item Description
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Using the Trigger Menu

The Trigger menu provides options for working with image triggers.

Group Adds a group begin image. When you add a group begin image, a 
group end image is automatically added.
This lets you associate images and optionally assign a common 
trigger to all of them. You can drag and drop or create images 
between the group begin and group end images to indicate they are 
part of the group. A form group can optionally have a group rule 
associated with the group begin image.

Delete Deletes the highlighted image.

Move up Moves the highlighted image up.

Move down Moves the highlighted image down.

Data Entry Check Lets you perform form level data entry check.

Option Description

Add Adds a trigger to the highlighted image.

Delete Deletes the highlighted trigger.

Move up Moves the highlighted trigger up.

Move down Moves the highlighted trigger down.

Option  Description
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USING THE WORKSPACE MENU

The workspace area is the area to the far left of the screen. From the workspace, you 
can open different modules within Documaker Studio. It shows which resources are...

• Checked out (green check mark) by you

• Checked out by another user and you would only have read-only access to (red 
check mark)

• Open in read-only mode or have never been checked into the library

Option Description

New Use to create a form.

Open Use to open a form.

Save Use to save an opened form.

Save As… Used to save an opened form with another name.

Check In Use to check in a form that has been checked out when you want to save 
the changes.

Check Out Use to check out a form that is in the library when changes need to be 
made.
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Unlock Use to unlock a form that is open when you want to release it back to the 
library without saving changes.

Drop Use to temporarily remove a form that appears in the list that is a library 
item. Permanently remove from the list a form that is not a library item. 
Unlock or check in permanently removes a library member from the 
working list. 

Properties Use to display properties of the form.

Option Description
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USING THE TOOL BAR

The tool bar is useful because it serves as a quicker route for performing some 
functions that may be listed on a drop down menu. Here is an example of the tool bar 
shown when you are working with forms:

Standard tool bar icons Shown below are the tool bar icons that are always available. The icons are listed as 
they appear, from left to right.

Table 1: 

Icon Name Description

New 
Workspac
e

Creates a workspace.

Open 
Workspac
e

Opens workspace.

Close 
Workspac
e

Closes a workspace.

Toggle 
Workspac
e

Toggles between displaying and hiding the workspace.

New Creates a file.

Open Opens a file.

Save Saves the open file.

Print Prints the current object.

Cut Removes an object and places it on the clipboard.

Copy Copies an object and places it on the clipboard.
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Form tool bar icons Shown below are the tool bar icons that appear when you are working with forms.

Paste Places an object from clipboard onto the current file.

Undo Reverses your last action

Redo Reverses last undo.

Help Displays the Help Context window

Table 1: 

Icon Name Description

Table 2: 

Icon Name Description

data entry check Lets you test entering data onto a form.
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CREATING A FORM To create a form, follow these steps:

1 Double click on Forms. The Open File window appears.

NOTE: You can also right click on Forms and select New, then click Ok on the Forms 
window.

2 Click New on the Open File window. This window appears.
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3 To define the form, make the appropriate entries in these fields:

4 To save the form, choose File, Save. Once you have saved the form, you can check 
it into the library using the File, Check in option.

Field Description

Name Enter the form name. You can enter up to 100 characters. This name 
appears on the Form Selection window in Documaker Workstation.

Description (optional) Enter a description of the form. You can enter up to 100 
characters. This description appears beside the form name when you 
are working with Groups. It also can help Documaker Workstation 
users make sure they have the correct form.

Multicopy Check this field if more than one copy of the form can be used for a 
transaction. This only affects Documaker Workstation.

Overflow This field is for legacy use.

Pull Check this field if the form is manually inserted into the form set as 
needed — there is no electronic image. This only affects Documaker 
Workstation. To add a pull form, you must check this field, then on the 
Image List window, highlight the blank line and click List. Highlight 
End of List on the Recipient window and click Add. Next add a 
recipient with a copy count of one (1) and click Ok.

Hidden Form is hidden from view in the entry environment but data can be 
embedded on the form for later use.

Staple Forms on certain Metacode and PCL printers can be stapled.

Size Choose the paper size, Only the most common are listed:
Letter - prints on default paper size (8.5 x 11)
Legal - prints on legal paper (8.5 x 14)
A4 - prints on standard European paper (210mm x 297mm)
Executive - prints on executive paper (7.25 x 10.5)

Orientation Choose from portrait or landscape. The default is portrait.

Recipients Studio shows you the names of the recipients defined by the 
Recip_Names INI option. For each recipient, you can specify whether 
the recipient should receive: 
- One copy
- Two copies
- Three copies
- A number of copies set via DAL (if not overridden by a trigger)
- A number of copies set via a GVM variable (if not overridden by a 
trigger)
- Eligible
- The recipient is not eligible to receive copies of this form.
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NOTE: You can use the icons at the top of the option area to save the changes or insert 
an image from the library or disk.

To define image-level triggers, see Setting Up Triggers on page 104 and SetRecip 
Options on page 107.
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MODIFYING
FORMS

Follow these steps to open and modify a form:

1 Double click on Forms. The Open File window appears:

2 Select the form you want to work with and click Ok. When you check out a form for 
editing or viewing, the Form View window appears. Inside the Form View there are 
several panels that show information about that form.

The first panel shows a tree view of the images that comprise the form. The images 
are segmented by page and whether they are designated as a header or footer 
images.



Modifying Forms

101

The next panel shows you the property settings for the active object. This is where 
you add or modify the property settings.

The final panel includes a preview of the form that shows the default layout of the 
images. You can scroll through this panel to see all the pages defined for the form.

If you click on the Triggers tab. The window changes as shown here:

The tree view shows you the form and image triggers associated with each. As you 
click on a trigger in the tree, the Property window shows you the various attributes 
associated with that trigger.
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NOTE: There are two types of triggers. The ones shown in the examples are the 
standard triggers which have been in use through prior releases. Newer 
triggers are actually given names that appear in the tree. The attributes 
displayed in the Property window will differ.

Note you can resize the various components of the view to suit your needs. For 
instance, you can zoom the Preview panel to make images larger or smaller and 
you can scroll to view a particular page.

NOTE: For more information on image-level triggers, see Setting Up Triggers on page 
104 and SetRecip Options on page 107.

3 When you finish modifying a form, select the File, Check in option to save the form 
and check it into the library. The File Information window appears. 

4 Set the library attributes that apply to the form and the changes you made.

NOTE: To learn more about the Mode, Status, Class, and Project fields see Managing 
Resources on page 171.

This window shows you the previous library settings for this form and lets you set 
new values. You set up the various modes, statuses, classes, and project codes 
elsewhere, but this window lets you choose the appropriate entry from 
predetermined lists.

The revision number is automatically set for you. When you specify that you intend 
to create a new version of the document, you can then enter a new effective date 
for that version.
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5 Click Ok to check the document back into the library and make it available for 
others sharing the same resources.

Dropping a form Dropping a form does not delete the actual FOR file, but does remove it from the library 
and from the list. To drop a form, highlight the form and then right-click. Select Drop.
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SETTING UP
TRIGGERS

You can create triggers at both the form and image level. Image-level triggers are 
stored at the form level and specify the condition that would cause an image to be 
included (or triggered) with a transaction.

Image level triggers are stored at the form level and specify the condition that would 
cause the image to be included on the form. Only set up image level triggers if the 
image's presence on the form is conditional.

Studio assumes you do not want to trigger any of the images that comprise a form if 
the form-level trigger is false. Therefore, image level triggers are automatically ignored 
when the form level trigger for the transaction being processed is false.

NOTE: If you omit a form-level trigger, the system does not operate as efficiently since 
every image-level trigger must then be evaluated by the system.

Follow these steps to add image-level triggers.

1 Highlight Forms, right click and select Open.

2 Select the form and click Ok.

3 Highlight the image to which you want to assign a trigger and click on the Triggers 
tab.

4 On the Triggers tab, select the trigger you want to edit then right click and choose 
Add.

Click the Triggers tab.
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5 The SetRecip table appears, on which you can edit or set up the triggers for the 
image.

Editing a trigger If you need to modify a trigger, right click on the trigger and select Edit Trigger File. The 
SetRecip table appears. 

You can also highlight the trigger and click on this icon:
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Click here to open the 
SetRecip table.
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SETRECIP
OPTIONS

The SetRecip Table lets you specify the conditions under which a form or an image will 
get triggered. Depending upon the requirement, not every field is completed. This table 
discusses each field:

Field Description

SetRecip Information

Transaction Codes
<TRANSCDS>

By including one or more Transaction codes in this field, 
you trigger a particular form (or image) only if the extract 
file record includes that particular Transaction Code.

<RECIPS> ???

Search Mask (Counter)
<MASK1>

Lets you set the criteria to determine whether or not a form 
(or image) belongs in the form set. The criteria allows the 
Rules Processor to get specific data from the extract file. 
Adds one form (or image) for every occurrence of the 
search mask per transaction. The Occurrence Flag must be 
set to one (1) for the search mask to act as a counter.

Occurrence Flag
<OCCURRENCE>

To use the search mask as a counter, the Occurrence Flag 
(overflow) must be set to one (1). Use with the Search 
Mask Counter, Records on Different First Image, and 
Records Per Overflow Image fields. (0=no overflow and 
1=overflow)
Performance issue flags in this field include:
- Master (M) form level trigger flag
- Form (F) form level trigger flag
- Subordinate (S) image level trigger flag 

Records on different first 
image
<RECSPER1ST>

Lets you indicate the number of records that appear on the 
first image before overflowing to a new image.

Records per overflow image
<RECSPERIMG>

Lets you specify the number of records matching the 
search mask that will fit on the specified overflow image. 
If the value is zero (0) and the Occurrence Flag is set to one 
(1) with the Search Mask Counter set, the system 
automatically sets this flag to one (1) to perform the 
overflow calculations.

Search Mask (True/False)
<CONDITIONAL>

Similar to Search Mask (Counter), but only one form (or 
image) is triggered, regardless of how many occurrences 
of the condition exists.

Custom Rule Name
<FUNCTIONNAME>

Normally used for custom implementation requirements. 
Only exceptions are RECIPIF and RECIPCONDITION rules.

Custom Rule Parameters
<DATA>

Specifies parameters for the custom rule used in the 
Custom Rule Name field.
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UNDERSTANDING RECIPIENT COUNTS

Although you can specify a recipient count at the form level, technically, recipient 
counts can only occur at the image level. The count shown at the form level actually 
represents the first occurrence of a recipient on an image contained within the form.

For instance, suppose you have these images:

with these possible recipients: Agent, Insured, and Memo, as shown in this table:

Assuming you have these images defined in this order: IMGA, IMGB, and IMGC on the 
form, your form-level recipient list will show the following:

Recipient Information

Form Level Trigger
Recipient Copy Count
<RECIPCPYCT>

Image Level Trigger
Recipient Copy Count
<RECIPCPYCT>
Recipient names listed with 
no check or a check

Defaults the recipient copy of each recipient defined at the 
form level
If recipient was eligible in the form file, it is checked here.

IMGA recipients IMGB recipients IMGC recipients

Agent not eligible Agent 1 copy Agent 2 copies

Insured 1 copy Insured not eligible Insured 2 copies

Memo not eligible Memo not eligible Memo not eligible

Field Description
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Notice that even though IMGC has a different copy count for Agent and Insured, the 
form shows the count of the first occurrence of that recipient. In this case, Insured first 
occurs on IMGA. Agent first occurs on IMGB and Memo does not occur on any image. 
Therefore, the form shows one copy for both Insured and Agent and not eligible for 
Memo, since it is not used anywhere.

When you change the recipient count at the form level, the system scans that form’s 
images. The system changes the recipient count for any image which shared the same 
recipient count value as the form to match the new setting defined at the form level. If 
the image did not share the same recipient value as the form or if that recipient had a 
different count, the system does not change the value.

Using the example above, assume you are changing the form level definition of Agent 
as shown here.

The resulting changes at the image level are shown in this table:

Notice that only IMGB changed to show Agent getting three copies. IMGA did not define 
the recipient and therefore did not change. IMGC did define the recipient, but had a 
different count (2) from what was shown at the form level. Therefore, it did not change 
either.

A value of not eligible means the recipient is not defined for a given image. If no images 
are using a given recipient, the form level will also show not eligible as the current 
value. In this example, the recipient Memo is not used on any of the images.

When you change a recipient at the form level that was formerly not eligible to have 
another value, you are adding that recipient to all subsequent images with the count 
you specify. For example, assume you define Memo at the form level as shown below:

The resulting change to the images is shown in this table:

IMGA recipients IMGB recipients IMGC recipients

Agent not eligible Agent 3 copies Agent 2 copies

Insured 1 copy Insured not eligible Insured 2 copies

Memo not eligible Memo not eligible Memo not eligible

IMGA recipients IMGB recipients IMGC recipients

Agent not eligible Agent 3 copies Agent 2 copies

Insured 1 copy Insured not eligible Insured 2 copies

Memo 1 copy Memo 1 copy Memo 1 copy
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Since none of the images previously defined a value for the Memo recipient, all of the 
images accepted the new value you assigned at the form level. In effect, all of the 
images had the same prior value for this recipient, as shown at the form level and 
therefore all matched. At this point, if you decide an image should not define this 
recipient or should have a different count, you can change that image independent of 
the others.

There is one exception to the matching rule where only those images that define the 
same value as shown on the form level will change. This occurs if you should change a 
recipient to not eligible at the form level.

If you set a recipient to not eligible at the form level, it does not matter what value an 
image has for that recipient. All the images will accept and assign not eligible to that 
recipient, if you assign that value at the form level. Consider this example where Agent 
is changed at the form level:

If you look back at the prior table for the images, you will see that only IMGB and IMGC 
defined the Agent recipient, but both had different counts. The resulting change by 
assigning not eligible at the form level is show in this table:

Again, note that assigning not eligible at the form level for a recipient is an exception 
that changes all of the images contained by that form.

Keep in mind...

• The values shown at the form level for each recipient merely represent the first 
occurrence of that recipient found within the form.

• It is not necessary that all of the images have the same value for each recipient.

• If you change the first occurrence of a given recipient at the image level, the form 
level value for that recipient changes to reflect the definition of that first instance.

Using Variables to Set Copy Counts

You can use a GVM or DAL variable to set the copy count for images and forms triggered 
using the method known as DAL triggers. This makes it possible for the trigger script to 
assign the count based on user data, or in the case of GVM variables, to get a value 
directly from the data feed.

IMGA recipients IMGB recipients IMGC recipients

Agent not eligible Agent not eligible Agent not eligible

Insured 1 copy Insured not eligible Insured 2 copies

Memo 1 copy Memo 1 copy Memo 1 copy
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The key is that the DAL or GVM variable must have the same name as the recipient 
being mapped. For instance, if you are mapping the INSURED recipient and want to use 
a DAL variable, then the DAL variable must be named INSURED as well. Or if you want 
to use a GVM variable to map the copy count to the recipient AGENT3, then the GVM 
variable must be named AGENT3.

If the requested variable type cannot be found with the correct name, a warning 
message appears and the count is set to one (1).

To use a GVM variable to assign the count, select GVM variable on triggers tab as the 
copy count. Select DAL variable if you want to assign the count from a DAL variable. 
Here is an example:

You must establish the values assigned to the recipient named GVM and/or DAL 
variables referenced by the triggers prior to their use. You can do this in the trigger 
script or at any point before the trigger executes. Subsequent values assigned to the 
recipient named GVM or DAL variables do not affect forms and/or images that have 
already been triggered and assigned a value.
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Chapter 6

Working with Images

Studio makes it easy to create and maintain the 
images that comprise your forms. 

An image is a group of text or graphics or both which 
make up all or part of a form. You create images with 
the Images option. Each image is stored in a separate 
file, so you can reuse images in multiple forms and 
form sets. 

For example, a three-page form with text and graphics 
printed on both sides of each page, could contain a 
total of six images. Two examples of images include an 
insurance policy declaration page and a 1040 Federal 
tax return form.

This topic discusses:

• Overview on page 114

• Using the Screen on page 115

• Creating an Image on page 131

• Opening an Image on page 132

• Adding Objects on page 135
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OVERVIEW Images can consist of both static and non-static objects. When saved, an image is 
stored with the extension of FAP. Each form is comprised of a minimum of one FAP file. 
Typically, however, a single form consists of one or more images. Since multiple forms 
and images make up a form set, you can view and navigate through each form and 
image individually.

A form may consist of multiple images, and consequently you can view the varying 
images within a form by displaying different pages of the form.

An image can contain varying sections on one page. For example, an automobile 
insurance application form could consist of three images. The first image or page may 
contain three separate sections: a section for listing the automobiles you want to 
insure, a section for recording household driver information, and a section for selecting 
the type and amount of coverage you want for each vehicle. Using the page display 
options, you can zero in on and view the beginning of a particular section of the 
insurance application image.

Objects are the individual items which comprise your image. Examples of objects are 
boxes, barcodes, lines, graphics, and text. All objects have unique attributes within the 
image. Attributes include items such as position, size, font type, and color.

Forms consist 
of one or more 
images

Image A

Image B

Image C

Image D

Image E

Image F

Form 1

Form 2

Image A

Image B

Image C

Form 1

Section 1

Section 2

Section 3

Images consist 
of one or more 
sections
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USING THE
SCREEN

Studio places all the tools you need for professional document creation at your 
fingertips. The screen is your document work area. It is important to become familiar 
with the general screen layout and parts of the screen. Understanding the screen 
layout will help you work quickly and efficiently.

The first window that appears when working with images is shown here.

Title bar

Menu bar

Tool bar

Workspace

Status bar

Object tree Work area
Object options

Item Description

Title bar The title bar displays the name of the workspace you have open, 
followed by Documaker Studio, and then the name of the image you have 
open. 

Menu bar The menu bar provides the list of available pull-down menus.

Tool bar The tool bar contains a row of icons that provide quick access to common 
options.

Status bar The Status bar gives the coordinates of the mouse pointer in the work 
area. The mode of operation, such as ready or edit, also appears here.

Workspace The workspace lets you quickly access different items. It also shows 
which specific resources that are checked out (green check mark), which 
resources are checked out by another user that you would only have 
read-only access to (red check mark), and which resources are open in 
read-only mode or have never been checked into the library.
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The object tree gives you a list of all objects on the image on which you are currently 
working. You can access these objects from this area, but you cannot add objects from 
here. 

NOTE: A plus sign by the object type denotes that there are objects of that type 
existing on the image.

Object tree Shows the objects, by object type, that comprise the image.

Object 
options

Depending upon which object is selected in the work area, specific object 
properties will be shown. If no object is selected, the image properties 
appear. This area is grayed out until you begin working in the work area.

Work area This is where you create the image. Objects are placed in this area as the 
image is built.

Item Description

Object tree Objects tab Fields tab This is where the object’s options appear Work area Status bar
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USING THE MENU BAR

This section introduces you to the pull-down menus which include additional options 
or are only available when you are working with images. A summary of each of these 
menu appears below. The menus are listed in the order they appear on the menu bar.

NOTE: For information on the standard menus and menu options which are always 
available, see Using System Menus on page 14.

Area Description

Object tree The Object tree gives you a list of all objects on the image on which you 
are currently working. You can access these objects from this area, but 
you cannot add objects from here. 

Objects tab The Objects tab shows all types of objects, along with the specific objects 
under each type. Within type, they are listed in the order in which they 
were created. 

Fields tab The Fields tab shows all fields in the field database (FDB), broken into the 
group (numeric or alpha) under which it falls.

Options area The options area gives you property information for the image or for 
individual objects you can create

Work area The work area is the area where you create the image. You can enlarge 
this area by closing or minimizing some of the other areas on the screen. 
You can also customize the ruler and grid.

Status bar The status bar gives you useful information while you are working with 
images.

Menu Description

Edit The Edit menu provides options you use as you create and modify images 
and the objects that make up images. You copy, cut, delete, and paste 
individual objects, or select all objects for editing. You can also delete pages 
and undo changes from the Edit menu.

View The View menu controls the appearance of your window as you create or edit 
images.

Insert The Insert menu lets you create objects and place them in your image. You 
can also insert objects by clicking on the object icon on the tool bar.

Format The Format menu provides options that let you format objects and text and 
set up the specific formatting properties.

Tools The Tools menu controls features used to check spelling and grammar on 
images and lets you enter the data entry check option. These types of 
features are used most often when an image is complete or near completion. 
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Using the Edit Menu

The Edit menu controls modifying images and objects within images. You can copy, cut, 
delete, and paste individual objects or select all the objects for editing. Edit options 
also let you find and replace text, make global font changes, and undo certain editing 
functions.

When you select Edit when working with images, this menu appears:

Option Description On right click?

Undo Cancels or reverses your last action or choice. Yes

Redo Reverses your last undo. Yes

Cut Removes a section of an image and places it on the 
clipboard.

Yes

Copy Duplicates a selected section of an image and places 
it on the clipboard.

Yes

Paste Places a section stored on the clipboard into an open 
image.

Yes

Delete Deletes the selected object. Yes

Duplicate Creates multiple copies of an object directly adjacent 
to the selected object.

Yes

Select

Character Selects a character.

Word Selects a word.

Line Selects an entire line.

Paragraph Selects a paragraph.

The grayed-out options are 
standard Edit menu options.



Using the Screen

119

Column Selects a column.

All Selects everything.

Deselect Deselects everything selected

Color Change the color of the selected object. Highlight the 
object, then choose this option.

Font Select or change fonts.

Bold Bold selected text.

Underline Underline selected text.

Strike-out Strike-out selected text

Do not 
Hyphenate

Prevents hyphenation of text.

Do not Break Prevents paragraphs, text labels, and embedded 
variable fields within text areas, and multi-line 
variable fields, from being broken by page breaks.

Language Select or change the language.

Find Locate words, phrases, or character strings.

Replace Locate words, phrases, or character strings and, if 
necessary, replace them.

Option Description On right click?
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Using the View Menu

The View menu controls the appearance of your screen as you work on an image. You 
toggle on and toggle off the display of various features through the use of items on the 
View menu.

When you select View, this menu appears:

Option Description On right click?

Toolbar Toggles on/off the Toolbar

Workspace Toggles on/off the Workspace area

Output Toggles on/off the Output area

Status Bar Toggles on/off the Status bar

Zoom... Lets you zoom in or out. Yes

Non-printing Tokens Display or hide formatting symbols such as 
paragraph markers and tab markers.

Refresh Lets you update and redisplay the image.

Reformat Reformat the text. Use after you have made 
significant formatting changes

Level Columns Balance the text in columns. 

The grayed-out options are 
standard View menu options.
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Using the Insert Menu

The Insert menu controls the creation and placement of objects in your image. Boxes, 
barcodes, lines, and other types of objects are drawn and positioned in your image. 
You can also import a page, whether it is blank or full of text. You can select to create 
an object from the Insert pull-down menu or you select to create an object from the tool 
bar. Any selection from the Insert menu or the tool bar activates the Image Editor create 
mode.

When you select Insert, this menu appears:

Option Description

Autocreate Lets you create objects repeatedly without entering the object’s options.

Barcode Activates barcode create mode.

Bookmark Used to add bookmarks to FAP files. A bookmark defines the text you 
want to print in the table of contents. A level number (TOC1, TOC2, and 
so on) can be used to determine the formatting to use. You specify 
whether the bookmark is to be used by a table of contents, table of 
figures, or index. 

Box Activates box create mode.

Break Text area feature – allows for inserting a break into a text area

Chart Activates chart create mode.

Field Activates variable field mode.

File Text area feature – allows for inserting a file into a text area

Guide Activates guide box create mode. Used for alignment of objects.
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Index and 
Tables

Used to add an index marker or a table of figures. Only applicable for 
Documaker Workstation.

Line Activates line create mode.

Logo Activates logo insert mode.

Note Activates note create mode.

Page Activates page insertion screen.

Shade Activates shading or pattern area create mode.

Text Area Activates text area create mode.

Text Area 
Special

Activates text area draw to insert from a file or the clipboard.

Text Label Activates text label create mode.

Vector Activates vector create mode.

Option Description
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Using the Format Menu

The Format menu controls formatting functions associated with the image and objects 
in the image. You can view or change the properties for the page, image, or individual 
objects from this menu.

When you select Format, this menu appears:

Option Description

Align Aligns according to image margins or a specific object.

Spacing Places selected objects at specified intervals either vertically or 
horizontally in relation to each other.

Convert to Text Area Combines selected text labels or text areas into a single text 
area.

Convert to Text Label Combines selected text labels into a single text label.

Split Text Splits a single text area into individual text labels.

Paragraph Text area feature – allows for formatting of paragraph

Tab Stops Text area feature – allows for formatting of tab stops

Border Text area feature – allows for formatting of border

Shade Text area feature – allows for formatting of shading

Bullets and 
Numbering

Text area feature – allows for formatting of bullets and 
numbering used in a text area

Columns Text area feature – allows for formatting of columns
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Using the Tools Menu

The Tools menu controls features often used when your image is complete or near 
completion. Spell check and Data Entry check are some of the features available. 

When you select Tools, this menu appears: 

Option Description

Spell Check Turns on the spell check feature. Lets you check the spelling of all 
text in your current image.

Spelling Options Lets you specify spell check options.

Grammar Check Gives you the option as to whether you wish to check the grammar 
on the entire document or only items that you have selected. 

Grammar Options Let you pick from the grammar checking settings that you want to 
use.

Data Entry Check Activates the image check feature. Lets you test the data entry and 
navigation rules you assigned to variable fields.

Validate Lets you validate your image.

Image Report Generate a report about the current image. You can view and print 
the report.

Compile Lets you compile your image file for a particular printer. Compile 
creates an image file for a PCL, AFP, PostScript or Metacode 
printer.

Convert Lets you convert a FAP file into a normalized Metacode or AFP file.
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USING THE RIGHT CLICK MENUS

When working with image properties, you can right click to see the following menu:

When working with an image, you can right click to see the following menu.

Option Description

Print Use to print the image.

Auto size Use to automatically size the image.
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Option Description

Zoom Lets you see a larger or smaller version of the image.

Ruler

Horizontal Select to display the horizontal ruler. Select again to remove the 
ruler.

Vertical Select to display the vertical ruler. Select again to remove the ruler.

FAPs Select to use FAP units (2400 per inch) on the ruler.

Inches Select to use inches on the ruler.

Centimeters Select to use centimeters on the ruler.

Picas Select to use picas on the ruler.

Points Select to use points on the ruler.

Print Prints a copy of the image.

Undo Cancel or reverse your last action or choice.

Redo Repeat the most recent change.

Cut Saves the changes you have made

Copy Removes a section of an image and places it on the clipboard.

Paste Duplicates a selected section of an image and places it on the 
clipboard.

Delete Places a section stored on the clipboard into an open image.

Duplicate Deletes the selected object.

Align Aligns according to image margins or a specific object.

Spacing Places selected objects at specified intervals either vertically or 
horizontally in relation to each other.
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USING THE TOOL BAR

The tool bar is useful because it serves as a quicker route for performing some 
functions that may be listed on a drop down menu. Here is an example of the tool bar 
shown when you are working with images:

Standard tool bar icons Shown below are the tool bar icons that are always available. The icons are listed as 
they appear, from left to right.

Icon Name Description

New 
Workspac
e

Creates a workspace.

Open 
Workspac
e

Opens a workspace.

Close 
Workspac
e

Closes an open workspace.

Toggle 
Workspac
e

Toggles between displaying and hiding the workspace.

New Creates a file.

Open Opens a file.

Save Saves the open file.

Print Prints the current object.

Cut Removes an object and places it on the clipboard.

Copy Copies an object and places it on the clipboard.

Paste Places an object from clipboard onto the current file.
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Image tool bar icons Shown below are the tool bar icons that only appear when you are working with 
images.

Undo Reverses your last action

Redo Reverses last undo.

Help Displays the Help window

Icon Name Description

Icon Name Description

Insert barcode Lets you insert a barcode

Insert bookmark Lets you insert a bookmark

Insert box Lets you insert a box

Insert chart Lets you insert a chart

Insert field Lets you insert a variable field

Insert guide* Lets you insert a guide box

Insert index or 
table

Lets you insert an index or table

Insert line Lets you insert a line

Insert logo Lets you insert a logo (graphic file)

Insert note* Lets you insert a note
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NOTE: An asterisk (*) denotes that icon is only available when you are composing 
forms. A note, however may be used during entry by including the following 
option:

< Control >

Insert shade Lets you insert a shaded area

Insert text area Lets you insert a text area

Insert text label Lets you insert a text label

Insert vector Lets you add a vector drawing

Spell check* Lets you check spelling

Data entry check* Lets you run a data entry check

Fonts Opens the font cross-reference file.

Bold Changes the font for the selected text to bold.

Italic Changes the font for the selected text to italic.

Underline Underlines the selected text.

Do not hyphenate Tells Studio not to hyphenate the selected text.

Border Opens the Paragraph Properties window so you can 
add a border.

Columns Opens the Columns Properties window so you can 
define columns.

Icon Name Description
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ShowNotes = Yes

The default is No. 

All image objects have default attributes. You can override these attributes by 
modifying the values assigned to the options in the default value can be 
overridden. The default values/attributes for the object are established in the 
Options by Group Section of the INI file.
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CREATING AN
IMAGE

You can create an image several ways, such as

• From the toolbar

• Using the File, New option

Studio then opens a new, untitled image:

Modify the image options as necessary and begin adding the objects that will comprise 
your image. See Adding Objects on page 135 for more information.
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OPENING AN
IMAGE

Follow these steps to select and open an image:

1 Double-click Images. The Open File window appears. You can also right click on 
Images and choose Open or Check out.

2 Highlight the image you want to edit or view and click Ok. The Image View window 
appears.

NOTE: If you check Open as read only and then click Ok, the file will only be available 
for viewing and someone else at another workstation would still be able to 
check it out. 

The Image View is similar to the Form View in that it shows you a representation of 
the image and provides a property panel when attributes about the various image 
objects can be shown.
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For example, if you click on a field, the properties are shown for that field. If you 
click on a box or static text label, the property panel changes to show the 
attributes for those objects. Here is an example of field properties:

Here is an example of how you edit box properties:



Chapter 6
Working with Images

134

Here is an example of how you choose a font for a static text label:

The property panel also shows you image properties, like DDT settings and other 
image level information.

Creating new fields and other objects on your image is as simple as clicking on the 
menu or toolbar to select what type of item you want to create and then using the 
mouse to designate the location on the image. 

When you create a new object, the property panel changes to reflect the current 
settings for your new object and lets you modify those settings to complete your 
definition.

3 Once you have completed the changes to an image, you can save your work and 
check the image back into the library for other users to access.

Click here to choose a font. The 
list of fonts is defined in your 
FXR file.
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ADDING OBJECTS Adding objects to an image is easy in Studio. You simply open an image or create a new 
image, then follow the steps below:

You can select the type of object you want to add two ways:

• From the Insert menu

• From the toolbar

From the Insert menu Choose the type of object you want to add and draw it on your image. Then move it 
where you want it and adjust the properties as necessary.

From the toolbar Use these icons:

NOTE: These tool bar icons only appear when you are working with images.
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To Click

Insert a barcode

Insert a bookmark

Insert a box

Insert a chart

Insert a field

Insert a guide*

Insert an index or table

Insert a line

Insert a logo

Insert a note*

Insert a shaded area

Insert a text area

Insert a text label

Insert a vector drawing
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Once you select the object and position it in your image, use the properties to 
customize the object to meet your needs. Here is an example of the properties for a 
variable field:
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Chapter 7

Working with Logos

Logos are bitmap objects you can place on an image. 
Studio does not create logos, but it does let you 
manipulate them. Logos are created in graphics 
applications such as Microsoft Paint or by scanning 
artwork.

Click Logos to work with logos.

This chapter discusses these topics:

• Using the Screen on page 140

• Managing Logos on page 148
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USING THE
SCREEN

Studio places all the tools you to work with graphics files, called logos, at your 
fingertips. The screen is your logo work area. It is important to become familiar with the 
general screen layout and parts of the screen. Understanding the screen layout will 
help you work quickly and efficiently.

The first window that appears when working with logos is shown here.

Title bar

Menu bar

Tool bar

Workspace

Status bar

logo properties Work area

Item Description

Title bar The title bar displays the name of the workspace you have open, 
followed by Documaker Studio, and then the name of the logo you have 
open. 

Menu bar The menu bar provides the list of available pull-down menus.

Tool bar The tool bar contains a row of icons that provide quick access to 
common options.

Status bar The Status bar gives the coordinates of the mouse pointer in the work 
area. The mode of operation, such as ready or edit, also appears here.
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USING THE MENU BAR

This section introduces you to the pull-down menus which include additional options 
or are only available when you are working with logos.

NOTE: For information on the standard menus and menu options which are always 
available, see Using System Menus on page 14.

Using the Logo Menu

The Logo menu provides you with tools to manipulate a logo. You can rotate, mirror, 
reverse, convert to black and white, resize, and crop a logo. When you select Logo, this 
menu appears:

Workspace The workspace lets you quickly access different items. It also shows 
which specific resources that are checked out (green check mark), 
which resources are checked out by another user that you would only 
have read-only access to (red check mark), and which resources are 
open in read-only mode or have never been checked into the library.

logo properties Here Studio shows you the properties for the logo you are working on.

Work area This is where you work with the logo. 

Menu Description

Logo The Logo menu provides you with tools to manipulate a logo.

Option Description On right click?

Rotate Yes

Left Rotates the graphic 90 degrees in a clockwise motion. Yes

Right Rotates the graphic 90 degrees in a counter-
clockwise motion.

Yes

Item Description
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Flip Rotates the graphic 180 degrees. Yes

Mirror Yes

Horizontal Lets you create a mirror image of the graphic by 
flipping it horizontally.

Yes

Vertical Lets you create a mirror image of the graphic by 
flipping it vertically.

Yes

Reverse Creates a negative image of the graphic file, where 
dark becomes light and vice versa.

Yes

Convert to BW Converts a color graphic into a black and white 
graphic. Reducing the number of colors typically 
reduces the size of the graphic.

Yes

Resize Lets you change the size of the graphic, either by 
entering a new height and width or by entering a 
percentage. For instance, if you enter 200%, Studio 
makes the graphic twice as big.
If you enter a new height and width, make your entry 
in FAP units (2400 per inch).

Yes

Border Space Lets you specify the size of the border that surrounds 
the graphic. You enter the size of the top, bottom, left, 
and right borders in FAP units (2400 per inch).

Yes

Clip Lets you crop a graphic. Using the Clip option, you 
draw a box around the part of the graphic you want to 
keep. Studio deletes everything outside the box.

Yes

Option Description On right click?
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USING THE RIGHT-CLICK MENU

When working with logo properties, you can right click to see the following menu.

Option Description

Print Prints a copy of the properties for this logo.

Save changes Saves the changes you have made

Rotate left Rotates the graphic 90 degrees to the left.

Rotate right Rotates the graphic 90 degrees to the right.

Flip Rotates the graphic 180 degrees.

Horizontal Lets you create a mirror image of the graphic by flipping it horizontally.

Vertical Lets you create a mirror image of the graphic by flipping it vertically.

Reverse Creates a negative image of the graphic file, where dark becomes light 
and vice versa.

Clip Lets you crop a graphic. Using the Clip option, you draw a box around 
the part of the graphic you want to keep. Studio deletes everything 
outside the box.
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When working with the actual logo, you can right click to see the following menu.

Option Description

Zoom Lets you see a larger or smaller version of the logo.

Ruler

Horizontal Select to display the horizontal ruler. Select again to remove the 
ruler.

Vertical Select to display the vertical ruler. Select again to remove the ruler.

FAPs Select to use FAP units (2400 per inch) on the ruler.

Inches Select to use inches on the ruler.

Centimeters Select to use centimeters on the ruler.

Picas Select to use picas on the ruler.

Points Select to use points on the ruler.

Print Prints a copy of the logo.

Undo Cancel or reverse your last action or choice.

Redo Repeat the most recent change.

Rotate

Left Rotates the graphic 90 degrees in a clockwise motion.

Right Rotates the graphic 90 degrees in a counter-clockwise motion.

Flip Rotates the graphic 180 degrees.

Mirror
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Horizontal Lets you create a mirror image of the graphic by flipping it 
horizontally.

Vertical Lets you create a mirror image of the graphic by flipping it vertically.

Reverse Creates a negative image of the graphic file, where dark becomes 
light and vice versa.

Convert to BW Converts a color graphic into a black and white graphic. Reducing the 
number of colors typically reduces the size of the graphic.

Resize Lets you change the size of the graphic, either by entering a new 
height and width or by entering a percentage. For instance, if you 
enter 200%, Studio makes the graphic twice as big.
If you enter a new height and width, make your entry in FAP units 
(2400 per inch).

Border space Lets you specify the size of the border that surrounds the graphic. 
You enter the size of the top, bottom, left, and right borders in FAP 
units (2400 per inch).

Clip Lets you crop a graphic. Using the Clip option, you draw a box around 
the part of the graphic you want to keep. Studio deletes everything 
outside the box.

Option Description
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USING THE TOOL BAR

The tool bar provides a quicker way to select options that may be listed on a drop down 
menu. Here is an example of the tool bar shown when you are working with logos:

Standard tool bar icons Shown below are the tool bar icons that are always available. The icons are listed as 
they appear, from left to right.

Table 3: 

Icon Name Description

New 
Workspac
e

Creates a workspace.

Open 
Workspac
e

Opens a workspace.

Close 
Workspac
e

Closes an open workspace.

Toggle 
Workspac
e

Toggles between displaying and hiding the workspace.

New Creates a file.

Open Opens a file.

Save Saves the open file.

Print Prints the current object.

Cut Removes an object and places it on the clipboard.

Copy Copies an object and places it on the clipboard.

Paste Places an object from clipboard onto the current file.
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Logo tool bar icons Shown below are the tool bar icons that appear when you are working with logos.

Undo Reverses your last action

Redo Reverses last undo.

Help Displays the Help window

Table 3: 

Icon Name Description

Table 4: 

Icon Name Description

Rotate left Rotates the logo 90 degrees to the left.

Rotate right Rotates the logo 90 degrees to the right.

Flip Rotates the logo 180 degrees.

Mirror horizontally Lets you create a mirror image of the graphic by 
flipping it horizontally.

Mirror vertically Lets you create a mirror image of the graphic by 
flipping it vertically.

Reverse Creates a negative image of the graphic file, where 
dark becomes light and vice versa.

Clip Lets you crop a graphic. Using the Clip option, you 
draw a box around the part of the graphic you want to 
keep. Studio deletes everything outside the box.

Resize Lets you change the size of the logo.
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MANAGING LOGOS Once you create a logo, you can modify it using this option. This gives you an easy way 
to resize, reverse, rotate, and manipulate the logo to fit your needs.

When you choose Logos, here is an example of the window that appears:

You can open the following types of files:

• Logo files (*.LOG)

• Bitmap files (*.BMP)

• Xerox font files (*.FNT)

• Xerox font data files (*.FNT)

• Xerox image files (*.IMG)

• Xerox logo files (LGO)

• PCX files (*.PCX)

• TIFF (Tagged Image File Format) files (*.TIF)

• Printer overlay files (*.OVL)

• AFP page segment files (*.SEG)

• JPEG (Joint Photographic Experts Group) files (*.JPG)

• IBM MMR IOCA (Image Object Content Architecture) files (*.ICA)

• Portable Network Graphics files (*.PNG)

• Windows Meta files (*.WMF)



Managing Logos

149

NOTE: Not all PNG formats are supported. Specifically, PNG supports a transparency 
attribute that is not supported. Studio only supports opaque (non-
transparent) bitmaps.

PNG also supports a variety of color bit patterns, such as - 1, 2, 4, 8, 16, 24, and 
32 bits per pixel. Studio does not support all of these formats, but a 3rd-party 
PNG library included with Studio will convert the bitmaps into a pixel format 
the system does support.

Studio converts PNG files into bitmaps when printing. It handles monochrome 
(1 bit), 16-color (4-bit), 256-color (8-bit), and full color (24-bit) bitmaps. 
However, not all printers can support these, so make sure you use bitmaps 
appropriate for your printer.

PDF only supports 1-bit and 24-bit bitmaps. So, some types of PNG files may 
look different when you create PDF files.

Positioning JPEG objects You can use the Z-Index option to position JPG objects:

< PrtType:HTML >

IMG_ZIndex = 100

The z-index indicates the stacking order of objects based on the order in which those 
objects appear in the HTML file. Higher values place objects closer to the front while 
lower values place them further to the back. Objects with the same value are stacked 
based on the order in which they appear in the HTML source.

For instance, a positive value positions an object above text that has no defined z-
index. A negative value would place the object below the same text.

If you omit this option or leave it blank, Studio will not layer objects.

Importing color bitmaps Studio can import the following types of color bitmaps:

• TIFF

• BMP

• LOG

• JPEG

To import another type of bitmap, first convert it to monochrome (black and white). 
Both gray-scale and color bitmaps can be converted to monochrome bitmaps. 

GDI and PCL print support color printing. Select File, Print to display the Print window. 
Select the printer type and device and click the Send Color option to print in color.

NOTE: Color bitmap and JPG files are only supported on Windows and UNIX systems 
if you are using the GenPrint program to print to color GDI, PCL, or PostScript 
printers or if you are producing color PDF or RTF output.

Color logos and TIF files are converted to monochrome for Metacode and AFP 
output, but are supported on Windows, UNIX, and MVS systems.
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Reverse black and white
file types

Studio can also import reversed black and white bits. A flag tells you whether a bitmap 
was stored in the opposite method. You can automatically reverse the bit if necessary.

Converting files You can use the Edit, Save As, option to convert a logo to one of the following file types:

• Logo files (*.LOG)

• Comp. Pack (*.LOG)

• Comp. TIFF (*.LOG)

• Bitmap (*.BMP)

• Xerox font (*.FNT)

• Xerox image (*.IMG)

• AFP page segment (*.SEG)

• JPEG (*.JPG)

To do so, open the logo and choose the File, Save As option. Select the type of file you 
want to convert to in the Save File As Type field. You can also convert files using the 
Manage, Conversion, Convert Logo Files option. If you have a large number of LOG files 
to convert into JPEG files, see the DocuToolbox Reference for information on using the 
LOG2JPG utility.

NOTE: An AFP page segment can contain a mixture of text, image objects, and 
graphics data objects and can be placed anywhere on a presentation page. 
Programs can request page segments for presentation in a page or overlay. 
Page segments are used for logos, signatures, and boilerplate. A Xerox font 
can also include multiple logos or signatures.

OPENING A LOGO

Use the following instructions to open a logo file for editing.

1 Choose Logos from the Manage menu or from the Workspace. The Open File 
window appears.
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NOTE: This option specifies the directory for storing logos:

< MasterResource >

LogoLib =

If you omit this option, Studio looks for logos in the path defined for FormLib.

2 Highlight the file you want and click Ok. The logo appears. If you want to open a 
file that has not been checked into the library, click Browse.

Importing a signature or
logo

You can import a signature or logo out of a Xerox font that contains multiple signatures 
or logos by clicking Browse and following these steps:
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1 Select Xerox font data in the Files of Type field. For the import to be successful, you 
must know the characters which comprise the signature or logo and you must 
match case when entering the characters to be imported. 

Be sure you do not select Xerox font files (*.FNT) as the file type by mistake.

2 Select the file containing the signature or logo and click Open.

3 Studio asks you to enter the characters to convert from the font file. You must 
enter the exact characters in the exact case for the system to properly import the 
signature or logo. For example, if the characters JHNDOE are used to print a 
signature from John Doe, you can’t enter jhndoe. 

4 Click Ok.

EDITING A LOGO

Once you open a logo, you have these options when you right click on a logo:

• Undo

• Redo

• Rotate

• Mirror

• Reverse

• Convert to BW

• Resize

• Border Space

• Clip

Undo Use the Undo option to cancel or reverse your last action or choice, and restore the logo 
to its prior appearance. Since the system keeps track of all actions, you can select Undo 
several times to undo your most recent changes one at a time.

Redo Use this option to repeat an action you have just reversed. For instance, if you rotate a 
logo, then click Undo to restore it to its original position, you can then click Redo to 
rotate the logo again.

Rotate The Rotate option takes the current logo and turns it in the direction you choose. You 
can rotate the logo left or right or flip the logo. 

Mirror Use this option to create a mirror image of the logo. If you want to create a mirror image 
of the logo, you can select either vertical or horizontal.

Reverse The Reverse option creates a negative of the logo by taking the open logo and 
switching the black and white colors.
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Convert to BW Use the Convert to BW option to convert a logo to black and white. Reducing the 
number of colors typically reduces the size of the logo. The system displays the Color 
Selection window when you choose this option. If you select Print in Color, the system 
prints the logo in the color you selected.

Resize The Resize option gives you two choices for changing the size of the logo you’re 
working in: absolute and by percentage. The Absolute option lets you set the height 
and width in inches. If you choose the Absolute option, your logo will not necessarily 
retain its current proportions.

The Percentage option lets you increase or decrease the size of the logo by the 
percentage you choose. If you choose this option the system retains the current 
proportions of the logo.

Border Space The Border Space option lets you add and remove white and black space around the 
logo. The amount of space can be as precise as needed.

To add white space, simply uncheck the Black Border field and set all the fields to the 
specific amount of white space you need. If you then want a black border or frame 
around the logo, check the Black Border field again and enter the amount or thickness 
of the border.

Clip The Clip option lets you crop the logo. After you select the Clip option from the Edit 
menu, outline the portion of the logo you want to keep by clicking and dragging the 
mouse. The selected area remains while everything outside the outline you dragged 
around the image is discarded.

SETTING ROTATION NAMES

Use the Normal, Downward, Upside Down, and Upward fields in properties to enter 
logo file names if you want to print a rotated logo using an AFP or Xerox Metacode 
printer. The names you enter here are the names of the printer resources (files stored 
on the printer) which are to be used when printing a logo which has a rotation of 0, 90, 
180, or 270 degrees. One system logo file can equate to four printer resource files.
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NOTE: PCL and PostScript printers do not have printer resource files, so they can 
automatically rotate a logo. You only need to enter these names if you are 
using an AFP or Xerox Metacode printer.

AFP and Metacode printers cannot automatically print a rotated logo. Therefore, you 
must create four printer resource files to support a logo printed in any rotation. Since 
you cannot rotate a logo directly on a FAP image, you need rotated logos when using 
logos on a non-portrait long edge image. For example,

• Portrait, long edge bind requires a zero (0) degree (normal) rotation printer 
resource.

• Portrait, short edge back page requires a 180 degree (upside down) rotation 
printer resource.

• Landscape, long edge bind requires a 270 degree (upward) rotation printer 
resource for Xerox printers and a 90 degree rotation printer resource for AFP 
printers.

• Landscape, short edge back page requires a 90 degree (downward) rotation 
printer resource for Xerox printers and a 270 degree rotation printer resource for 
AFP printers.

NOTE: If you are using a Metacode printer, do not enter more than six characters per 
name.

Changing the Resolution

The Resolution field in the Properties lets you change the dpi (dots per inch) of the 
logo. Resolution determines the clarity of the object for use with different printer types. 
The more dots per inch, the sharper and more defined the object appears.

Portrait, long edge bind

Portrait, short edge back page

Landscape, short edge back page

Landscape, long edge bind
Text

Text

Text

Te
xt

(270 degree rotation for Xerox)

(180 degree rotation)

(zero (0) degree rotation)

(90 degree rotation for Xerox)

(90 degree rotation for AFP)

(270 degree rotation for AFP)
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SETTING RULER AND GRID OPTIONS

You can select View, Options to turn on or off rulers and the grid.

The Grid Settings let you display or hide horizontal and vertical grid lines on the logo. 
Grid lines show you the edges of the logo. Select the appropriate Show field to display 
a grid line. Click Ok to exit the window and apply your changes.

By right clicking on a logo and choose the Rulers option, you can set the display 
options for the horizontal and vertical rulers. Select the ruler’s units of measure in the 
field to the right. You can choose between FAP units (1/2400 of an inch), points, inches 
(1/6, 1/8, or 1/10), centimeters, or picas. 
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Chapter 8

Creating Scripts

You can write DAL scripts to automate system tasks. 
Click on Scripts to open the DAL Script Editor.

This chapter discusses this topics:

• Using the Screen on page 158

• Overview on page 164

• Checking Syntax on page 166
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USING THE
SCREEN

Studio places all the tools you need to work with DAL scripts at your fingertips. The 
screen is your work area. It is important to become familiar with the general screen 
layout and parts of the screen to work quickly and efficiently.

The window that appears when working with a DAL script is shown here.

Title bar

Menu bar

Tool bar

Triggers

Workspace

Status bar

DAL functions Work area

Item Description

Title bar The title bar displays the name of the workspace you have open, 
followed by Documaker Studio, and then the name of the DAL script 
you have open. 

Menu bar The menu bar provides the list of available pull-down menus.

Tool bar The tool bar contains a row of icons that provide quick access to 
common options.

Triggers Here Studio lists the triggers associated with this DAL script.

Status bar The Status bar gives the coordinates of the mouse pointer in the work 
area. The mode of operation, such as ready or edit, also appears here.
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USING THE MENU BAR

This section introduces you to the pull-down menus which include additional options 
or are only available when you are working with DAL scripts.

NOTE: For information on the standard menus and menu options which are always 
available, see Using System Menus on page 14.

Using the Edit Menu

The Edit menu provides standard word processing options you can use as you create 
and modify DAL scripts. These options let you copy, cut, delete, and paste text or select 
all of the text in the script. Edit options also let you find and replace text.

When you select Edit when working with DAL scripts, this menu appears:

Workspace The workspace lets you quickly access different items. It also shows 
which specific resources that are checked out (green check mark), 
which resources are checked out by another user that you would only 
have read-only access to (red check mark), and which resources are 
open in read-only mode or have never been checked into the library.

DAL functions This panel lists the various categories of DAL functions and procedures. 
You can expand each category to see the DAL functions and procedures 
included within.
To insert a function or procedure, simply highlight it and then drag it to 
the appropriate location within the script.

Work area This is where you work with the DAL script.

Menu Description

Edit To this menu, Studio adds the Syntax Check option.

Script The Script menu provides you with options you can use when writing or 
editing a DAL script.

Item Description



Chapter 8
Creating Scripts

160

Using the Script Menu

The Script menu provides you with options you can use as you work with DAL scripts. 
You can insert and delete functions or convert the file into a library, trigger file, or 
script. When you select Script, this menu appears:

Option Description

Syntax Check Lets you check your script for syntax errors. See x for more 
information.

Option Description

Insert New Function Use to insert a DAL function.

Delete Function Use to remove a DAL function.

Convert to Library Use to convert this file into a library file.

Convert to Trigger File Use to convert this file into a trigger file.

Convert to Script File Use to convert this file into a script file.

The grayed-out options are 
standard Edit menu options.
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USING THE RIGHT-CLICK MENU

When working with scripts, you can right click to see the following menu.

NOTE: To learn more about individual DAL functions and procedures, see the DAL 
Reference.

Option Description

Cut Remove a highlighted selection and place it on the clipboard. Use 
Paste to insert the selection into another part of the script.

Copy Make a copy of the selection and place it in the clipboard. Use Paste 
to insert the selection into another part of the script.

Paste Insert the contents of the clipboard at the cursor location.

Delete Erase the selection. The selection is not stored on the clipboard so 
you must immediately select Undo if you change your mind.

Select All Select all of the script. You can then cut or copy the script.

Find Select to find a text string in the file.

Replace Select to find a text string and replace it with another text string.

Print Send the current file to the printer.

Insert Command Use to insert a DAL function or procedure. When you choose this 
option a list of categories appears. You can then choose the 
appropriate function or procedure from the appropriate category.
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USING THE TOOL BAR

The tool bar provides a quicker way to select options that may be listed on a drop down 
menu. Here is an example of the tool bar shown when you are working with scripts:

Standard tool bar icons Shown below are the tool bar icons that are always available. The icons are listed as 
they appear, from left to right.

Icon Name Description

New 
Workspac
e

Creates a workspace.

Open 
Workspac
e

Opens a workspace.

Close 
Workspac
e

Closes an open workspace.

Toggle 
Workspac
e

Toggles between displaying and hiding the workspace.

New Creates a file.

Open Opens a file.

Save Saves the open file.

Print Prints the current object.

Cut Removes an object and places it on the clipboard.

Copy Copies an object and places it on the clipboard.

Paste Places an object from clipboard onto the current file.
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Script tool bar icons Shown below are the tool bar icons that appear when you are working with scripts.

Undo Reverses your last action

Redo Reverses last undo.

Help Displays the Help window

Icon Name Description

Icon Name Description

Find Select to find a text string in the file.

Repeat Select to repeat the last action.

Find previous Select to return to reverse the search.

Replace Select to find a text string and replace it with another 
text string.

Check syntax Select to check your script for syntax errors.
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OVERVIEW Here is an example of the window that appears:

After you select the script you want to edit, the system displays in a window similar to 
the one shown here:

You can insert DAL functions 
and procedures from here.

Simply highlight the function 
or procedure you want to 
insert, then drag it to the 
appropriate location in the 
script.
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When editing a DAL script, you can right click to display a menu of editing options. This 
menu provides another way to insert a DAL function or procedure, as shown below:

NOTE: To learn more about individual DAL functions and procedures, see the DAL 
Reference.

Right click to display 
the context menu, 
then highlight the 
Insert Command 
option.

You can choose from 
a list of DAL function 
categories.

When you highlight a 
category, the 
applicable functions 
appear. 

Highlight the one you 
want to insert it into 
your script.
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CHECKING SYNTAX When creating a DAL script, you can easily check for syntax errors by choosing the Edit, 
Check Syntax option.

NOTE: You can also check for syntax errors by clicking this icon on the tool bar: 

Here is an example of what you will see when you check the syntax of a DAL script:

The following icon marks each line with a syntax error:

An explanation of the syntax error appears in the status bar

Studio tells you the line and column number to make it easier to find the error.

This table discusses the types of things Studio checks for:

This icon tells you there is a 
syntax error on this line of the 
DAL script.

Here, the system explains the 
error
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Error Description

Out of memory This can indicate you are running low on memory or have some 
other internal memory problem. 
Try closing any other applications or open documents within the 
program to free memory before trying again.

Open failure on 
script file

This indicates the program could not locate or open the 
referenced script file. This could mean the file name or path is 
incorrect or that the file did not contain the expected DAL 
information. 
You would typically not receive this error during a syntax check.

Syntax error This message indicates that something on or about the line 
where it was encountered that did not meet the syntax 
requirements. 
Check parentheses for matches; that quoted strings are defined 
correctly; and that semicolons are used to separate multiple 
statements on a single line.

Wrong number of 
parameters

This is an unlikely message to receive during a syntax check. The 
syntax check does not actually execute internal functions and 
therefore only minimal parameter validation occurs. This 
message indicates that a DAL function or procedure was called 
with the incorrect number of parameters. Check the 
documentation of the function for more information.

Wrong type of 
parameter

This message indicates that a parameter passed to a DAL 
function or procedure is not of a type that can be used by that 
routine. In most cases, DAL automatically handles the conversion 
of variables types, however, there are some variable types it 
cannot convert. 
For instance, a list variable can be assigned to another list 
variable, but it cannot be converted to a number or string. 
Therefore passing a list variable to a function expecting a string 
might cause such an error.
This is an unlikely message to receive during a syntax check. The 
syntax check does not actually execute internal functions and 
therefore only minimal parameter validation occurs. 

Invalid or unknown 
symbol

During a syntax check, Studio can only verify that the defined 
symbol follows the correct naming requirements. The syntax 
check cannot verify whether functions or variables you might use 
will exist at runtime. 
Encountering this error during a syntax check means the defined 
item does not conform to naming requirements. If a DAL variable 
or function you reference does not exist at the point where it is 
referenced during the runtime execution of the script,  you will 
not receive this message at that time.
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Invalid assignment 
statement

This means you have created an invalid arithmetic or assignment 
statement. Typically this indicates you forgot the assignment 
operator or omitted an expected arithmetic operator. 
For instance, AVAR=BVAR is correct syntax; using AVAR==BVAR 
would generate the invalid assignment statement message 
because the operator == is unknown. AVAR BVAR (with no 
operator specified) also generates the invalid assignment 
statement message.

Cannot modify target This message indicates the script is incorrectly trying to assign or 
change data associated with a constant (or keyword) item that 
cannot be changed. 
An example of this is to use a statement like 1 = AVAR. You 
cannot change the constant value of 1 in this case. A situation 
where you might encounter this error is when you attempt use a 
variable that happens to have the same name as a defined 
function or DAL routine.

Unexpected internal 
error

This message indicates the script processing has resulted in a 
condition that was not expected. It is difficult to predict when you 
might receive this error, although it is probably more likely to be 
encountered during runtime execution of the script than during a 
syntax check. 
Typically, this message indicates you have an expression or 
function parameters that do not resolve to an expected state.

Missing or 
mismatched 
parenthesis

This message indicates the number of opening and closing 
parentheses used within the statement do not match. For each 
open parenthesis, there should be a closing parenthesis.

Invalid IF statement This message indicates there is some problem with the 
construction of the IF statement. It could mean you have 
forgotten a parenthesis, or a quote around a constant, or that a 
subsequent keyword limited to use within an IF statement was 
encountered outside of the IF structure. This would include these 
keywords: ELSE, ELSEIF, and END.

Unexpected after 
ELSE

(24) The ELSE statement is the final branch of an IF statement. 
This error will be generated if another ELSE or ELSEIF condition is 
found that appears to belong to the same IF statement.

CONTINUE outside of 
WHILE

(25) The CONTINUE statement is only valid when used within a 
WHILE-WEND statement group. 
This error may not always be caught by syntax checking, but will 
be during runtime execution.

BREAK outside of 
WHILE

(26) The BREAK statement is only valid when used within a 
WHILE-WEND statement group. 
This error may not always be caught by syntax checking, but will 
be during runtime execution.

Invalid WHILE 
statement

(27) This message indicates a WHILE statement did not end with 
a WEND or that a WEND statement was encountered without a 
WHILE.

Error Description
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Unexpected WEND 
statement

(28) Similar to the invalid WHILE statement message, this 
message indicates a WEND statement was encountered 
incorrectly. 
This error may not always be caught by syntax checking, but will 
be during runtime execution.

Unexpected end of 
script

This message indicates the end of the script was encountered 
before finding an expected keyword or that the script was empty. 
Such a condition can occur if you fail to terminate an IF statement 
with an END or a WHILE statement with a WEND before 
encountering the end of the script. 
This error may not always be caught bysyntax checking, but will 
be during runtime execution.

Invalid expression 
syntax

This error indicates the expression did not result in a value as 
expected. Such a situation can occur if you called a function or 
procedure that expected a value and none was returned. 
Since the syntax check does not actually execute internal 
functions, it is not always possible to identify this problem prior 
to runtime. This error may not always be caught by syntax 
checking, but will be during runtime execution.

Attempt to divide by 
zero

This message indicates the expression results in an attempt to 
divide a numerator by zero. This is an undefined mathematical 
situation and is flagged as an error by most processors. In most 
cases, this message appears during runtime execution. The 
syntax checker only catches this situation if the expression 
explicitly uses a zero constant as a devisor.

No result value 
returned

This message is unlikely to be generated during a syntax check. 
The message indicates that a function or called DAL script or 
routine did not place a return value on the internal stack. If the 
code is calling a DAL routine, make sure all the RETURN 
statements in the called script include a return parameter and 
that there is a RETURN statement at the end of the script.

Statement label 
already used

This message indicates the same label used as a destination for 
a GOTO statement has been defined in multiple places within the 
same script. This error may not always be caught by syntax 
checking, but will be during runtime execution.

Unknown statement 
label

This message indicates the label defined as the destination for a 
GOTO statement could not be located within the defined script. 
Typically, this means you have incorrectly identified the label in 
the GOTO statement or have omitted the label destination in the 
script. Make sure to name the destination label on the GOTO 
statement with the tailing colon. 

GOTO BOB (incorrect)

GOTO BOB: (correct)

Invalid statement 
label

This message indicates the defined label does not conform to the 
definition requirements of a GOTO label. Statement labels have 
the same requirement as string variables and must begin with a 
letter and be no more than 64 characters in length, including the 
terminating colon on the end of the name.

Error Description
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Function out of place This message indicates you have called a function which must 
return a value, but did not define the expression in a way to use 
the resulting value. 
For instance, the HaveForm function must return a zero or one to 
indicate if the defined form is included in the document set. If you 
use this function without capturing or testing the returned value, 
this message appears. 
Since the syntax checker does not actually execute internal 
functions, it is unable to identify when such a situation might 
exist. These errors occur during the runtime execution of the 
script.

Illegal parameter 
value

This message indicates you have called a function or procedure 
with an invalid parameter value. 
Since the syntax checker does not actually execute internal 
functions, it is unable to identify when such a situation might 
exist. These errors occur during the runtime execution of the 
script.

Table has not been 
opened

(22) This message indicates a function or procedure was called 
with a parameter naming a table, such as a database file, that 
was not explicitly opened. 
Since the syntax checker does not actually execute internal 
functions, it is unable to identify when such a situation might 
exist. These errors occur during the runtime execution of the 
script.
If you encounter this error, make sure that the DBOPEN 
statement was not skipped due to an IF statement or GOTO 
operation.

Error Description
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Chapter 9

Managing Resources

This chapter discusses how you can store the 
resources that comprise your forms in libraries and 
use Studio and other tools to manage those resources.

Included in this chapter is information on:

• Overview on page 172

• Creating Libraries on page 189

• Working with Libraries on page 218

• Using the LBYPROC Utility on page 254

• Troubleshooting on page 256
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OVERVIEW You use a variety of resources to build a form set. These resources can include images 
(FAP files), logos (LOG files), and processing scripts (DAL scripts).

Studio creates a library into which you can place the resources and provides features 
that let you manage those resources. For instance, Studio lets you date stamp a 
resource so it will not be used until its effective date is reached.

As you work with resources, such as images or logos, Studio lets you check resources 
into and out of the library. When a resource is checked out, Studio marks that resource 
as being locked and prevents others from checking it out until it is checked back in.

Documaker Workstation uses the library management capabilities to get the 
appropriate version of a resource, based on the effective date of the documents being 
generated.

Likewise, Documaker RP uses the library management capabilities to load the correct 
resources from the library when needed. And, the Documaker Bridge for 
Docupresentment uses library management capabilities to retrieve the correct version 
of each of the resources used when the document was archived.

To better understand library management, it is important for you to become familiar 
with the following topics:

• Terminology on page 173

• Concepts on page 175

• How It All Works on page 183

• Managing Workflow on page 188
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TERMINOLOGY

Before you begin managing your resources in libraries, there are some terms you 
should understand and concepts you should be familiar with.

Check in The process of putting a resource back into the library after you have checked that 
resource out. 

Check out The process of selecting a resource from a library. When you select the resource, it is 
locked. It remains locked until you check the resource back in.

Effective dates A field in the library index that is associated with a resource in the library. This field 
indicates the date at which the resource is available for use, or when it will become 
effective.

Expire The process of designating a library resource as being unavailable for use beginning 
with a supplied expiration date.

Extract The process of making a copy of a resource in a library and writing that copy to disk.

Libraries Refers to the physical files in which the resources are stored. Logically, a library is 
divided into an index portion and a data portion.

Modification dates A field in the library index that contains a timestamp indicating the date and time the 
resource was last modified or checked in to the library. This field is in hexadecimal 
format in the index but is formatted to a more readable format when displayed in the 
tools.

Revisions A field in the Library Index that indicates the minor change number. The revision 
number is generally incremented by one each time a resource is checked out and back 
in. If, however, the version number is incremented, the revision number is reset to 1 for 
that version. A revision number consists of five digits, such as 00001.

NOTE: When a resource is expired, the revision field is set to EXP.

Response files In Documaker terms, a file created by the LBRYMGR utility that contains commands and 
data. These commands and data are then read by Studio (or the LBRYMGR utility) and 
processed accordingly.

Promotion The process of copying (or promoting) resources from one library to another library, 
based on criteria you specify. Resources from the source library that have a newer 
modification date than resources, with a corresponding name, in the target library, are 
copied to the target library.

Unlock The process of removing the lock from a resource that you have previously checked 
out. Only the user who locked the resource can unlock it.
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Versions A field in the library index that indicates the major change number. The version number 
is only incremented upon check in when you check the Increment Version field. If you 
want to change the effective date for the resource you are checking in, you are forced 
to check the Increment Version field before you are allowed to type a new effective 
date.

In Documaker 10.2 and higher, a version number consists of five digits, such as 00001.
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CONCEPTS

In addition to the terminology you should be familiar with, there are several concepts:

• Understanding Libraries on page 175

• Processing with Effective Dates on page 177

• Retrieving Resources with Version and Revision Numbers on page 178

• Stringently Checking Resources on page 179

• Understanding Run Dates on page 181

Understanding Libraries

A Documaker library consists of an index and its corresponding data. Generally, the 
index is contained in one table and the data portion in another table. The index table 
contains one row for each version and revision of a resource with a specific name and 
of a specific type.

The index table includes these fields. The maximum length is indicated in parentheses:

Field Description

FileType
(3)

This field can contains a value that defines the type of resource this row 
refers to, such as FAP, LOG, BDF, GRP, or DAL.

FileSTyp
(3)

This field indicates the sub type of the resource this row refers to. This field 
is not currently used and is usually set to the value of the FileType field.

FileName
(100)

This field indicates the name of the resource, such as Q1SNAM, Q1ADDR, or 
IMAGE1. The name can consist of up to 100 characters.

Resource
(25)

Reserved for future use.

Descript
(100)

This field contains a description of the resource or the last change made to 
it. You can enter up to 100 characters.

Effectiv
(10)

This field contains the date on which you want this resource to become 
available for processing. This date is stored in D4 format (YYYYMMDD) in 
the library index. 
Depending on your locale setting (Choose Settings, then go to the Locale 
option in the Language control group), you may see the date displayed in 
other formats like MMDDYYYY or DDMMYYYY.

ModifyTm
(10)

This field indicates the date and time the resource was last checked in or 
modified. This date appears in the appropriate format for your locale 
setting, along with the time.

FileIndx
(8)

This field contains a number that, for xBase implementations, connects 
this index record to a compressed file in the data portion of the library.

RecStat
(3)

This field indicates whether this resource is locked or not. If locked, the 
field contains LOC, otherwise it is blank.
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Version
(5)

This field contains the version number of this resource. The version 
number starts at 00001 and, as the resource is checked out and checked in, 
is incremented if you have checked the Increment Version field.

Revision
(5)

This field contains the revision number of this resource. The revision 
number starts at 00001 and, as the resource is checked out and checked in, 
is incremented. If you have checked the Increment Version field, the 
version number is incremented instead of the revision number and the 
revision number is reset to 00001.

When a resource is expired, the revision field is set to EXP.

UserID
(64)

This field shows you the user ID of the user who last modified the resource, 
or who has the resource checked out. This ID can consist of up to 64 
characters.

UsrLevl
(2)

Reserved for future use.

Passwd
(64)

Reserved for future use.

Unique_ID
(26)

This field contains a unique identifier used for internal purposes.

ArcKey
(18)

This key is used with DBMS implementations of the library to connect this 
index record to a row in the data table of the library. When using a DBMS, 
this field is used instead of the FILEINDX field, which is used in xBase 
implementations of the library.

LibName
(129)

This is the name of the library. This name can consist of up to 129 
characters.

AppData
(10)

This field can contains up to 10 characters of additional, customer-specific 
application data.

Mode
(25)

This field indicates the mode of the resource. You define the modes using 
the Manage, Settings options. For instance, you could set up modes to 
denote milestones in the development process such as Development, 
Testing, and Production. You can enter up to 25 characters. For more 
information, see Defining Mode, Status, Class, and Project Options on 
page 252.

Status
(25)

This field indicates the status of the resource. You define the status codes 
using the Manage, Settings options. For instance, you could have codes 
like Pass or Fail. You can enter up to 25 characters. For more information, 
see Defining Mode, Status, Class, and Project Options on page 252.

Class
(25)

This field indicates the class of the resource. You define classes using the 
Manage, Settings options. You can use classes to group resources by 
product lines or by geographical regions, such as GA, TX, or MD. You can 
enter up to 25 characters. For more information, see Defining Mode, 
Status, Class, and Project Options on page 252.

Field Description
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While the index portion of the library contains attributes for each version/revision 
combination of a resource that is stored in the library, the data portion of the library 
contains the resources themselves.

The structure of the data portion of the library depends on how the library is defined 
(xBase, DBMS, Documanage), but in general, the data portion contains each of the 
version/revision combinations of the resources listed in the library index.

Processing with Effective Dates

Because document requirements change over time, your forms will evolve. Studio lets 
you assign effective dates to resources so you can make changes ahead of time while 
making sure those changes are put in effect only when appropriate. You can change the 
content of a form as necessary and control the date at which the new form takes effect. 
Using effective dates also lets you preserve prior versions of a form so when you need 
to retrieve a version of a form that was effective, for example, a year ago, you can.

In the Documaker system, a form may be composed of one or more images. An image 
is also called a FAP file because fap is the extension the Studio applies. So, if a form 
needs to be changed, then one or more of the images (FAP files) that comprise the form 
need to be changed.

For example, you have a form called DEC PAGE. This form consists of these images...

• Q1SNAM

• Q1MDC1

• Q1MDC2

• Q1MDC3

The Q1SNAM image contains the company’s corporate address. The company’s 
corporate address is going to change next month. and you want to go ahead and 
change the address to reflect the change.

You can check out the Q1SNAM image (FAP), make the address change, then check in 
the Q1SNAM image and set the effective date for this new version of Q1SNAM to the 
first of next month.

If the DEC PAGE form is assembled at any time this month, the version of Q1SNAM that 
is effective this month (the older one) is used. If the DEC PAGE form is assembled next 
month, the version of Q1SNAM that is effective next month (the newer one) is used.

This example uses a FAP file to demonstrate how the effective date of a resource can 
be used to cause a different version of that resource to be used at the appropriate time. 
You can also manage logos (LOG files) and DAL scripts in the same way. 

Project
(25)

This field indicates the project code that last modified this resource. You 
define project codes using the Manage, Settings options. You can enter up 
to 25 characters. For more information, see Defining Mode, Status, Class, 
and Project Options on page 252.

Field Description
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NOTE: Keep in mind if you are triggering forms based on effective date processing:

If possible, avoid creating forms with effective dates that require updated 
printer resource files, such as fonts, form overlays, bitmap files, and so 
on.

Otherwise, make sure you have the corresponding set of printer resource 
files for the forms based on the effective date to be processed.

Retrieving Resources with Version and Revision Numbers

When a resource is added to the library it is assigned a version number and a revision 
number. A resource added to the library for the first time is given a version number of 
00001 and a revision number of 00001. The version number and revision number 
change as the resource is checked out, changed, and checked back in.

Generally, if you check out a resource to make a small change, the revision number of 
the resource is incremented by one when you check in the resource. If you make a 
major change to the resource, or if this change requires you also change the effective 
date, the version number is incremented by one. The version number is considered a 
major number and the revision number is considered a minor number. 

Typically, version/revision numbers are shown in this format:

version.revision

and leading zeros are omitted. So version 00001, revision 00003 is referred to as 1.3.

NOTE: Documaker (versions 10.2 and higher) enforces the rule that all revisions of a 
particular version of a resource must have the same effective date. Prior to 
version 10.2, Documaker allowed revisions of a particular version of a resource 
to have different effective dates.

When you request a resource, the request generally supplies a resource type (FAP, 
LOG, or DAL), a name (such as Q1SNAM) and a run date (such as 20071225, which is 
December 25, 2007). Studio searches the library index for items that match that name 
and type, then chooses the one which has an effective date closest to, but not 
exceeding, the run date.

If Studio finds there are two or more versions of the same resource with the same 
effective date, it chooses the one with the higher version/revision number. For 
instance, the version/revision 2.1 is considered to be higher than the version/revision 
1.2, so between these two resources, Studio would choose 2.1.
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Stringently Checking Resources

In Documaker 10.3 In Documaker 10.3 and higher, the StringentChecking option defaults to Yes. Stringent 
checking means that if Studio finds versions of a resource in the library but none are 
effective yet — their effective date is greater than the run date being used— it will not 
return any of those resources.

Although you should leave the StringentChecking option set to Yes, you can, however, 
override it, as shown here:

< LibraryManager >

StringentChecking =  No

When StringentChecking is set to No, Studio tries to return some version of the 
resource, even if that resource is not yet effective. If Studio finds versions of a resource 
in the library but none are effective yet, Studio returns the resource with the oldest 
effective date.

If the StringentChecking option is set to No and Studio does not find any versions of the 
resource in the library, it tries to find the resource on disk, in the location designated 
for that resource type in the INI file. If it finds the resource on disk, it returns that 
resource.

In Documaker 10.2 and
earlier

In Documaker 10.2 and earlier, the StringentChecking option defaults to No. If the 
system finds versions of a resource in the library but none of those versions are 
effective yet, it returns the oldest version/revision of that resource. 

If the system does not find any versions of the resource in the library, it tries to find the 
resource on disk, in the location designated for that resource type in the INI file. If it 
finds the resource on disk, it returns that resource. 

For DDT files only, if you want the system to issue an error message or to perform 
specialized processing, you can set the StringentChecking option to Yes. In Documaker 
10.2, stringent checking is only available for DDT resources and only affects the 
GenData program.

You can use these INI options to control the stringent checking of DDT resources:

< DDTResource >

ErrorOnMissingFile    = Yes

RemoveImageMissingDDT = No

StringentChecking     = No

WarnOnMissingFile     = Yes

Option Description

ErrorOnMissingFile The system normally generates an error if a DDT file cannot 
be found for a triggered image. Errors are written to a file, 
named using the ErrFile option in the Data control group.
This file is typically called ERRFILE.DAT. Set this option to No 
to prevent the system from generating an error message 
when it cannot find the DDT file. The default is Yes.
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RemoveImageMissingDD
T

A DDT file is normally required for any triggered image and 
not finding an image is a fatal error for a transaction. Setting 
this option to Yes tells the system that when it cannot find a 
DDT file for a triggered image, it should remove the image 
from the form set. 
This can result in the removal of the form as well if all images 
are removed. An empty form set can result if all of the forms 
are removed. If this results in an empty form set, the system 
generates an error message. The default is No.

StringentChecking Normally, if the system does not find an effective version of 
the file, it returns the oldest version/revision of the file. 
If, however, you set this option to Yes, only an effective 
version of the file will be returned. If no such file exists, 
nothing is returned. Stringent checking is only applicable 
when you use the system to control effective date eligibility 
of DDT files. The default is No.

WarnOnMissingFile Normally, the system generates an error if it cannot find a 
DDT file for a triggered image. You can, however, suppress 
this error by setting the ErrorOnMissingFile option to No. 
When you suppress this type of error, the system assumes 
you still want a warning message but by setting this option 
to No, even the warning message is suppressed. The default 
is Yes.

Option Description
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Understanding Run Dates

The idea behind effective date processing is that, within a library, there can be multiple 
versions of a resource, each with a different effective date. When the system creates a 
form set, it is built with the version (and revision) of the resources that were, or will be, 
effective on a given date. In Documaker RP, this date is called the run date. In 
Documaker Workstation it is called the create date.

When using Studio to manage your resources, you must use run dates for the system 
to construct, archive, and retrieve your form sets correctly. Be sure to:

• Define the RunDate field in your TRNDFDFL.DFD, RCBDFDFL.DFD, and APPIDX.DFD 
Data Format Definition (DFD) files.

• Create the extract file to include the run date for each transaction’s set of records.

• Use the TRN_FIELDS control group to indicate the location of the RunDate and 
other fields in the extract file. The GenTrn program uses this control group.

• Set the RunDate option in the Trigger2Archive control group as shown here to 
make the GenArc program populate the APPIDX file with the RunDate from the 
NEWTRN file:

< Trigger2Archive >

RunDate = RunDate

• Set the RunDate option in the AFEWIP2ArchiveRecord control group to make 
Documaker Workstation (PPS) populate the APPIDX file with the value of the 
creation date in the WIP index:

< AFEWIP2ArchiveRecord >

RunDate = CreateTime,X

If you follow the guidelines above, the system will behave as described here:

• When the GenTrn program runs, the value in the RunDate field for each transaction 
is read from the extract file and copied into the TRNFILE.

• When the GenData program runs, it uses the value in the RunDate field in the 
TRNFILE for each transaction and loads the appropriate resources from the library.

• When the GenPrint program runs, it uses the value in the RunDate field, if 
necessary, in the recipient batch files for each transaction.

• When the GenArc program runs, it copies the value in the RunDate field from the 
NEWTRN file into the APPIDX file, using the RunDate option in the Trigger2Archive 
control group.

• When you archive a form set in Documaker Workstation, the value in the 
CreateTime field is converted from hexadecimal format to D4 format (YYYYMMDD) 
and copied into the APPIDX file.

When you retrieve that form set, the value in the CreateTime field that was saved 
into the APPIDX file can be used to load objects, such as FAP files and logos, from 
the library as required to reconstruct the form set.

Keep in mind the run date should be in D4 format, which is YYYYMMDD. If your run date 
is not in D4 format, you can convert it using additional INI options.
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To make sure the value in the RunDate field is part of the TRNDFDFL.DFD, 
RCBDFDFL.DFD, and APPIDX.DFD files, make sure these DFD files contain entries for the 
RunDate field, as shown below. The DFD files shipped with your system contain similar 
entries. DFD files are generally stored in the \DEFLIB directory. In each of these DFD 
files, you should have an entry for the RunDate field and an entry that describes the 
attributes of the RunDate field. These entries will look similar to those shown here:

< Fields >

FieldName = RunDate

< FIELD:RunDate >

EXT_Type = CHAR_ARRAY

EXT_Length = 8

EXT_Precision = 0

INT_Type = CHAR_ARRAY

INT_Length = 8

INT_Precision = 0

Key = No

Required = Yes

If you did not place the RunDate field in the TRNDFDFL.DFD, RCBDFDFL.DFD, and 
APPIDX.DFD files, you can use the GetRunDate rule to get the current system date and 
use it as the RunDate for each transaction. Keep in mind that using the GetRunDate rule 
limits you to using the current date as the run date, which may not always be the date 
you want to use.
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HOW IT ALL WORKS

The following topics describe how Documaker software uses these concepts in 
everyday processing.

In Documaker Workstation

Entry When you use Documaker Workstation (or PPS) to create a new form set or transaction, 
the current system date is used to note when the form set was created. This value is 
stored in the CreateTime field, which is equivalent to the RunDate field in Documaker 
RP.

You can change this date by clicking on the Effective Date control and choosing a 
different date from the calendar. You can hide the Effective Date control using this 
option:

< Control >

ShowEffectiveDate  = No

The effective date specified — whether the current date or another date — is the date 
compared against the effective dates associated with the resources, such as FAP files 
and logos, pulled from the library.

Example 1 - Multiple
versions, different

effective dates

Say today’s date is 10/25/2007 and the form set you are creating requires a form called 
DEC PAGE. The DEC PAGE form is comprised of these FAP files:

• Q1SNAM

• Q1MDC1

• Q1MDC2

• Q1MDC3

Assume the following versions of the Q1SNAM FAP are in the library:

Since the run date is 20071025 (10/25/2007), Studio chooses version 00001, revision 
00002 (version 1.2) of Q1SNAM because it has an effective date (20070731) and that is 
the latest date that does not exceed the run date (20071025).

NOTE: This example shows two revisions, 1.1 and 1.2, of version 1 which contain 
different effective dates. Though Documaker 10.2 and higher enforce the rule 
that all revisions of a particular version of a resource must have the same 
effective date, if you have migrated a library from a prior version, your library 
may contain resources that do not adhere to this restriction. This situation will 
not cause errors.

Form set Version Revision Effective Date

Q1SNAM 00001 00001 20070131

Q1SNAM 00001 00002 20070731

Q1SNAM 00002 00001 20071231
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Example 2 - Multiple
versions, same effective

dates

Say today’s date is 10/25/2007 and the form set you are creating requires a form called 
DEC PAGE. The DEC PAGE form is comprised of these FAP files:

• Q1SNAM

• Q1MDC1

• Q1MDC2

• Q1MDC3

Assume the following versions of the Q1SNAM FAP are in the library:

The run date is 20071025 (10/25/2007), so the latest effective for Q1SNAM that does 
not exceed the run date is 20070731. There are three version/revisions of Q1SNAM that 
have the most correct effective date, versions 1.1, 1.2, and 1.3. Studio chooses version 
1.3 because it has the highest version/revision number.

Sometimes, you might create a form set and decide to base that new form set on an 
older one from archive. To do this, you first choose the New, Retrieve Data option to 
select the form set from archive. By default, the new form set would consist of the same 
version/revisions of the forms from the archived form set. 

If, instead, you want the new form set to be comprised of the same forms as the 
archived form set, but with newer versions/revisions of those forms — if they exist — 
you must use this INI option:

< FormSelection >

RetrieveVersionInfo = No

Form set Version Revision Effective Date

Q1SNAM 00001  00001 20070731

Q1SNAM 00001 00002 20070731

Q1SNAM 00001 00003 20070731

Q1SNAM 00002 00001 20071231
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WIP When you save a form set to WIP (by choosing File, Save or WIP, Save), the system 
writes a record to the WIP index table and two WIP data files are written to the \WIP 
directory. By default, the WIP index table is named WIP and is composed of these files:

• WIP.DBF

• WIP.MDX

The two WIP data files written to the \WIP directory are essentially an NAFILE and a 
POLFILE. These two files may be named something like:

D4234FF15243414FB1B504379EC76D0D.dat   (this is the NAFILE)

D4234FF15243414FB1B504379EC76D0D.pol   (this is the POLFILE)

Prior to version 10.2 of Documaker Workstation, the WIP data files had names such as:

00000001.dat    (this is the NAFILE)

00000001.pol    (this is the POLFILE)

If you migrated to version 10.2 of Documaker Workstation from a prior version and have 
a WIP index (WIP.DBF and WIP.MDX), your WIP data files have the shorter names. 
Depending on the configuration, the resources in the NAFILE.DAT file may have version, 
revision, and effective date information in the \NA=... record. Here is an example:

\NA=q1snam,LN=1,DUP=OFF,SIZE=C,TRAY=U,X=0,Y=0,PA=1,OPT=D\

\ENDIMAGE\

\NA=q1mdc1,LN=1,DUP=OFF,SIZE=C,TRAY=U,X=0,Y=3360,PA=1,OPT=DS,V=1,R=
1,D=20020911\

ENDIMAGE\

Notice the \NA=q1mdc1... record contains these options and values:

• V=1

• R=1

• D=20020911

These values represent the specific version, revision, and effective date of Q1MDC1, 
pulled from the library when this form set was created. Notice that the \NA=q1snam... 
record does not contain these values.

After saving this form set to WIP, you might later return to retrieve this form set. When 
reconstructing the form set, for those images listed in the NAFILE.DAT file that contain 
the V, R, and D options and values, the system retrieves the specific version and 
revision of the image listed.

For those images listed in the NAFILE.DAT file that do not contain the V, R, and D 
options, Documaker Workstation gets a run date and uses that date to retrieve the 
correct version/revision of the images. Documaker Workstation gets its run date by 
looking for a value in these locations:

• The RunDate field in the WIP index

• The CreateTime field in the WIP index

• The current system date

If the RunDate field does not exist or is empty, Documaker Workstation looks in the 
CreateTime field. If the CreateTime field does not exist or is empty, it uses the current 
system date.
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Archive and retrieval When a form set is archived, its NAFILE and POLFILE contents are stored in an archive 
file or table (called a CARFile — Compressed Archive File) and some (or all) of the 
information that was in the WIP index (if it was archived from WIP) or in the NEWTRN 
file (if it was archived using the GenArc program) is stored into the application index 
(APPIDX) table. One of the fields in the APPIDX table is called RunDate.

You can retrieve a form set from archive in Documaker Workstation by choosing the 
Retrieve, Formset option. When reconstructing the form set, for those images listed in 
the NAFILE file that contain the V, R, and D options and values, the system retrieves the 
specific version and revision of the image that is listed.

For those images listed in the NAFILE that do not contain the V, R, and D options, 
Documaker Workstation gets a run date and uses that date to retrieve the correct 
version/revision of the images. Documaker Workstation gets its run date by looking for 
a value in these locations:

• The RunDate field in the application index (APPIDX)

• The CreateTime field in the application index

• The current system date

If the RunDate field does not exist or is empty, Documaker Workstation looks in the 
CreateTime field. If the CreateTime field does not exist or is empty, it uses the current 
system date.

In Documaker Server

The GenData and GenPrint programs in Documaker Server will generally need to load 
resources (such as FAP files, LOG files, and DAL scripts). To retrieve the resource with 
the appropriate effective date, the system needs to know the run date for each form set 
to be generated.

The GenTrn program gets the run date from the extract file, for each transaction and 
writes the run date to the TRNFILE.

The GenData program gets the run date from a Global Variable Manager (GVM) variable 
named RunDate. The RunDate GVM is set by:

• a value in the TRNFILE file or 

• the GetRunDate rule, which copies the current system date into the RunDate GVM

As the GenData program processes transactions, the run date is written to the NEWTRN 
file and to the recipient batch files, provided the TRNDFDFL.DFD and RCBDFDFL.DFD 
files contain the RunDate field.

The GenPrint program reads the NAFILE, POLFILE, and recipient batch files. When it 
needs to load a resource referenced in the NAFILE, such as a FAP or logo file, it asks for 
the specific version and revision of the resource if those values are listed in the NAFILE. 
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For example, in this NAFILE excerpt:

\NA=q1snam,LN=1,DUP=OFF,SIZE=C,TRAY=U,X=0,Y=0,PA=1,OPT=D\

\ENDIMAGE\

\NA=q1mdc1,LN=1,DUP=OFF,SIZE=C,TRAY=U,X=0,Y=3360,PA=1,OPT=DS,V=1,R=
1,D=20070911\

\ENDIMAGE\

The Q1MDC1 FAP file contains these options:

• V=1

• R=1

• D=20070911

These options and values represent version 1, revision 1 (1.1) and an effective date of 
9/11/2007. If the GenPrint program needs to load Q1MDC1, it asks for version 1.1 of this 
file.

On the other hand, for Q1SNAM, the V, R, and D options and values do not exist in the 
NAFILE, so if the GenPrint program needs to load this file, the system uses the run date 
specified in the recipient batch file to determine the correct version and revision of the 
FAP file to retrieve.

In Docupresentment (IDS)

When you use the Documaker Bridge to retrieve archived form sets, you can also use 
library management to retrieve the correct version and revision of any objects, such as 
FAP and logo files, referenced in the form set.

To configure Docupresentment to use library management, follow these steps:

1 For each request type in the DOCSERV.INI file you want to use, specify the 
DPRInitLby rule in the rules list. Here is an example of how you can use the 
DPRInitLby rule and its location in the rule list for the PRT request type:

[ ReqType:PRT ]

function = atcw32->ATCLogTransaction

function = atcw32->ATCLoadAttachment

function = dprw32->DPRSetConfig

function = dprw32->DPRInitLby

function = atcw32->ATCUnloadAttachment

function = dprw32->DPRRetrieveFormset

function = dprw32->DPRPrint

function = dprw32->DPRProcessTemplates

2 For each configuration you want to use, specify the library name in that 
configuration’s INI file. For example, if you are using the RPEX1 configuration, you 
would specify options similar to these in the RPEX1.INI file:

< MasterResource >

FormFile = master.lby

LogoFile = master.lby

DALFile  = master.lby

LbyLib   = e:\fap\mstrres\rpex1\deflib\

The FormFile, LogoFile, and DALFile options name the library and the LbyLib option 
names the location of the library.
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3 Set the ARCEFFECTIVEDATE attachment variable before calling any rules that use 
the library, such as DPRRetrieveFormset. Refer to the SDK Reference to determine 
which rules use the ARCEFFECTIVEDATE attachment variable.

The ARCEFFECTIVEDATE attachment variable is used by the Documaker Bridge to 
locate the appropriate version/revision of a resource if a specific version/revision 
is not indicated in the retrieved NAFILE. If you are using the Docupresentment CGI 
client, you can set the ARCEFFECTIVEDATE by specifying the following in the 
appropriate HTML templates:

<FORM METHOD="POST" ACTION="#EXENAME,#">

<INPUT NAME="USERID" VALUE="#USERID,%s#" TYPE="HIDDEN">

<INPUT NAME="DOCTYPE" VALUE="#DOCTYPE,%s#" TYPE="HIDDEN">

<INPUT NAME="REQTYPE" VALUE="PRT" TYPE="HIDDEN">

<INPUT NAME="CONFIG" VALUE="#CONFIG,%s#" TYPE="HIDDEN">

<INPUT NAME="ARCEFFECTIVEDATE" VALUE="#RUNDATE,%s#" TYPE="HIDDEN">     
<-- sets the ARCEFFECTIVEDATE attachment variable

This copies the value of the RunDate attachment variable into the 
ARCEFFECTIVEDATE attachment variable. The RunDate attachment variable comes 
from the RunDate field of the archive application index (APPIDX) file. See 
Understanding Run Dates on page 181 to see how to make sure the APPIDX 
RunDate field is populated correctly.

MANAGING WORKFLOW

You can also manage the development, testing, and promotion of resources. Using one 
or more libraries, you can coordinate the creation and modification of image (FAP), logo 
(LOG), and DAL script files. Locking of resources as they are checked out, prevents 
multiple users from trying to change a particular resource at the same time. Prior 
versions of a resource are kept safe and can be restored if necessary.

As you test resources checked into a library, you can mark the resources as having 
passed or failed using the Status field on the File Information window. You can also 
promote them to another library for additional testing or for production use.
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CREATING
LIBRARIES

The way you create a resource library differs depending on how the library is stored. 
You have these choices:

• Using xBase and CARFiles on page 189

• Using the DB2 Native Driver on page 191

• Using the DB2 ODBC Driver on page 196

• Using the SQL Server ODBC Driver on page 202

• Using the Oracle ODBC Driver on page 206

• Using Documanage on page 211

USING XBASE AND CARFILES

You can use the xBase or CARFile format for the library on Windows, AIX, Solaris, and 
Linux operating systems. By default, a Documaker library is stored in this file format:

• The index portion is stored as a xBase file (actually two files)

• The data portion is stored in a compressed file format referred to as a CARFile

The default library name is MASTER.LBY. Using this name, the system creates these 
files:

File Description

MASTER.DBF The DBF and MDX files make up the index portion of the library. The DBF 
component contains the index data and the MDX component contains 
tag information.

MASTER.MDX The DBF and MDX files make up the index portion of the library. The DBF 
component of the index contains the index data and the MDX 
component contains tag information. 

MASTER.LBY The LBY file makes up the data portion of the library. This file contains 
the actual resources the index refers to. This file is in a compressed 
archive file (CARFile) format.
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Creating the CARFile and Index Files

On Windows, AIX, Solaris,
and Linux

If you are using the xBase/CARFile format for the library index and data, Studio can 
create the library index and data files.

Sample INI options Use INI options like the following to create a library in a CARFile format (index in xBase 
format) and to load resources from that library:

< MasterResource >

BDFFile = master.lby

DALFile = master.lby

DDTFile = master.lby

FORFile = master.lby

FormFile = master.lby

GRPFile = master.lby

LbyLib = ..\mstrres\deflib\

LogoFile = master.lby

< LibraryManager >

LbyLogFile = lbylog

Option Description

MasterResource control group

BDFFile This option tells the system you want to retrieve business definition (BDF) 
resources from a library named MASTER.LBY.

DALFile This option tells the system you want to retrieve DAL scripts and DAL 
script libraries from a library named MASTER.LBY.

DDTFile This option tells the system you want to retrieve DDT files from a library 
named MASTER.LBY.

FORFile This option tells the system you want to retrieve form (FOR) resources 
from a library named MASTER.LBY.

FormFile This option tells the system you want to retrieve FAP files from a library 
named MASTER.LBY.

GRPFile This option tells the system you want to retrieve group form (GRP) 
resources from a library named MASTER.LBY.

LbyLib This option tells the system that the MASTER.LBY file and the two files 
that make up its index (MASTER.DBF and MASTER.MDX), reside in the 
location specified by the relative path ..\mstrres\deflib\.

LogoFile This option tells the system you want to retrieve LOG (logo) files from a 
library named MASTER.LBY.

LibraryManager control group

LbyLogFile This option tells the system the name of the library log file is LBYLOG. The 
library log contains information about resources added to, deleted from, 
or updated in the library. The library log file does not have to use the 
same type of database handler as the library index and data portions.
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USING THE DB2 NATIVE DRIVER

You can use the DB2 native driver — using DB2 but not going through ODBC — with the 
Windows, AIX, Solaris, Linux, and OS390 operating systems.

Creating the Database and Tables

On Windows, AIX, Solaris,
and Linux

On Windows, AIX, Solaris, and Linux you can have the LBRYMGR utility create the 
library index, data and catalog tables or you can create them beforehand. To tell the 
LBRYMGR utility to create the library and catalog tables, specify this INI option:

< DBHandler:DB2 >

CreateTable = Yes

NOTE: For more information about the LBRYMGR utility, see the Docutoolbox 
Reference.

To create the DB2 library and catalog tables manually, execute an SQL script like the 
one provided with the RPEX1 sample resources in this directory:

..rpex1\deflib\db2\lbysqlr.cmd

This file is also listed below:

CONNECT TO LBYLIB;

         ------------------------------------------------

         -- DDL Statements for table "DAP110_CAT_R1"

         ------------------------------------------------

          CREATE TABLE "DAP110_CAT_R1"  (

                           "CATALOGID" CHAR(10) ,

                           "CARFILE" CHAR(8) ,

                           "MEDIAID" CHAR(11) ,

                           "STATUS" CHAR(1) )

                          IN "USERSPACE1" ;

         ------------------------------------------------

         -- DDL Statements for table "DAP110_LBYI_R1"

         ------------------------------------------------

          CREATE TABLE "DAP110_LBYI_R1"  (

                           "FILETYPE" CHAR(3) ,

                           "FILESTYP" CHAR(3) ,

                           "FILENAME" CHAR(100) ,

                           "RESOURCE" CHAR(25) ,

                           "DESCRIPT" CHAR(100) ,

                           "EFFECTIV" CHAR(10) ,

                           "MODIFYTM" CHAR(10) ,

                           "FILEINDX" CHAR(8) ,

                           "RECSTAT" CHAR(3) ,

                           "VERSION" CHAR(5) ,

                           "REVISION" CHAR(5) ,

                           "USERID" CHAR(64) ,

                           "USRLEVL" CHAR(2) ,
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                           "PASSWD" CHAR(64) ,

                           "UNIQUE_ID" CHAR(26) ,

                           "ARCKEY" CHAR(18) ,

                           "MODE" CHAR(25) ,

                           "STATUS" CHAR(25) ,

                           "CLASS" CHAR(25) ,

                           "PROJECT" CHAR(25) )

                          IN "USERSPACE1" ;

         ------------------------------------------------

         -- DDL Statements for table "DAP110_LBYD_R1"

         ------------------------------------------------

          CREATE TABLE "DAP110_LBYD_R1"  (

                           "ARCKEY" CHAR(18) ,

                           "SEQ_NUM" CHAR(5) ,

                           "CONT_FLAG" CHAR(1) ,

                           "TOTAL_SIZE" INTEGER ,

                           "CARDATA" LONG VARCHAR FOR BIT DATA )

                          IN "USERSPACE1" ;

         COMMIT WORK;

         CONNECT RESET;

         TERMINATE;

If you manually create the DB2 tables by running using this script, set the CreateTable 
option to No when you later run Documaker RP. Here is an example:

< DBHandler:DB2 >

CreateTable = No

On OS390 On OS390, run the job located in FSI.V110.JCLLIB(LBYSQLR) to create the library index, 
data, and catalog tables. This job also creates the library log (LBYLOG) table, which 
contains entries of items that are added to, deleted from, or updated in the library.
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Sample INI Options

Here is an example of how you can set up your INI options to use the DB2 native driver 
to load resources from a library defined in DB2:

< MasterResource >

BDFFile = LBYI

DALFile = LBYI

DDTFile = LBYI

FORFile = LBYI

FormFile = LBYI

GRPFile = LBYI

LogoFile = LBYI

< LibraryManager >

LBYLogFile = LBYLOG

< Library:LBYI >

DBTable = LBYD

< DBTable:LBYI >

DBHandler = DB2

< DBTable:LBYD >

DBHandler = DB2

UniqueTag = ARCKEY+SEQ_NUM

< DBTable:LBYLOG >

DBHandler = DB2

< DBTable:CATALOG >

DBHandler = DB2

UniqueTag = CATALOGID

< DBHandler:DB2 >

Class = DB2

CreateIndex= No

CreateTable= Yes

Database = LBYDBASE

Debug = No

Passwd = password

UserID = userID

< DB2_FileConvert >

LBYI = DAP110_LBYI_R1

LBYD = DAP110_LBYD_R1

LBYLog = DAP110_LBYLOG_R1

Option Description

MasterResource control group

BDFFile This option tells the system you want to retrieve business definition (BDF) 
resources from a library named LBYI.

DALFile This option tells the system you want to retrieve DAL scripts and DAL 
script libraries from a library named LBYI.

DDTFile This option tells the system you want to retrieve DDT files from a library 
named LBYI.

FORFile This option tells the system you want to retrieve form (FOR) resources 
from a library named LBYI.



Chapter 9
Managing Resources

194

FormFile This option tells the system you want to retrieve FAP files from a library 
named LBYI.

GRPFile This option tells the system you want to retrieve group form (GRP) 
resources from a library named LBYI.

LogoFile This option tells the system you want to retrieve LOG (logo) files from a 
library named LBYI.

LibraryManager control group

LbyLogFile This option tells the system the name of the library log file is LBYLOG. The 
library log contains information about resources added to, deleted from, 
or updated in the library. The LbyLogFile does not have to use the same 
type of database handler as the library index and data portions.

Library:LBYI control group

DBTable This option tells the system the data component of the library named LBYI 
is called LBYD. In this example, the names LBYI and LBYD have been 
chosen to emphasize that one table, LBYI, represents the library index 
and one table, LBYD represents the library data.
You can call these tables any name you like but the name cannot exceed 
eight characters. See the DB2_FileConvert control group if you need to 
map these eight-character names to longer table names.

DBTable:LBYI control group

DBHandler This option tells the system to access the table known as LBYI using the 
database handler named DB2. Based on this option, the system expects 
to find a control group named DBHandler:DB2.

DBTable:LBYD control group

DBHandler This option tells the system to access the table known as LBYD using the 
database handler named DB2. Based on this option, the system expects 
to find a control group named DBHandler:DB2.

UniqueTag This option tells the system the columns ARCKEY and SEQ_NUM can be 
combined to represent a unique tag for the table. This unique tag is only 
used for internal purposes.
If you do not specify a unique tag for this table, and a column with the 
name UNIQUE_ID does not exist within the table, you receive warning 
messages indicating no unique tag is defined. Include this value to avoid 
those warning messages.

DBTable:LBYLOG control group

DBHandler This option tells the system to access the table known as LBYLOG using 
the database handler named DB2. Based on this option, the system 
expects to find a control group named DBHandler:DB2.

DBTable:CATALOG control group

Option Description
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DBHandler This option tells the system to access the table known as CATALOG using 
the database handler named DB2. The CATALOG table temporarily stores 
the CATALOGID values used to construct an ARCKEY.

UniqueTag This option tells the system the column CATALOGID represents a unique 
tag for this table. This unique tag is only used for internal purposes.
If you do not specify a unique tag for this table, and a column with the 
name UNIQUE_ID does not exist within the table, you receive warning 
messages indicating there is no unique tag defined. Include this value to 
avoid those warning messages.

DBHandler:DB2 control group

Class This option tells the system this database handler represents a handler 
for IBM’s DB2 database management system. The Class option is 
unnecessary if the name of the handler (DB2 in this case) matches one of 
the Documaker pre-defined values, such as DB2, ODBC, ORA, or DMS.

CreateIndex This option tells the system not to create database indexes. This option 
should always be set to No.

CreateTable This option tells the system to create any missing required tables at run 
time.

Database This option tells the system the name of the database for this database 
handler is LBYDBASE.

Debug This turns off tracing for the Documaker DB2 database handler. Normally 
you would omit the Debug option or set it to No. In troubleshooting 
situations, set this option to Yes and examine the trace messages written 
to the trace file.

Passwd This option tells the system the password to use when connecting to the 
database management system.

UserID This option tells the system the user ID to use when connecting to the 
database management system.

DB2_FileConvert control group

LBYI This option tells the system the table referenced in INI options as LBYI is 
really named DAP110_LBYI on the database management system.
This control group lets you map table names of eight characters or less to 
table names longer than eight characters.
The table name you specify must adhere to the table naming conventions 
for the database management system.

LBYD This option tells the system the table referenced in INI options as LBYD is 
really named DAP110_LBYI on the database management system.

LBYLog This option tells the system the table referenced in INI options as LBYI is 
really named DAP110_LBYI on the database management system.

Option Description
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USING THE DB2 ODBC DRIVER

You can use the DB2 ODBC driver on the Windows operating system.

Creating the Database and Tables

You can let the LBRYMGR utility create the library index, data, and catalog tables or you 
can create them beforehand. To have the LBRYMGR utility create the library and 
catalog tables, specify this INI option:

< DBHandler:DB2 >

CreateTable = Yes

NOTE: For more information about the LBRYMGR utility, see the Docutoolbox 
Reference.

To create the DB2 library and catalog tables manually, execute an SQL script like the 
one provided with the RPEX1 sample resources in this directory:

..rpex1\deflib\db2\lbysqlr.cmd

This file is also listed below:

CONNECT TO LBYLIB;

         ------------------------------------------------

         -- DDL Statements for table "DAP110_CAT_R1"

         ------------------------------------------------

          CREATE TABLE "DAP110_CAT_R1"  (

                           "CATALOGID" CHAR(10) ,

                           "CARFILE" CHAR(8) ,

                           "MEDIAID" CHAR(11) ,

                           "STATUS" CHAR(1) )

                          IN "USERSPACE1" ;

         ------------------------------------------------

         -- DDL Statements for table "DAP110_LBYI_R1"

         ------------------------------------------------

          CREATE TABLE "DAP110_LBYI_R1"  (

                           "FILETYPE" CHAR(3) ,

                           "FILESTYP" CHAR(3) ,

                           "FILENAME" CHAR(100) ,

                           "RESOURCE" CHAR(25) ,

                           "DESCRIPT" CHAR(100) ,

                           "EFFECTIV" CHAR(10) ,

                           "MODIFYTM" CHAR(10) ,

                           "FILEINDX" CHAR(8) ,

                           "RECSTAT" CHAR(3) ,

                           "VERSION" CHAR(5) ,

                           "REVISION" CHAR(5) ,

                           "USERID" CHAR(64) ,

                           "USRLEVL" CHAR(2) ,

                           "PASSWD" CHAR(64) ,
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                           "UNIQUE_ID" CHAR(26) ,

                           "ARCKEY" CHAR(18) ,

                           "MODE" CHAR(25) ,

                           "STATUS" CHAR(25) ,

                           "CLASS" CHAR(25) ,

                           "PROJECT" CHAR(25) )

                          IN "USERSPACE1" ;

         ------------------------------------------------

         -- DDL Statements for table "DAP110_LBYD_R1"

         ------------------------------------------------

          CREATE TABLE "DAP110_LBYD_R1"  (

                           "ARCKEY" CHAR(18) ,

                           "SEQ_NUM" CHAR(5) ,

                           "CONT_FLAG" CHAR(1) ,

                           "TOTAL_SIZE" INTEGER ,

                           "CARDATA" LONG VARCHAR FOR BIT DATA )

                          IN "USERSPACE1" ;

         COMMIT WORK;

         CONNECT RESET;

         TERMINATE;

If you manually create the DB2 tables by running using this script, set the CreateTable 
option to No when you later run Documaker RP. Here is an example:

< DBHandler:ODBC >

CreateTable = No
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Sample INI Options

Use INI options like the following to create a library in DB2, using the DB2 ODBC driver, 
and to load resources from that library:

< MasterResource >

BDFFile = LBYI

DALFile = LBYI

DDTFile = LBYI

GRPFile = LBYI

FORFile = LBYI

FormFile = LBYI

LogoFile = LBYI

<LibraryManager>

LBYLogFile = LBYLOG

< Library:LBYI >

DBTable = LBYD

< DBTable:LBYI >

DBHandler = ODBC

< DBTable:LBYD >

DBHandler = ODBC

UniqueTag = ARCKEY+SEQ_NUM

< DBTable:LBYLOG >

DBHandler = ODBC

< DBTable:CATALOG >

DBHandler = ODBC

UniqueTag = CATALOGID

< DBHandler:ODBC >

Class = ODBC

CreateIndex= No

CreateTable= Yes

Debug = No

Passwd = password

Qualifier = LBYDBASE

Server = LBYDB2

UserID = userID

< ODBC_FileConvert >

LBYI = DAP110_LBYI_R1

LBYD = DAP110_LBYD_R1

LBYLog = DAP110_LBYLOG_R1

Option Description

MasterResource control group

BDFFile This option tells the system you want to retrieve business definition (BDF) 
resources from a library named LBYI.

DALFile This option tells the system you want to retrieve DAL scripts and DAL 
script libraries from a library named LBYI.

DDTFile This option tells the system you want to retrieve DDT files from a library 
named LBYI.

FORFile This option tells the system you want to retrieve form (FOR) resources 
from a library named LBYI.
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FormFile This option tells the system you want to retrieve FAP files from a library 
named LBYI.

GRPFile This option tells the system you want to retrieve group form (GRP) 
resources from a library named LBYI.

LogoFile This option tells the system you want to retrieve LOG (logo) files from a 
library named LBYI.

LibraryManager control group

LbyLogFile This option tells the system the name of the library log file is LBYLOG. The 
library log contains information about resources added to, deleted from, 
or updated in the library. The LbyLogFile does not have to use the same 
type of database handler as the library index and data portions.

Library:LBYI control group

DBTable This option tells the system the data component of the library named LBYI 
is called LBYD. In this example, the names LBYI and LBYD have been 
chosen to emphasize that one table, LBYI, represents the library index 
and one table, LBYD represents the library data.
You can call these tables any name you like but the name must be eight 
characters or less. See the ODBC_FileConvert control group to map these 
eight-character names to longer table names.

DBTable:LBYI control group

DBHandler This option tells the system to access the table known as LBYI using the 
database handler named ODBC. Based on this option, the system expects 
to find a control group named DBHandler:ODBC.
Microsoft’s SQL Server is an ODBC-compliant database. 

DBTable:LBYD control group

DBHandler This option tells the system to access the table known as LBYD using the 
database handler named ODBC. Based on this option, the system expects 
to find a control group named DBHandler:ODBC.

UniqueTag This option tells the system the columns ARCKEY and SEQ_NUM can be 
combined to represent a unique tag for the table. This unique tag is only 
used for internal purposes.
If you do not specify a unique tag for this table, and a column with the 
name UNIQUE_ID does not exist, you receive warning messages 
indicating no unique tag is defined. Include this option to avoid those 
warning messages.

DBTable:LBYLOG control group

DBHandler This option tells the system to access the table known as LBYLOG using 
the database handler named ODBC. Based on this option, the system 
expects to find a control group named DBHandler:ODBC

DBTable:CATALOG control group

Option Description
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DBHandler This option tells the system to access the table known as CATALOG using 
the database handler named ODBC. The CATALOG table temporarily 
stores the CATALOGID values used to construct an ARCKEY.

UniqueTag This option tells the system the column CATALOGID represents a unique 
tag for this table. This unique tag is only used for internal purposes.
If you do not specify a unique tag for this table, and a column with the 
name UNIQUE_ID does not exist within the table, you receive warning 
messages indicating no unique tag is defined. Include this option to avoid 
those warning messages.

DBHandler:ODBC control group

Class This option tells the system this database handler represents a handler 
for Microsoft’s Open Data Base Connectivity (ODBC) standard. The 
Class parameter is unnecessary if the name of the handler, ODBC in 
this case, matches one of the Documaker pre-defined values, such as 
DB2, ODBC, ORA, or DMS.

CreateIndex This option tells the system not to create database indexes. This option 
should always be set to No.

CreateTable This option tells the system that if a table needed by the system does not 
exist, to create it.

Debug This option turns off tracing for the Documaker ODBC database handler. 
Normally you should omit the Debug option or set it to No. In 
troubleshooting situations, set this option to Yes and examine the trace 
messages that are written to the trace file.

Passwd This option tells the system the password to use when connecting to the 
database management system.

Qualifier This option tells the system that the name of the database for this 
database handler is LBYDBASE. If you omit this option, the system uses 
the database set up as the default database for the LBYDB2 ODBC data 
source.

Server This option tells the system the name of the ODBC data source for this 
database handler is LBYDB2. You will need to have defined an ODBC 
data source by this name.

UserID This option tells the system the user ID to use when connecting to the 
database management system.

ODBC_FileConvert

LBYI This option tells the system the table referenced in INI options as LBYI is 
really named DAP110_LBYI on the database management system.
This control group lets you map table names of eight characters or less to 
table names longer than eight characters. 
The table name you specify must adhere to the table naming conventions 
for the database management system.

Option Description
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LBYD This option tells the system the table referenced in INI options as LBYD is 
really named DAP110_LBYI on the database management system.

LBYLog This option tells the system the table referenced in INI options as LBYI is 
really named DAP110_LBYI on the database management system.

Option Description
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USING THE SQL SERVER ODBC DRIVER

You can use the SQL Server ODBC driver on Windows.

Creating the Database and Tables

On Windows, you can use Studio to create the library index and data files. You can also 
use the LBRYMGR utility do it.

NOTE: For more information about the LBRYMGR utility, see the Docutoolbox 
Reference.

Sample INI Options

Use INI options like the following to create a library in SQL Server, using the SQL Server 
ODBC driver, and to load resources from that library:

< MasterResource >

BDFFile = LBYI

DALFile = LBYI

DDTFile = LBYI

FORFile = LBYI

FormFile = LBYI

GRPFile = LBYI

LogoFile = LBYI

< LibraryManager >

LBYLogFile = LBYLOG

< Library:LBYI >

DBTable = LBYD

< DBTable:LBYI >

DBHandler = ODBC

< DBTable:LBYD >

DBHandler = ODBC

UniqueTag = ARCKEY+SEQ_NUM

< DBTable:LBYLOG >

DBHandler = ODBC

< DBTable:CATALOG >

DBHandler = ODBC

UniqueTag = CATALOGID

< DBHandler:ODBC >

CreateIndex = No

CreateTable= Yes

Debug = No

Passwd = password

Qualifier = LBYDBASE

Server = LBYSQL

UserID = userID

< ODBC_FileConvert >

LBYI = DAP110_LBYI

LBYD = DAP110_LBYD

LBYLog = DAP110_LBYLOG
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Option Description

MasterResource control group

BDFFile This option tells the system you want to retrieve Business Definition 
(BDF) resources from a library named LBYI.

DALFile This option tells the system you want to retrieve DAL scripts and DAL 
script libraries from a library named LBYI.

DDTFile This option tells the system you want to retrieve DDT files from a library 
named LBYI.

FORFile This option tells the system you want to retrieve form (FOR) resources 
from a library named LBYI.

FormFile This option tells the system you want to retrieve FAP files from a library 
named LBYI.

GRPFile This option tells the system you want to retrieve group form (GRP) 
resources from a library named LBYI.

LogoFile This option tells the system you want to retrieve LOG (logo) files from a 
library named LBYI.

LibraryManager control group

LbyLogFile This option tells the system the name of the library log file is LBYLOG. 
The library log contains information about resources that are added to, 
deleted from, or updated in the library.
The LbyLogFile does not have to use the same type of database handler 
as the library index and data portions.

Library:LBYI control group

DBTable This option tells the system the data component of the library named 
LBYI is called LBYD. In this example, the names LBYI and LBYD 
emphasize that one table, LBYI, represents the library index and one 
table, LBYD, represents the library data.
You can call these tables any name you like but the name must be eight 
characters or less. See the ODBC_FileConvert control group to map these 
eight-character names to longer table names.

DBTable:LBYI control group

DBHandler This option tells the system to access the table known as LBYI using the 
database handler named ODBC. Because of this INI value, the system 
later expects to find a control group named DBHandler:ODBC. 
Microsoft’s SQL Server is an ODBC-compliant database.

DBTable:LBYD control group

DBHandler This option tells the system to access the table known as LBYD using the 
database handler named ODBC. Because of this INI value, the system 
later expects to find a control group named DBHandler:ODBC.
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UniqueTag This option tells the system the columns ARCKEY and SEQ_NUM can be 
combined to represent a unique tag for the table. This unique tag is only 
used for internal purposes. 
If you do not specify a unique tag for this table, and a column with the 
name UNIQUE_ID does not exist within the table, you receive warning 
messages indicating no unique tag is defined. Include this option to 
avoid those warning messages.

DBTable:LBYLOG control group

DBHandler This option tells the system to access the table known as LBYLOG using 
the database handler named ODBC. Because of this INI value, the system 
later expects to find an INI control group named DBHandler:ODBC.

DBTable:CATALOG control group

DBHandler This option tells the system to access the table known as CATALOG using 
the database handler named ODBC. The CATALOG table is used to 
temporarily store CATALOGID values which are used to construct an 
ARCKEY.

UniqueTag This option tells the system the column CATALOGID represents a unique 
tag for this table. This unique tag is only used for internal purposes. 
If you do not specify a unique tag for this table, and a column with the 
name UNIQUE_ID does not exist within the table, you receive warning 
messages indicating no unique tag is defined. Include this option to 
avoid those warning messages. 

DBHandler:ODBC control group

Class This option tells the system this database handler represents a handler 
for Microsoft’s Open Data Base Connectivity (ODBC) standard. 

This option is unnecessary if the name of the handler (ODBC in this case) 
matches one of the Documaker pre-defined values such as, DB2, ODBC, 
ORA, or DMS.

Debug This option turns off tracing for the Documaker ODBC database handler, 
which is the default. Normally you should omit the Debug option or set 
it to No.
In troubleshooting situations, set this option to Yes and examine the 
messages written to the trace file.

CreateIndex This option tells the system not to attempt to create database indexes 
(always set to No).

CreateTable This option tells the system that if a table needed does not exist at run 
time, it should create it.

Passwd This option tells the system the password to use when connecting to the 
database management system.

Qualifier This option tells the system the name of the database for this database 
handler is LBYDBASE. If you omit this option, the database set up as the 
default database for the LBYSQL ODBC data source is used.

Option Description
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Server This option tells the system the name of the ODBC data source for this 
database handler is LBYSQL. You must define an ODBC data source by 
this name.

UserID This option tells the system the user ID to use when connecting to the 
database management system.

ODBC_FileConvert control group

LBYI This option tells the system the table referenced in INI options as LBYI is 
really named DAP110_LBYI on the database management system.
This control group lets you map table names of eight characters or less 
to table names longer than eight characters.
The table name you specify must adhere to the table naming 
conventions for the database management system.

LBYD This option tells the system the table referenced in INI options as LBYD 
is really named DAP110_LBYI on the database management system.

LBYLog This option tells the system the table referenced in INI options as LBYI is 
really named DAP110_LBYI on the database management system. 

Option Description
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USING THE ORACLE ODBC DRIVER

You can use the Oracle ODBC driver on Windows.

NOTE: You can have up to 32 SQL static variables.

Data Format Definition (DFD) Requirements

Sample CARFILE.DFD file To use a library using the Oracle ODBC driver, you must use a Docucorp-supplied 
CARFILE.DFD file that differs from the standard (internal) DFD definition. The supplied 
CARFILE.DFD file is included in the sample RPEX1 resources in the directory:

..\DEFLIB\ODBC_ORA\CARFILE.DFD 

The contents of the CARFILE.DFD file are listed below:

; CARFILE.DFD - use this DFD when referencing a library or archive 
with the Oracle ODBC driver.

;

< Fields >

FieldName = ARCKEY

FieldName = SEQ_NUM

FieldName = CONT_FLAG

FieldName = TOTAL_SIZE

FieldName = CARDATA

< Field:ARCKEY >

INT_Type = CHAR_ARRAY

INT_Length = 18

EXT_Type = CHAR_ARRAY

EXT_Length = 18

Key = N

Required = N

< Field:SEQ_NUM >

INT_TYPE = CHAR_ARRAY

INT_LENGTH = 5

EXT_TYPE = CHAR_ARRAY

EXT_LENGTH = 5

KEY = N

REQUIRED = N

< Field:CONT_FLAG >

INT_TYPE = CHAR_ARRAY

INT_LENGTH = 1

EXT_TYPE = CHAR_ARRAY

EXT_LENGTH = 1

KEY = N

REQUIRED = N

< Field:TOTAL_SIZE >

INT_TYPE = LONG

INT_LENGTH = 4

EXT_TYPE = DOUBLE

EXT_LENGTH = 4

KEY = N

REQUIRED = N

< Field:CARDATA >
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INT_TYPE = BLOB

INT_LENGTH = 252

EXT_TYPE = BLOB

EXT_LENGTH = 252

KEY = N

REQUIRED = N

< Keys >

KEYNAME = ARCKEY

KEYNAME = SEQ_NUM

KEYNAME = CAR_KEY

< Key:ARCKEY >

EXPRESSION = ARCKEY+SEQ_NUM

FIELDLIST = ARCKEY,SEQ_NUM

< Key:SEQ_NUM >

EXPRESSION = SEQ_NUM

FIELDLIST = SEQ_NUM

< Key:CAR_KEY >

EXPRESSION = ARCKEY

FIELDLIST = ARCKEY

To use the supplied CARFILE.DFD file, follow these steps:

1 Copy the CARFILE.DFD file into the directory where you store other DFD files 
(generally the \DEFLIB directory).

2 Tell the system to use the CARFILE.DFD file by adding this option to the INI file:

< ArcRet >

CARFileDFD = ..\DEFLIB\CARFILE.DFD

Creating the Database and Tables

On Windows, you can use Studio to create the library index and data files. You can also 
use the LBRYMGR utility do it.

NOTE: For more information about the LBRYMGR utility, see the Docutoolbox 
Reference.

Sample INI Options

Use INI options like the following to create a library using the Oracle ODBC driver and 
to load resources from that library:

< MasterResource >

BDFFile = LBYI

DALFile = LBYI

DDTFile = LBYI

FORFile = LBYI

FormFile = LBYI

GRPFile = LBYI

LogoFile = LBYI

< LibraryManager >

LBYLogFile = LBYLOG

< Library:LBYI >
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DBTable = LBYD

< DBTable:LBYI >

DBHandler = ODBC

< DBTable:LBYD >

DBHandler = ODBC

UniqueTag = ARCKEY+SEQ_NUM

< DBTable:LBYLOG >

DBHandler = ODBC

< DBTable:CATALOG >

DBHandler = ODBC

UniqueTag = CATALOGID

< DBHandler:ODBC >

CreateIndex = No

CreateTable = Yes

Debug       = No

Passwd      = password

Qualifier   = LBYDBASE

Server      = LBYORA

UserID      = userID

< ODBC_FileConvert >

LBYI        = DAP110_LBYI

LBYD        = DAP110_LBYD

LBYLog      = DAP110_LBYLOG

Option Description

MasterResource control group

BDFFile This option tells the system you want to retrieve business definition (BDF) 
resources from a library named LBYI.

DALFile This option tells the system you want to retrieve DAL scripts and DAL 
script libraries from a library named LBYI.

DDTFile This option tells the system you want to retrieve DDT files from a library 
named LBYI.

FORFile This option tells the system you want to retrieve form (FOR) resources 
from a library named LBYI.

FormFile This option tells the system you want to retrieve FAP files from a library 
named LBYI.

GRPFile This option tells the system you want to retrieve group form (GRP) 
resources from a library named LBYI.

LogoFile This option tells the system you want to retrieve LOG (logo) files from a 
library named LBYI.

LibraryManager control group

LbyLogFile This option tells the system the name of the library log file is LBYLOG. The 
library log contains information about resources added to, deleted from, 
or updated in the library.
The LbyLogFile does not have to use the same type of database handler as 
the library index and data portions.
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Library:LBYI control group

DBTable This option tells the system the data component of the library named LBYI 
is called LBYD. In this example, the names LBYI and LBYD emphasize that 
one table, LBYI, represents the library index and one table, LBYD 
represents the library data.
You can call these tables anything you like but the name must be eight 
characters or less. Use the ODBC_FileConvert control group if you need to 
map these eight character names to longer table names.

DBTable:LBYI control group

DBHandler This option tells the system to access the table known as LBYI using the 
database handler named ODBC. Because of this INI option, the system 
later expects to find a control group named DBHandler:ODBC.
Microsoft’s SQL Server is an ODBC-compliant database. 

DBTable:LBYD control group

DBHandler This option tells the system to access the table known as LBYD using the 
database handler named ODBC. Because of this INI option, the system 
later expects to find a control group named DBHandler:ODBC.

UniqueTag This option tells the system the columns ARCKEY and SEQ_NUM can be 
combined to represent a unique tag for the table. This unique tag is only 
used for internal purposes.
If you do not specify a unique tag for this table, and a column with the 
name UNIQUE_ID does not exist, you receive warning messages 
indicating no unique tag id defined. Include this option to avoid those 
warning messages.

DBTable:LBYLOG control group

DBHandler This option tells the system to access the table known as LBYLOG using 
the database handler named ODBC. Based on this INI option, the system 
expects to find a control group named DBHandler:ODBC.

DBTable:CATALOG control group

DBHandler This option tells the system to access the table known as CATALOG using 
the database handler named ODBC. The CATALOG table temporarily 
stores the CATALOGID values used to construct an ARCKEY.

UniqueTag This option tells the system the column CATALOGID represents a unique 
tag for this table. This unique tag is only used for internal purposes. 
If you do not specify a unique tag for this table, and a column with the 
name UNIQUE_ID does not exist, you receive warning messages 
indicating no unique tag is defined. Include this option to avoid those 
warning messages.

DBHandler:ODBC control group

Option Description
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Class This option tells the system this database handler represents a handler 
for Microsoft’s Open Data Base Connectivity (ODBC) standard. This option 
is unnecessary if the name of the handler (ODBC in this case) matches one 
of the Documaker pre-defined values, such as DB2, ODBC, ORA, or DMS.

CreateIndex This option tells the system not to attempt to create database indexes 
(always set to No).

CreateTable This option tells the system that, if a table needed does not exist at run 
time, it should create it.

Debug This option turns off tracing for the Documaker ODBC database handler, 
which is the default. Normally you should omit the Debug option or set it 
to No.
In troubleshooting situations, set this option to Yes and examine the trace 
messages written to the trace file.

Passwd This option tells the system the password to use when connecting to the 
database management system.

Qualifier This option tells the system the name of the database for this database 
handler is LBYDBASE. If you omit this option, the system uses the 
database set up as the default database for the LBYORA ODBC data 
source.

Server This option tells the system the name of the ODBC data source for this 
database handler is LBYORA. You must define an ODBC data source by 
this name.

UserID This option tells the system the user ID to use when connecting to the 
database management system.

ODBC_FileConvert control group

LBYI This option tells the system the table referenced in INI options as LBYI is 
really named DAP110_LBYI on the database management system.
This control group lets you map table names of eight characters or less to 
table names longer than eight characters.
The table name you specify must adhere to the table naming conventions 
for the database management system.

LBYD This option tells the system the table referenced in INI options as LBYD is 
really named DAP110_LBYI on the database management system.

LBYLog This option tells the system the table referenced in INI options as LBYI is 
really named DAP110_LBYI on the database management system.

Option Description
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USING DOCUMANAGE

Studio supports installable interfaces to alternate document management systems 
(DMS). The default DMS is the DAP archive system, but you can also use Documanage. 
To use Documanage, follow these steps:

NOTE: To store an 11.0 resource library in Documanage, you must have Documanage 
version 6.3 SR 2 or version 6.4 SR 1 or higher.

1 Create a table in an ODBC database. You can name the table anything you like. This 
example uses RPEX1LBY. Include in the table the following fields. All fields should 
be of the VARCHAR type:

This table maps to the internally-defined table for Studio. The table corresponds 
to a cabinet in the Documanage environment.

For performance reasons, it is best to add an index on the new table by GROUPID 
and RESOURCEID, as shown on the following window.

Field Description

GROUPID varchar 128 

RESOURCEID varchar 104
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2 Set up an ODBC connection for this database using Data Sources (ODBC) in 
Administrative Tools in Windows 2000 Server. This lets Documanage 
Administrator recognize this database and table for powermapping.

3 Powermap the database table you created (RPEX1LBY in this example) using 
Documanage Administrator.

4 After you powermap the database table, edit the Business Data table to set the 
Part of Folder Key values to Yes for the GROUPID and RESOURCEID database 
fields.

Make sure these values are set 
to Yes.
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5 Create a cabinet. The name of this cabinet (RPEX1LBY in this example) must be 
used in the FAPCOMP.INI file and other Documaker RP INI files that access the 
library from Documanage. To create the cabinet in Documanage Administrator, 
select Cabinet, File, New, and enter the name of your new cabinet (RPEX1LBY in 
this example).

On the Cabinet Definition window, select the table you powermapped from the 
Table list then select the Folder Properties tab and set the Editable values to Yes 
for the GROUPID, RESOURCEID, and UNIQUE_ID database fields.

Once you define the cabinet, select Save, Release, and then Refresh Servers from 
the File menu.

6 Define a category called DMRPLibrary using the Documanage Administrator. Set 
up a storage location under the Storage tab. This is usually DEFAULT/Permanent 
or Temporary. Under the Sub-Categories tab, add these sub-categories:

BDF

DAL

DDT

FAP

FOR

GRP

LOG

XDD

Click here to select the table you 
powermapped
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Here is an example:

7 Next, select the category DMRPLibrary, click the Labels tab, and enter Version in 
the Keyword1 field and Revision in the Keyword2 field.
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8 Next, select the category DMRPLIbrary, click on the Extended Document 
Properties tab, and add the following information:

NOTE: The display order is not important.

As shown here:

Field Data Extended document Display 

name  type Length Required property name Width Order

USERID varcha
r

64 Yes USERID 64 1

USRLEVL varcha
r

2 No USRLEVL 2 2

PASSWD varcha
r

64 No PASSWD 64 3

RESOURC
E

varcha
r

25 No RESOURCE 25 4

MODE varcha
r

25 No MODE 25 5

STATUS varcha
r

25 No STATUS 25 6

CLASS varcha
r

25 No CLASS 25 7

PROJECT varcha
r

25 No PROJECT 25 8
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Documanage creates the table OT_DMRPLibrary in the DMANAGE (DM 
administrative tables) database.

Be sure to select Yes for Folder Update, Folder Insert, Folder Delete, and 
Administrator Authorities in the Authorities section of Documanage Administrator.

9 Load the test master resource libraries (MRLs) into the config RPEX1. Here are the 
necessary FAPCOMP.INI options for Documaker RP: (RPEX1LBY is the Documanage 
cabinet name that contains the objects in this example)

< Config:RPEX1 >

DALFile = RPEX1LBY

DDTFile = RPEX1LBY

DDTLib = RPEX1LBY

FormFile = RPEX1LBY

LbyLib = RPEX1LBY

LogoFile = RPEX1LBY

LogoLib = RPEX1LBY

FormLib = FORMS

BDFFile = RPEX1LBY

GRPFile = RPEX1LBY

FORFile = RPEX1LBY

< DBHandler:LBYSETUP >

Class = DMIL

Domain = FSI

RPCHost = 10.1.10.228

UserID = administrator
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PassWord = 1234589

Debug = No

< DBTable:RPEX1LBY >

SelfIndex = Yes

DBHandler = LBYSETUP

NOTE: The value in the DBHandler option must match the name in the DBHandler:XXX 
control group. For instance, in the above example LBYSETUP is used in both 
places.

10 Create a response file for RPEX1. This response file will add FAP, DDT, DAL, and 
LOGO files into a file called RPEX1.RSP. To create the response file, run the 
LBRYMGR utility in the directory where the FAPCOMP.INI file resides. Use the 
following syntax:

LBRYMGRW /RSP=RPEX1.RSP /INI=FAPCOMP.INI /
FAP=D:\FAP\MSTRRES\RPEX1\FORMS\*.FAP /
LOGO=D:\FAP\MSTRRES\RPEX1\FORMS\*.LOG /
DDT=D:\FAP\MSTRRES\RPEX1\DEFLIB\*.DDT /
DAL=D:\FAP\MSTRRES\DEFLIB\*.DAL

11 Finally, run the response file. For more information on running the response file, 
see Running Response Files on page 251.
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WORKING WITH
LIBRARIES

Studio lets you open a library, add resources to a library, delete, or extract resources 
from a library and edit some of the properties of a resource. You can also run a 
response file, print a list of resources, and view a history of changes made to a 
resource. For initialization settings, Studio uses the INI files referenced in the Studio 
workspace file. The Studio workspace file usually references the FSIUSER.INI and 
FSISYS.INI INI files.

• Opening a Library on page 219

• Adding Resources to a Library on page 221

• Importing Files on page 224

• Importing Libraries on page 225

• Checking Out Resources on page 226

• Checking In Resources on page 228

• Unlocking Resources on page 230

• Promoting Resources on page 231

• Filtering Resources on page 235

• Editing Resource Information on page 237

• Deleting Resources on page 239

• Searching the Library on page 240

• Extracting Resources on page 244

• Expiring Resources on page 248

• Reviewing a History of Resource Changes on page 249

• Running Response Files on page 251
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OPENING A LIBRARY

A workspace is associated with a specific library. When you click on Library, the 
contents of the library appear, as shown below. This is known as the Library view.

Understanding the System Once you are in Studio, there is no visible difference between a standard library, a 
DBMS library, or a Documanage library. You are only concerned with the library type 
when you are creating a new workspace or using Manage, Settings, Libraries to define 
a new library.

Here you see all the resources in the library along with their type, version/revision, 
effective date, description, last modified date, mode, status, class, and project, along 
with information about the user who created the resource and whether or not it is 
locked.

From this window you can perform these tasks:

To Do this

Check out a 
resource

Highlight the resource and right click. Then choose Check Out.

Check in a resource Highlight the resource and right click. Then choose Check In. The 
Check In window appears.

Unlock a resource Highlight the resource and right click. Then choose Unlock.

See a history of the 
changes made to the 
resource

Highlight the resource and right click. Then choose History. The 
Library Log window appears.
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Save a copy of the 
resource to disk

Highlight the resource and right click. Then choose Extract. The 
Extract Library Resources window appears. From this window you 
can specify where to extract the resource and other options.

Print a listing of the 
resources

Right click in the list of resources and choose Print this Window. 
This prints a list of all the resources currently being shown. You 
can use the Filter tab to limit that list to only those resources you 
want to see. For instance, you can choose to see only DAL scripts 
or FAP files.

To Do this
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ADDING RESOURCES TO A LIBRARY

When you add resources to a library, the system writes information about the resource 
into the index portion of the library and places the resource itself in the data portion of 
the library.

There are several ways to add a resource to your library. For instance, you can use the 
Library, Import Files options to add several files at once. See Importing Files on page 
224 for more information. You can also add a single resource to your library.

To add a single resource to your library, you simply choose the File, Check In option. 
For example, suppose you have opened a bitmap file and you want to check it into the 
library as a LOG file.

Follow these steps:

1 Choose File, Check In. The Save As window appears. 

1 Make sure you have the name and location you want to assigned to the resource 
and click Save. The Check In window appears.
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2 Make entries into the following fields as necessary:
Y

Field Description

Description You can enter up to 100 characters to indicate what type of change 
was made to the resource. This field defaults to the contents of the 
Description field of the resource checked out, but you can enter a 
different description if you like. 
The Description field appears on the Check Out Image window that 
appears when you select a file to check out.

Increment 
Version

Check this box if you want Studio to increment the version number. 
If you only make a minor change you will probably want to just 
increment the revision number and not the version number. The 
revision number is automatically incremented by one if you do not 
check the Increment Version field. 
If you make a major change, or if you need to change the effective 
date of the resource that you are checking in, check the Increment 
Version field. This tells Studio to increment the version number by 
one and set the revision number to one.
Once this field is checked, you can modify the Effective Date field. 
This makes sure all revisions of a resource have the same effective 
date. When a resource is checked out, changed, and checked back in, 
the older version/revision combinations of that resource remain in 
the library and can be loaded by the GenData and GenPrint programs 
or retrieved by Documaker Workstation or Docupresentment as 
needed.
Keep in mind, however, you can only check out the latest revision of 
each version of a resource.

Effective 
Date

All revisions of a specific version of a resource must have the same 
effective date. This field is only available if you check the Increment 
Version field.
The effective date defaults to MM/DD/YYYY, but may have a different 
format depending on your locale setting.
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3 Click Ok when finished or Cancel to exit without checking in the file.

Mode Use this field to assign a mode to the resource as it is checked in. For 
instance, you can use the Mode field to specify where in the 
development cycle the resource is.
See Defining Mode, Status, Class, and Project Options on page 252 
for information on how to set up modes.

Status Use this field to assign a status to the resource as it is checked in. For 
instance, you could use the Status field to indicate whether a 
resource has passed or failed testing.
See Defining Mode, Status, Class, and Project Options on page 252 
for information on how to set up statuses.

Class Use this field to assign a class to the resource as it is checked in. For 
instance, you could use the Class field to indicate the market in which 
a resource was applicable.
See Defining Mode, Status, Class, and Project Options on page 252 
for information on how to set up classes.

Project Use this field to assign a project ID to the resource as it is checked in. 
For instance, you could use the Project field to indicate which project 
a resource was associated with.
See Defining Mode, Status, Class, and Project Options on page 252 
for information on how to set up projects.

Field Description
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IMPORTING FILES

You can use the Library, Import Files option to add a number of files into your library. 
When you choose this option, the Import Files window appears:

You can use the Browse buttons to select the files you want to import. When you finish, 
click Ok and Studio adds them to the library. You can then modify the property settings 
as necessary.
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IMPORTING LIBRARIES

You can use the Library, Import Library option to import resources from another library 
to the workspace library. You can only import resources from a library that is in xBase/
CARFile format. You cannot import resources from a library that is in a DBMS format or 
one that is in Documanage.

When you choose this option, the Open window appears:

When you select a library and click Open, the following window appears:

You can click Cancel to stop the import. Studio lists the resources as it imports them in 
the Status bar. If you right click in the Status bar and select Print, you can print a list of 
the resources it imported.
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CHECKING OUT RESOURCES

Studio lets you check out resources, edit them and check them back in. While you have 
a resource checked out, it is locked and others cannot check it out, although they can 
open it in view-only mode.

There are several ways to check out resources. For instance, to check out an image you 
simply double click on Images, then select the image you want to check out on the 
Open File window and click Ok.

Another way to check out a resource is to double click Library in the workspace to bring 
up the library view, then right click on a resource in the library view and select Check 
Out.

NOTE: You can only check out the latest revision of a specific version of a resource. 
You cannot, for example, check out version 1.4 of Q1SNAM if a version 1.5 
exists.

When you check out a resource, this is what happens:

• In the library index record for the resource you are checking out, the RecStatus 
column is set to LOC and your user ID is placed into the UserID column.

In the library index, the Locked column will now contain a green check mark to 
indicate you have checked out the resource (a red check mark indicates another 
user has checked out the resource).

• A long (or versioned) resource name for the resource is created and the resource 
is retrieved from the library and placed onto disk with the long file name. The long 
file name consists of the resource name concatenated with the version, revision 
and effective date of the resource. For example, if version 2, revision 3 of Q1ADDR, 
with an effective date of 4/21/2007 is checked out, it will be written to disk with 
this name:

Q1ADDR_0000200003_20070421.FAP

Red check marks 
indicate resources 
checked out by other 
users.

Green check marks 
indicate resources you 
have checked out.
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The file is marked as a read/write file. The version, revision, and effective date for 
the resource appear on the title bar so you can tell which version/revision of the 
resource you are editing.

The resource is stored on disk in the appropriate directory. You specify these 
directories in the MasterResource control group, as shown below:

< MasterResource >

BDFLib = \BDFLIB

GRPLib = \GRPLIB

FORLib = \FORLIB

FormLib = \FORMS

DDTLib = \DEFLIB

LogoLib = \FORMS

DEFLib = \DEFLIB

D

Option Description

BDFLib BDF (business definition) files are stored here.

GRPLib GRP (group) files are stored here.

FORLib FOR (form) files are stored here.

FormLib FAP files (images) are stored here.

DDTLib  DDT files are stored here.

LogoLib Logo (LOG) files are stored here. This is often the same directory used for 
FAP files.

DEFLib DAL (Document Automation Library) files are stored here.
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CHECKING IN RESOURCES

Once you finish making changes, you can check in the resource.

When you check in the resource, Studio asks for information the system needs to 
assign the appropriate version, revision and effective dates.

To check in a resource follow these steps:

1 With the resource open, choose File, Check In. The Check In window appears.

2 Make entries into the following fields as necessary:
Y

Field Description

Description You can enter up to 100 characters to indicate what type of change 
was made to the resource. This field defaults to the contents of the 
Description field of the resource checked out, but you can enter a 
different description if you like. 
Your entry in the Description field appears in the grid displayed on 
the Open File window and in the Library view. 

Increment 
Version

Check this box if you want Studio to increment the version number. 
If you only make a minor change you will probably want to just 
increment the revision number and not the version number. The 
revision number is automatically incremented by one if you do not 
check the Increment Version field. 
If you make a major change, or if you need to change the effective 
date of the resource that you are checking in, check the Increment 
Version field. This tells Studio to increment the version number by 
one and set the revision number to one.
Once this field is checked, you can modify the Effective Date field. 
This makes sure all revisions of a resource have the same effective 
date. When a resource is checked out, changed, and checked back in, 
the older version/revision combinations of that resource remain in 
the library and can be loaded by the GenData and GenPrint programs 
or retrieved by Documaker Workstation or Docupresentment as 
needed.
Keep in mind, however, you can only check out the latest revision of 
each version of a resource.
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3 Click Ok when finished or Cancel to exit without checking in the resource.

This is what happens when you check in a resource:

• The contents of the long (or versioned) resource file are written to the data portion 
of the library and the long file name is deleted. For example, if you had originally 
checked out version 2, revision 3 of Q1ADDR FAP, with an effective date of 4/21/
2007, the file written to disk during check out would have a long file name of:

Q1ADDR_0000200003_20070421.FAP

During check in, after this file is added to the data portion of the library, the file is 
deleted from disk.

• A new library index record for the resource is added to the library index file. This 
record contains the name, type, version, revision, effective date, modification 
date, description, mode, status, and so on of the resource.

Note the version or the revision, or both, of this library index record differs from 
those of the library index record for the resource originally checked out.

Effective 
Date

All revisions of a specific version of a resource must have the same 
effective date. This field is only available if you check the Increment 
Version field.
When you enter an effective date, keep in mind the date must be 
equal to or later than the effective date of the prior version of the 
resource.
The effective date defaults to MM/DD/YYYY, but may have a different 
format depending on your locale setting.

Mode Use this field to assign a mode to the resource as it is checked in. For 
instance, you can use the Mode field to specify where in the 
development cycle the resource is.
For more information, see Defining Mode, Status, Class, and Project 
Options on page 252.

Status Use this field to assign a status to the resource as it is checked in. For 
instance, you could use the Status field to indicate whether a 
resource has passed or failed testing.
For more information, see Defining Mode, Status, Class, and Project 
Options on page 252.

Class Use this field to assign a class to the resource as it is checked in. For 
instance, you could use the Class field to indicate the market in which 
a resource was applicable.
For more information, see Defining Mode, Status, Class, and Project 
Options on page 252.

Project Use this field to assign a project ID to the resource as it is checked in. 
For instance, you could use the Project field to indicate which project 
a resource was associated with.
For more information, see Defining Mode, Status, Class, and Project 
Options on page 252.

Field Description
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• The library index record for the resource originally checked out is updated so the 
RecStatus column is changed from LOC to blank. This shows the resource is no 
longer checked out.

On the Open File window and in the Library view, Studio removes the green check 
mark that was in the Locked column.

UNLOCKING RESOURCES

When a resource is checked out it becomes locked. You can tell which resources are 
locked and by whom by looking at the Locked and User columns of the Open File 
window, shown here:

Only the user who has locked the resource can resume editing the resource or unlock it.

There are several ways to unlock a resource:

• If you are editing a resource and you want to unlock the resource, choose the File, 
Unlock option. A window appears telling you your changes will be lost if you 
unlock the resource and asks whether you want to unlock it. Click Yes to unlock the 
resource.

• Double click on Library in the workspace. From the Library view, right click on the 
resource you want to unlock and choose Unlock from the popup menu.

• If the resource is in the workspace and has a green check mark next to it, you can 
either right click on the resource and choose Unlock from the popup menu or 
highlight the resource and choose Unlock from the File menu.

This file has been 
checked out by the 
current user (ADMIN)

These files have been 
checked out by other 
users
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PROMOTING RESOURCES

You can promote one or more resources from one library to another and in the process 
have Studio modify the Mode, Status, Class, and Project fields. When you choose the 
Library, Promote option, the Promote Resources window appears.

NOTE: You must have sufficient access rights to promote resources. If this option is 
unavailable to you, contact your system administrator.

Identifying the resources
to promote

On the Promote Resources window, you use the Source Library options to tell Studio 
which resources you want to promote.

Field Description

Library Select the name of the library that contains the resources you want to 
promote.

Name Enter the name of the resource you want to promote. You can use wildcards 
and enter a partial name to have Studio promote a group of similarly named 
resources. For instance, brt* tells Studio to select all resources with names 
that start with brt.
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Changing the Mode,
Status, Class, and Project

values in the source
library

In addition, you can have Studio change the Mode, Status, Class, and Project values for 
resources in the source library after they are successfully promoted. For instance, you 
can tell Studio to select resources with a Mode of DEV, promote them, then change the 
Mode value in the source library to TEST. You do this in the Source Library fields, as 
shown here:

Type Select the type of resource you want to promote. You can choose from any 
type of resources stored in a library or specify that you want any resource 
that meets the other criteria. 

Version You can specify that you want Studio to include all versions or just the last 
version.

Revision You can specify that you want Studio to include all revisions, just the last 
revision, or only expired (EXP) revisions.

Mode Select which mode you want Studio to look for when selecting resources to 
promote. For more information, see Defining Mode, Status, Class, and 
Project Options on page 252.

Status Select which status you want Studio to look for when selecting resources to 
promote. For more information, see Defining Mode, Status, Class, and 
Project Options on page 252.

Class Select which class you want Studio to look for when selecting resources to 
promote. For more information, see Defining Mode, Status, Class, and 
Project Options on page 252.

Project Select which project ID you want Studio to look for when selecting resources 
to promote. For more information, see Defining Mode, Status, Class, and 
Project Options on page 252.

Field Description

Scroll down to define the 
final values in the source 
library

Field Description

Mode Select which mode you want Studio to assign after it moves a copy of the 
resource into the target library. For more information, see Defining Mode, 
Status, Class, and Project Options on page 252.

Status Select which status you want Studio to assign after it moves a copy of the 
resource into the target library. For more information, see Defining Mode, 
Status, Class, and Project Options on page 252.y

Class Select which class you want Studio to assign after it moves a copy of the 
resource into the target library. For more information, see Defining Mode, 
Status, Class, and Project Options on page 252.



Working with Libraries

233

If you do not want these values to change, simply ignore the Source Final Value fields.

Defining the target library Next, you must define the target library. Click in the Library field to select the library to 
which you will promote resources.

After you identify the target library, you can tell Studio the values you want assigned 
to the resources it will promote after it moves those resources into the target library.

If you do not want these values to change, simply ignore these Target Library fields.

Using a promotion script You can save your resource promotion settings and reuse them. To save your settings, 
enter a name for the script in the Script File field and click Save Script. Studio appends 
an LSC extension onto the name you entered and stores the script in the DEFLIB 
directory.

To open a script, click Open Script and choose the script you want to run or edit. You 
can clear the settings from a script by clicking Clear Script.

Project Select which project ID you want Studio to assign after it moves a copy of the 
resource into the target library. For more information, see Defining Mode, 
Status, Class, and Project Options on page 252.

Field Description

Click here to select the 
target library

Field Description

Mode Select which mode you want Studio to assign after it moves the resource 
into the target library. For more information, see Defining Mode, Status, 
Class, and Project Options on page 252.

Status Select which status you want Studio to assign after it moves the resource 
into the target library. For more information, see Defining Mode, Status, 
Class, and Project Options on page 252.

Class Select which class you want Studio to assign after it moves the resource into 
the target library. For more information, see Defining Mode, Status, Class, 
and Project Options on page 252.

Project Select which project ID you want Studio to assign after it moves the resource 
into the target library. For more information, see Defining Mode, Status, 
Class, and Project Options on page 252.
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Performing the Promotion

Once you define the promotion settings, click Build List to have Studio create a list of 
the resources that qualify for promotion.

Inspect the resources shown in the list. If necessary, make changes to your selection 
criteria and build the list again. When you have the list as you want it, click Preview. 
Studio runs a test promotion and shows you the results. 

NOTE: At this point, no changes have been made. Preview simply shows you what the 
result of your promotion script would be if you actually ran it.

If necessary, make changes to your selection criteria and preview the promotion again. 
When you are satisfied with the results, click Promote Now to promote the resources.

Studio tells you 
how many 
resources it 
selected and lets 
you scroll through 
the list
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FILTERING RESOURCES

To make it easier to work with resources, you can apply a filter to select a subset of your 
resources. For instance, you can apply a filter to see only FAP files (images) or only 
logos with a given effective date. The filter tab is available on the Open File window and 
in the Library view. 

To create a filter, click the Filter tab:

Field Description

Name Enter the name or partial name of a resource or group of resources. You 
can use wildcards in your entry. For instance, bil*.fap will give you all 
the FAP files with names beginning with bil.

Type Select the type of file you want to filter on. You can choose from all types 
of files stored in the library.

Version Choose either all or last to see all versions or only the last version.

Revision Choose all, last, or EXP to see all revisions, only the last revision, or only 
expired revisions

Effective Date Check this field and then select the effective date you want to filter on.

Locked Choose from yes, no, or any to see only locked files, only files that are 
not locked, or any file.

User ID Enter a user ID to see only files assigned to that user.

Mode Select which mode you want to filter on.

Status Select which status you want to filter on.

Class Select which class you want to filter on.
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Click Save Script to save this filter script so you can reuse it.

NOTE: If you save a filter script, Studio remembers the script name and tries to use 
that script the next time you open the Open File window or the Library view. To 
prevent Studio from remembering the script and trying to use it the next time, 
remove the script name before you exit this window.

Project Select which project ID you want to filter on.

Script Name Enter a name for the filter script you are creating or enter the name of 
the script you want to retrieve.

Field Description
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EDITING RESOURCE INFORMATION

The steps below tell you how to edit the Description, Effective Date, Mode, Status, 
Class, and Project fields for a resource. 

1 From the Library view, highlight the resource whose properties you want to modify 
and click the Properties tab.

2 Make your changes. You cannot edit some fields, such as the version number. This 
table discusses the fields you can edit:

Y

These prompts guide you 
through the fields.

Click Update Resource to 
save your changes.

Field Description

Effective 
Date

All revisions of a specific version of a resource must have the same 
effective date. The effective date for a resource must equal or fall 
after the effective date for the prior version of that resource. Studio 
prevents you from entering a prior date.
The effective date defaults to MM/DD/YYYY, but may have a different 
format depending on your locale setting.

Description You can enter up to 100 characters to indicate what type of change 
was made to the resource. This field defaults to the contents of the 
Description field of the resource checked out, but you can enter a 
different description if you like. 
Your entry in the Description field appears in the grid displayed on 
the Open File window and in the Library view.

Mode Use this field to assign a mode to the resource as it is checked in. For 
instance, you can use the Mode field to specify where in the 
development cycle the resource is.
For more information, see Defining Mode, Status, Class, and Project 
Options on page 252.
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3 Click the Update Resource icon on the toolbar to record your changes.

Status Use this field to assign a status to the resource as it is checked in. For 
instance, you could use the Status field to indicate whether a 
resource has passed or failed testing.
For more information, see Defining Mode, Status, Class, and Project 
Options on page 252.

Class Use this field to assign a class to the resource as it is checked in. For 
instance, you could use the Class field to indicate the market in which 
a resource was applicable.
For more information, see Defining Mode, Status, Class, and Project 
Options on page 252.

Project Use this field to assign a project ID to the resource as it is checked in. 
For instance, you could use the Project field to indicate which project 
a resource was associated with.
For more information, see Defining Mode, Status, Class, and Project 
Options on page 252.

Field Description
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DELETING RESOURCES

You must be a library or system administrator or have been assigned the specific right 
to delete library resources. If you do not have the appropriate rights, the red X icon 
shown below will not be enabled.

In all but very rare circumstances, if you have ever used the resource, you should not 
delete it. For example, suppose a form was used when a policy was archived and you 
later delete that form. If you later try to retrieve that form from archive, you will 
encounter problems because the system will not be able to load the form you deleted.

If you delete a resource from the library while it is checked out, you cannot later check 
in the resource. If you try, Studio tells you the resource has not been checked out. You 
would then have to close the resource and delete it from disk.

NOTE: When you delete a resource from the library, Studio does not remove the file 
from disk if you had it checked-out or extracted a copy there. Studio merely 
removes the resource from the library. Once removed, you cannot undo this 
action.

To delete a resource from Library Manager, first select the resource. Then, on the 
Properties tab for the resource, click the red X, as shown below.

Studio warns you that you cannot undo this action and lets you confirm the deletion.

Click Yes to delete the resource you selected. Studio then deletes the resource from the 
library and from your hard disk.

Click here to delete the 
selected resource.
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NOTE: There is a Delete option on the pop-up menu for the Workspace window and a 
Delete button on the Workspace List window. These options delete a file from 
disk and do not affect the library storage of the selected item — assuming it 
came from the library. Unlike deleting a resource from the library, you do not 
have to have special rights to use these Delete options.

SEARCHING THE LIBRARY

You can use the Library, Search option to identify resources that reference (or contain) 
other resources or resource elements. For instance, since FAP files can contain 
references to logos (LOG resources), variable fields, rule names, and text labels, you 
can use this option to search the library for FAP files that contain a given field name or 
that use a certain rule.

When you choose the Library, Search option, the Search Library window appears.

Defining the resources Use the Search Source fields to identify the resources you want to search. You must 
limit your search to a specific type of resource.
Y

Field Description

Library Select the library in which the resources are stored.
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Defining the objects Use the Search Objects fields to identify specific objects within the resources you want 
to search for. For instance, these fields let you search for a specific field on FAP files or 
a specific group within business unit files.

The fields change, depending on what you select in the Type field in the Search Source 
fields. For instance, if you chose FAP files in the Type field, you see these fields:

Name Enter the name or partial name of a resource or group of resources. You 
can use wildcards in your entry. For instance, specifying a type of FAP and 
a name value of bil* tells Studio to search all FAP files with names that 
begin with the letters bil.

Type Select the type of resource you want to filter on. You can choose from 
these types of resources: BDF, GRP, FOR, and FAP.

Version Choose either all or last to see all versions or only the last version.

Revision Choose all, last, or EXP to see all revisions, only the last revision, or only 
expired revisions

Mode Use this field to tell Studio to include only those resources assigned the 
mode you specify.

Status Use this field to tell Studio to include only those resources assigned the 
status you specify.

Class Use this field to tell Studio to include only those resources assigned the 
class you specify.

Project Use this field to tell Studio to include only those resources assigned the 
project ID you specify.

Field Description

Field Description

Type You can choose from Field, Text, Font, Log, Rule (image), Rule (field).
Your selection tells Studio to search for this type of object in the FAP files 
selected using the criteria you specified on the Search Source fields.

Name The name of this field changes, depending on what you chose in the Type field. 
For instance, if you chose Field in the Type field, the name of this field is Field 
Name. If you chose Image Rule, the name will be Image Rule Name.
Enter the name of the field, the font ID, the logo, the image rule, or the field 
rule.
If you chose Text in the Type field, the following fields appear:
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Using a search script You can save your search settings and reuse them. To save your settings, enter a name 
for the script in the Script File field and click Save Script. Studio appends an LSC 
extension onto the name you entered and stores the script in the DEFLIB directory.

To open a script, click Open Script and choose the script you want to run or edit. You 
can clear the settings from a script by clicking Clear Script.

Field Description

Text 
Element 
Name

Enter the name of the text element you want to search for. If you leave this 
field blank, Studio identifies all text elements.

Text String Enter the text string you want to search for. 
If you leave this field blank, Studio identifies all text elements that match 
the Text Element Name field. If you left the Text Element Name field blank, 
Studio searches for text elements with any name.

Text Case Choose Insensitive if you do not want Studio to consider the case when 
reaching. Choose Sensitive if you do want the case considered.
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Performing the Search

Once you define the search settings, click Search to have Studio create a list of the 
resources it found based on the criteria you defined.

You can highlight on any selected resource, right click, and perform these tasks:

Click here to start the 
search

The results appear 
here

To Select this option

Check out the resource Check Out. See Checking Out Resources 
on page 226 for more information.

Open the resource without checking it out Read

See the history of changes to the resource History. See Reviewing a History of 
Resource Changes on page 249 for more 
information.

Extract the resource from the library Extract. See Extracting Resources on 
page 244 for more information.

Promote the resource Promote. See Promoting Resources on 
page 231 for more information.

Expire the resource Expire. See Expiring Resources on page 
248 for more information.

Print a list of the resources found Print this Window
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EXTRACTING RESOURCES

You can extract a resource from a library using the Library, Extract option. You can also 
highlight the resource on the Library View or from a list of resources found via a search, 
right click, and select the Extract option.

The Extract Library Resources window appears.

Identifying the resources
to extract

On the Extract Library Resources window, you use the Source Library options to tell 
Studio which resources you want to extract.

Field Description

Library Select the name of the library that contains the resources you want to 
extract.

Name Enter the name of the resource you want to extract. You can use wildcards 
and enter a partial name to have Studio promote a group of similarly named 
resources. For instance, brt* tells Studio to select all resources with names 
that start with brt.

Type Select the type of resource you want to extract. You can choose from any 
type of resources stored in a library or specify that you want any resource 
that meets the other criteria. 
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Defining extract options Use the Extract Options fields to tell Studio which directory or directories to extract the 
resources to. By default, Studio extracts the resources to the location you identified 
using the Path field. You can change this location by clicking on the field and navigating 
to a different location.

If you are extracting several types of resources and you want each resource type to be 
extracted to a specific directory, you can specify the directories by expanding the 
Extract to Different Directories item and specifying a directory for each type.

By default, the extracted resources are written to disk with their long file name. The 
long file name is constructed by taking the resource name, appending an underscore, 
appending the version and revision (five digits each), followed by another underscore, 
followed by the effective date (in YYYYMMDD format) and followed by a file extension 
for the specific resource type, such as BDF or GRP. If you want to extract to the standard 
name of the resource, select No in the Extract to Long File Name field.

Version You can specify that you want Studio to include all versions or just the last 
version.

Revision You can specify that you want Studio to include all revisions, just the last 
revision, or only expired (EXP) revisions.

Mode Select which mode you want Studio to look for when selecting resources to 
extract.

Status Select which status you want Studio to look for when selecting resources to 
extract.

Class Select which class you want Studio to look for when selecting resources to 
extract.

Project Select which project ID you want Studio to look for when selecting resources 
to extract.

Field Description

Click here to define a 
directory for each type of 
resource.

Enter a path to define a 
single directory into which 
the extracted resources will 
be copied.

Field Description

Path Enter a path to extract the selected resources to a specific path.

Extract to 
different 
directories

Click to display fields into which you can define individual directories for 
each type of resource.



Chapter 9
Managing Resources

246

Using an extraction script You can save your resource extraction settings and reuse them. To save your settings, 
enter a name for the script in the Script File field and click Save Script. Studio appends 
an LSC extension onto the name you entered and stores the script in the DEFLIB 
directory.

To open a script, click Open Script and choose the script you want to run or edit. You 
can clear the settings from a script by clicking Clear Script.

Extract to 
long file 
name

Select Yes to use long file names. Select No to use the 8.3 file naming 
convention on extracted resources. 
Long file names are created by taking the resource name, appending an 
underscore followed by the version and revision, then appending another 
underscore followed by the date in YYYYMMDD format, and then adding an 
extension to indicate the resource type. Here is an example:

FileName_0000100001_20041201.fap

Field Description
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Performing the Extraction

Once you define the extraction settings, click Build List to have Studio create a list of 
the resources that qualify for extraction.

Inspect the resources shown in the list. If necessary, make changes to your selection 
criteria and build the list again. When you have the list as you want it, click Preview. 
Studio runs a test extraction and shows you the results.

NOTE: At this point, no changes have been made. Preview simply shows you what the 
result of your extraction script would be if you actually ran it.

If necessary, make changes to your selection criteria and preview the extraction again. 
When you are satisfied with the results, click Extract Now to extract the resources.

Studio tells you 
how many 
resources it 
selected and lets 
you scroll through 
the list.
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EXPIRING RESOURCES

You can expire a resource you no longer wish to maintain. In essence, expiring a 
resource is like retiring a resource. The resource remains in the library, but has EXP as 
its revision number. To expire a resource, highlight the resource on the Library view or 
from a search list and right click. Then choose the Expire option. The Expire window 
appears.

Expiring a resource tells Studio to check into the library another revision of the 
resource, but with EXP as the value of the Revision field.

By default, the expiration date is set to today's date but you can change this date if 
necessary. The expiration date you specify must be greater than or equal to the 
effective date of other revisions within this version and must be less than or equal to 
the effective date of the next version of the resource, if one exists.

On the Expire window, you can also enter a description and set the Mode, Status, Class, 
and Project fields. Once you are satisfied with the values, click Ok to expire the 
resource.
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REVIEWING A HISTORY OF RESOURCE CHANGES

To see what changes have occurred to the resources in your library, choose the Library, 
History option. The Library Log window appears.

Studio shows you a log of all changes to all resources. You can filter this list by 
assigning filter values.

For instance, you can use a filter to see only FAP files which have been checked in by a 
specific user. Here are the fields you can define to create a filter:

Field Description

Name Enter the name or partial name of a resource or group of resources. You can 
use wildcards in your entry. For instance, specifying a type of FAP and a name 
of bil* tells Studio to display the log entries for all FAP files whose names 
begin with the letters bil.

Action Choose from these actions: any, added, checked in, checked out, deleted, 
promoted from after, promoted from before, promoted to, unlocked, updated 
from, or updated to.
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Click Filter Now to apply the filter.

Library Select the library in which the resources are stored.

Type Select the type of file you want to filter on. You can choose from all types of 
files stored in the library.

User ID Enter the user ID for the user on whom you want to filter.

Mode Select which mode you want to filter on.

Status Select which status you want to filter on.

Class Select which class you want to filter on.

Project Select which project ID you want to filter on.

Field Description
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RUNNING RESPONSE FILES

A response file is a file created by the LBRYMGR utility which contains commands and 
data. These commands and data are then read and processed accordingly. There are 
two ways to process a response file:

• Using the LBRYMGR utility (see the Docutoolbox Reference for more information)

• Using Studio

To read and process a response file using Studio, follow these steps:

1 Choose the Library, Run Response File option. The Open window appears from 
which you can select the response file you want to run.

2 Select the response file to process and click Ok. Studio displays messages to show 
you its progress.
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DEFINING MODE, STATUS, CLASS, AND PROJECT OPTIONS

Use the Manage, Settings option to define the Mode, Status, Class, and Project options 
users choose from when checking in a resource. These options are grouped under 
LibraryManager, as shown here:

You can have multiple modes, classes, statuses, and projects.

Option Description

Mode Use this option to set up the modes users will select from in the Mode field as 
they edit resource information. For instance, you can use the Mode field to 
specify where in the development cycle the resource is. You can set up multiple 
options, as shown here:

Mode = DEV;Development

Mode = TEST;Testing

Mode = PROD;Production

These entries set up these modes: DEV, TEST, and PROD. The text after the 
semicolon is an optional description.

Status Use this option to set up the statuses users will select from in the Status field 
as they edit resource information. For instance, you could use the Status field 
to indicate whether a resource has passed or failed testing. You can set up 
multiple statuses, as shown here:

Status = TEST;Test

Status = PASSED;Passed testing

Status = FAILED;Failed testing

These entries set up these statuses: TEST, PASSED, and FAILED. The text after 
the semicolon is an optional description.
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Class Use this option to set up the classes users will select from in the Class field as 
they edit resource information. For instance, you could use the Class field to 
indicate the market in which a resource was applicable. You can set up multiple 
classes, as shown here:

Class = GA;Georgia resource

Class = TX;Texas resource

Class = MD;Maryland resource

These entries set up these classes: GA, TX, and MD. The text after the semicolon 
is an optional description.

Projec
t

Use this option to set up the projects users will select from in the Project field 
as they edit resource information. For instance, you could use the Project field 
to indicate which project a resource was associated with. You can set up 
multiple projects, as shown here:

Project = P001;Project 001

Project = P002;Project 002

Project = P003;Project 003

These entries set up these projects: P001, P002, and P003. The text after the 
semicolon is an optional description.

Option Description
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USING THE
LBYPROC

UTILITY

The LBYPROC utility processes library scripts. Library scripts are XML-based files that 
let you perform actions on a resource library. You can use these scripts for...

• Adding resources to a library

• Deleting resources from a library

• Extracting resources from a library (writing the contents to a disk file)

• Promoting resources from one library to another

• Searching a library for specific elements

• Producing a list of resources that match a designated set of filter values

The scripts are designed so a script can cause the indicated action to be performed on 
more than one resource. For example, a single Promote script can cause many 
resources to be promoted from one library to another and an Extract script can cause 
many resources in a library to be extracted from the library and written to disk.

Here are some example scripts:

<LBYSCRIPT> 

<FILTER> 

<LIBRARY VALUE=".\DEFLIB\MASTER.LBY"/> 

<NAME VALUE=""/> 

<TYPE VALUE=""/> 

<MODE VALUE=""/> 

<STATUS VALUE=""/> 

<CLASS VALUE=""/> 

<PROJECT VALUE=""/>

<DESC VALUE=""/>

<VERSION VALUE=""/>

<REVISION VALUE="last"/>

<USERID VALUE=""/>

<EFFDATE VALUE=""/>

</FILTER> 

<PROMOTE> 

<LIBRARY SRC=".\deflib\MASTER.LBY" TGT=".\deflib\V.LBY"/> 

<NAME VALUE=""/>

<TYPE VALUE=""/>

<VER VALUE=""/> 

<REV VALUE=""/> 

<USERID VALUE=""/> 

<MODE SRC="" TGT=""/> 

<STATUS SRC="" TGT="*"/> 

<CLASS SRC="" TGT="*"/> 

<PROJECT SRC="" TGT="*"/> 

</PROMOTE> 

<ADD> 

<LIBRARY VALUE=".\DEFLIB\MASTER.LBY"/> 

<FILENAME VALUE=".\forms\Q1ADDR.fap"/> 

<NAME VALUE="Q1ADDR"/> 

<DESC VALUE="Added this FAP using LBYPROC"/> 

<TYPE VALUE="FAP"/> 

<SUBTYPE VALUE=""/> 
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<EFFDATE VALUE="20030701"/> 

<VER VALUE="00001"/> 

<REV VALUE="00001"/> 

<MODE VALUE=""/> 

<STATUS VALUE=""/> 

<CLASS VALUE=""/> 

<PROJECT VALUE=""/> 

</ADD> 

<SEARCH> 

<LIBRARY VALUE=".\DEFLIB\MASTER.LBY"/> 

<NAME VALUE=""/> 

<TYPE VALUE="FAP"/> 

<MODE VALUE=""/> 

<STATUS VALUE=""/> 

<CLASS VALUE=""/> 

<PROJECT VALUE=""/> 

<OBJECTTYPE VALUE="LOG"/> 

<OBJECTNAME VALUE=""/> 

<OBJECTTEXT VALUE=""/> 

<OBJECTEXTCASE VALUE=""/> 

</SEARCH> 

<EXTRACT> 

<LIBRARY VALUE="DEFLIB\MASTER.LBY"/>

<NAME VALUE="" TGTNAME="LONG"/> 

<ALLLIB VALUE=".\EXT\"/>

<BDFLIB VALUE=".\EXT\BDFLIB\"/> 

<GRPLIB VALUE=".\EXT\GRPLIB\"/> 

<FORLIB VALUE=".\EXT\FORLIB\"/> 

<FAPLIB VALUE=".\EXT\FAPLIB\"/> 

<DDTLIB VALUE=".\EXT\DDTLIB\"/> 

<LOGLIB VALUE=".\EXT\FAPLIB\"/> 

<DALLIB VALUE=".\EXT\DEFLIB\"/> 

<TYPE VALUE=""/> 

<VERSION VALUE=""/> 

<REVISION VALUE=""/> 

<MODE VALUE=""/> 

<STATUS VALUE=""/> 

<CLASS VALUE=""/> 

<PROJECT VALUE=""/> 

</EXTRACT> 

<DELETE> 

<LIBRARY VALUE=".\DEFLIB\W.LBY"/>

<NAME VALUE=""/> 

<TYPE VALUE="FOR"/> 

<MODE VALUE=""/> 

<STATUS VALUE=""/> 

<CLASS VALUE=""/> 

<PROJECT VALUE=""/> 

</DELETE> 

</LBYSCRIPT>
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TROUBLESHOOTING To help you resolve problems, this topic discusses how to turn on tracing and various 
error messages you may encounter.

TURNING ON TRACING

If you feel Studio is not retrieving the correct version/revision of a resource, or if you 
are experiencing other problems that seem to be related to the use of a library, you can 
use INI options to create a trace file.

You can then use the trace file to determine the date of the resource you requested and 
the effective date of the resource returned by Studio, as well as other library-related 
information. To turn on tracing, specify these options:

< Debug_Switches >

Enable_Debug_Options = Yes

LbyLib = Yes

This table shows you where to place the options and the default file name.

For Documaker RP, Documaker Workstation, and Docupresentment, you can specify 
the name of the trace file using this option:

< Data >

TraceFile = 

NOTE: Turning on the tracing causes a large amount of data to be written to the trace 
file. For optimal performance, only do this when you are testing or 
troubleshooting an implementation.

You may also want to retain the NAFILE.DAT and the POLFILE.DAT files. During retrieval, 
these files are retrieved from archive and are initially written to disk then later deleted. 
To keep these files on disk during retrieval from Documaker Workstation, include this 
option:

< ArcRet >

KeepFiles = Yes

To keep the NAFILE and POLFILE on disk during retrieval from Docupresentment (IDS), 
include this option:

< Attachments >

Debug = Yes

For Specify the options in Default file name

Documaker RP (GenData) FSIUSER.INI or FSISYS.INI trace

Documaker Workstation FSIUSER.INI or FSISYS.INI trace

Docucreate FAPCOMP.INI trace

Docupresentment (IDS) DAP.INI or RPEX1.INI *  dprtrc.log

* RPEX1.INI is commonly-used as the name of the configuration INI file. If the name you 
use differs, substitute that name.
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NOTE: For optimal performance, only turn on the KeepFiles or Debug option when you 
are testing or troubleshooting a system.

HANDLING ERROR MESSAGES

Here are some of the error messages you may encounter:

ORA-00904 The following error message:

[Oracle][ODBC][Ora]ORA-00904: invalid column name

indicates one of the column names in the table is invalid. To determine which table is 
invalid, turn on LBYLIB tracing (See Turning on Tracing on page 256), recreate the 
problem, then examine the trace file and look for the ORA-00904 error message. The 
table referenced immediately before the ORA-00904 message is the one with the 
invalid column.

Note there are column names reserved by Oracle which cannot be used. To remap a 
column name use the ODBC_FieldConvert control group as described in a previous 
section. If you are setting up the tables for the first time, after re-mapping the column, 
you may need to remove the existing table so it can be recreated with the correct 
column names.

This message can also indicate you are trying to reference a column in the table that 
does not exist. Look closely at the trace file and compare the columns referenced in the 
SQL statement, such as SELECT, to the columns of the table as it is defined in the 
database.

ORA-01401 The following error message:

[Oracle][ODBC][Ora]ORA-01401: inserted value too large for column

indicates you are trying to insert a value that is too large for the column. To try to 
determine which table the problem is with, turn on LBYLIB tracing (See Turning on 
Tracing on page 256), recreate the problem, then examine the trace file and look for the 
ORA-01401 error message. The table referenced immediately before the ORA-01401 
message should be the table that contains the column with the problem.

SQL0104N The following DB2 ODBC error message:

42601 -104 [IBM][CLI Driver][DB2/NT] SQL0104N  An unexpected token 
")" was found following "on DAP110_LBYI_R1 (".

Expected tokens may include:  "<index_col_list>". SQLSTATE=42601

indicates that the DB2 driver attempted to create an index for the table. When using the 
DB2 ODBC driver, you should always set the following INI option to No.

< DBHandler:ODBC >

CreateIndex = No
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Chapter 10

Using Dictionaries

Use the Dictionaries option to work with the fields, rule 
files, and extract files you will use in your 
implementation. This topic discusses the following 
topics:

• Working with Extract Files on page 260

• Working with Fields on page 263

• Importing TGA Files on page 264
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WORKING WITH
EXTRACT FILES

The extract dictionary (also known as the SYMBOL.XDD) lets you store information 
about extract file records, as well as fields within records, in a database file format. 
Each record in this database contains all of the information that appears in the rule 
section for a variable field. Other information is also stored in the XDD. You can use the 
extract dictionary in both the field mapping process and the triggering process. This 
topic discusses the creation of and the use of the XDD in the mapping process.

Use of the XDD increases productivity and reliability when mapping since each field 
does not have to be mapped at a detailed level. Instead of entering information for all 
the fields in the Rule section for each variable field on an image, all that is required is 
that the rule XDD be specified for the field rule.

Typically, there is one (see note below) SYMBOL.XDD file per resource library. It is 
stored by default in the DEFLIB directory, under the specified workspace. The XDD is 
used with the rule section of the image at rules processing time. The link to the XDD 
database from the rule section of the image is the use of the XDD rule.

When the rules processor runs, items for the XDD are stored in cache. A thousand 
entries is the default cache number. There are INI options to change this number and 
to control the order of fields being removed (less frequent ore less recent) from cache. 
Use the extract dictionaries option to build the SYMBOL.XDD file.

The XDD file is laid out in a parent-child structure. The top level, parents, are individual 
records in the extract file. Fields within the record are children.

NOTE: You can have a separate XDD file for each line of business. This is specified in 
the BDF file. At conversion time, the MASTER.DDT file, if one exists, and the 
XDB.DBF file, if one exists, automatically import into the SYMBOL.XDD file.
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OPENING AN
EXTRACT

DICTIONARY

There are two ways to open an extract dictionary:

• Using the Manage, Dictionaries, Extract option

• By clicking on Extract in the workspace

The main window that appears when you are managing an extract dictionary is shown 
here.

When you highlight an extract dictionary or the fields it contains, its property 
information appears so you can modify it.

Click here to expand these 
items

You maintain the property 
information here

Property Description

Name Enter a unique name for this entry.

Offset Enter the offset of the data in the extract.

Length Enter the length of the data in the extract.

Rule List any optional rule to run on this data. You can only use the 
DAL ? rule and the GlobalFld rule.

Required Choose one of these options: Not, Host, Operator, Either.

Type Reserved for future use.

Format Reserved for future use.

Mask Include the formatting mask for the data returned by the rule.

Conditional Set to Yes if this entry can be used as a trigger.

Custom format function Reserved for future use.

Multiple occurrence Reserved for future use.
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Description Reserved for future use.

Search mask is an 
XPath

Set to Yes if the search mask is an XPath. Otherwise, choose 
No.

Data Use this field for search masks and rule parameters.

Property Description
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WORKING WITH
FIELDS

Click on Fields to work in a centralized database where the system stores variable field 
attributes for the master resource library. Here you can edit and manage common field 
information.

Storing common variable field information can make setting up and creating FAP files 
faster and more consistent.

Here is an example of the window that appears when you are working with fields:

When you highlight a field, its property information appears so you can modify it.

Click here to add 
a field

Click here to 
delete a field

Click here to 
restore original 
values
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IMPORTING TGA
FILES

Follow these steps to import a Tagcommander (TGA) file:

1 Choose Manage, Dictionaries, Fields.

2 Choose File, Import (not Import Workspace files). On the Open File window, double 
click on Fields.

3 In the Field window, change the Files of Type to TGA, as shown here:

4 Browse for the file you want to import and then press Ok.



265

Chapter 11

Creating Tables

Click on Tables to attach table data to a variable field 
so it is available during data entry.

There are two ways to create a table file: using the 
Tables option, or when you create a variable field using 
the Properties window. The entry screens are the 
same. The Tables option lets you create tables for the 
variable fields you create.

Tables make the entry process quicker and more 
efficient for the end user. Users choose from data in a 
table rather than keying in information. This is 
especially useful, for example, when entering lengthy 
codes. Tables reduce data entry errors and increase 
speed.
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OVERVIEW The data for a table can either be manually entered or merged from a client data source. 
A table file can contain many tables. Each table contains many entries. The entries in 
the tables are the choices available to the data entry user. Each table entry contains 
two parts: a key and a description. A key might be a short abbreviation, such as GA, and 
the description provides a longer and more complete explanation of the key, such as 
Georgia.

Table files reside in the selected master resource library (typically in the Table 
directory). A table file (DBF) can contain multiple tables identified by unique names. 
You can create a new table file, or you can open an existing table file to correspond with 
your image and its variable fields. After you open or create a file, you can add or edit 
tables in the file to meet the particular requirements of the image.

Documaker uses a variety of database files as input and output for various software 
modules. For example, the GenTrn program outputs a transaction file that serves as an 
input to the GenData program. The transaction file is stored as a database file, and as 
such, the transaction file has a pre-defined record structure. This record structure 
specifies the length, type, and order of the fields that contain the information in the file. 

The software modules that use these database files must have access to the record 
structure in order to write data in the proper format and to read that data correctly. This 
is true for all database files. The purpose of DFD (data format definition or just 
definition) files is to provide record structure information to the software modules.

DFD (Data Format Definition) files contain information defining the structure of the data 
contained within a database file. Many common system files are stored in database 
format. For example, in addition to the transaction file already discussed, the new 
transaction, application index, recipient batch, WIP (work in progress), help, and table 
files are all stored in database format. These system database files can be in a variety 
of formats, including Codebase, DB/2, ODBC, and standard sequential files (such as 
flat ASCII files). The record structure defined in the DFD files remains independent, 
regardless of the type of database being used — although there are occasionally 
exceptions for some database specific records.

Not all of these database files require an external DFD file. In some cases, the file’s 
record structure is coded directly into the software modules that access the file. There 
are currently no external DFD files for Documaker help and table database files for this 
reason. However, external DFD files are used with other system database files, in many 
cases, because DFD files allow for easier modification of the database file’s record 
structure, without having to modify the software modules directly.

DFD Files There are several system database files, meaning that these files are written and read 
via calls to the DBLIB data base software library. As already mentioned, these database 
files can be in several formats, including Codebase, DB/2, and flat ASCII. Also, not all 
system database files require a corresponding DFD file because their record structure 
is coded in the software modules that access them.

The following are Documaker database files:

• Transaction files

• New transaction files

• Recipient batch files

• Manual batch files

• Application index files
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• WIP files

• Help files

• Table files

Of the files listed above, only five require an external DFD file. The use of one other DFD 
file is optional.

The WIP file may optionally have an external DFD. If there is no external WIP DFD file, 
the internal record structure as coded in the program is used. The help and table files 
do not support the use of external DFD files.

Of the system database files that require external DFD files, only these actual DFD files 
are required:

• a transaction file DFD

• a recipient batch file DFD

• an application index file DFD

The transaction file DFD is used by both the transaction file and the new transaction 
file. The recipient batch file DFD is used by both the recipient batch files and the 
manual batch files. Finally, the application index file DFD is used by the application 
index file.

So, for installations, these are the only DFD files that possibly need to be configured.

TRANSACTION FILE DFD
The transaction file DFD, commonly referred to as the TRNDFDFL, is used by these 
modules:

• GenTrn

• GenData

• GenArc

The GenTrn program writes out the transaction file using the TRNDFDFL. The GenData 
program reads the transaction file and writes out the new transaction file using 
TRNDFDFL. The GenArc program reads the new transaction file using TRNDFDFL.

File External DFD File

transaction files TRNDFDFL.DFD

new transaction files TRNDFDFL.DFD

recipient batch files RCBDFDFL.DFD

manual batch files RCBDFDFL.DFD

application index files APPIDX.DFD

WIP files WIP.DFD (optional – see below)
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The name of the TRNDFDFL is set in the initialization file in the Data control group as 
follows:

< Data >

TrnDfdFile = TrnDfdFl.Dfd

RECIPIENT BATCH FILE DFD
The recipient batch file DFD, commonly referred to as the RCBDFDFL, is used by these 
modules:

• GenData

• GenPrint

• GenWIP

The GenData program writes out the recipient and manual batch files using the 
RCBDFDFL. The GenPrint program reads the recipient batch files using RCBDFDFL. The 
GenWIP program reads the manual batch files using RCBDFDFL.

The name of the RCBDFDFL is set in the initialization file in the Data control group as 
follows:

< Data >

RcbDfdFile = RcbDfdFl.Dfd

APPLICATION INDEX FILE DFD
The application index file DFD, commonly referred to as the APPIDXDFD is used by 
these modules:

• GenArc

• AFEMAIN

The GenArc program writes out the application index file using the APPIDXDFD. The 
AFEMAIN program reads the application index file using APPIDXDFD.

The name of the APPIDXDFD may be set in the initialization file in the ArcRet control 
group as follows:

< ArcRet >

AppIdxDfd = AppIdx.Dfd

However, the APPIDXDFD name does not have to be set as shown above provided you 
are running the system in a Windows environment. If the APPIDX.DFD name is not 
specified as shown, the system automatically appends a DFD extension to the APPIDX 
name specified in the same group, which is specified as follows:

< ArcRet >

AppIdx = AppIdx

This will not work in an environment that does not support file name extensions, such 
as MVS or OS/400.

In addition to the specifying the name of the APPIDXDFD, other related settings must 
be made in the initialization file to use the GenArc and AFEMAIN programs. These 
changes will be discussed in the Archive/Retrieval setup section.
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FIELD SECTION

The FIELD section lists all the fields in the record structures and the order those fields 
appear in the storage media. The fields are automatically stored internally in the same 
order they appear externally.

Field Format Type Field / Format Description

Name FIELDNAME can have length 
limitations, based upon each 
database type. For instance, when 
using Codebase, the FIELDNAME 
length limit is 10 characters.

Name of the field used by applications to reference 
data in the DFD record. Defaults to FIELDXXX, where 
XXX is the next sequential field number.

Internal Type
BLOB
CHAR_ARRAY
CHAR_ARRAY_NO_NULL_TERM
DATETIME
DECIMAL
DOUBLE
FLOAT
LONG
LONG DOUBLE
NOT_PRESENT 
SHORT
SIGNED CHARACTER
TIMESTAMP
UNKNOWN
UNSIGNED CHARACTER
UNSIGNED LONG
UNSIGNED SHORT
VARCHAR

Data format of field used internally by Docucorp
Binary Large Object
NULL terminated string
character array not NULL terminated
A Docucorp date/time field
expressed as a decimal value
double precision
float single precision
32-bit signed integer
long double precision
not present in this record
16-bit signed integer
a signed character
a Docucorp time stamp
data type is unknown
an unsigned character
32-bit unsigned integer
16-bit unsigned integer
variable length character array

Internal Length Same as External Length except one additional byte is 
added to length to store null termination byte. 
Maximum of 255.

Internal 
Precision 

Same as External Precision. Maximum of 255.

External Type 

Same as Internal Type format types.

Data format of the field on storage media.

Same as Internal Type format descriptions.

External Length Length of field on storage media. This is valid for data 
types CHAR_ARRAY & CHAR_ARRAY_NO_NULL_TERM 
only. It is ignored for all other data types. Maximum of 
255 characters.

External 
Precision 

Number of digits after decimal point. This is valid for 
data types FLOAT, DOUBLE, and LONG_DOUBLE only. 
It is ignored for all other data types. Maximum of 255 
characters.
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NOTE: The external record definition must match the actual records written to or read 
from the database. The internal record definition is provided for easier 
programming use.

KEY SECTION

The KEY section lists fields that are key fields. This field is only used by DB/2 and 
indicates that the field is required. The purpose of defining keys is to define columns if 
a database is being used when WIP and/or Archive is being implemented.

Field Description

Name Defaults to KEY01, KEY02, and so on. Can be changed.

Field list Used for associating the KEYXX with a field already defined in the 
DFD.

Descending If using SQL databases, descending works by issuing the correct 
order by command.
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Chapter 12

Converting Files

Use the Conversion option to convert, change, or 
compile one or more files.

This chapter covers these topics:

• Overview on page 272

• Converting Files into FAP Files on page 274

• Compiling FAP Files into Print Files on page 275

• Converting Logo Files on page 276

• Making Changes to Multiple FAP Files on page 277

• Converting Bitmap Files into LOG Files on page 285

• Finishing a Conversion on page 286
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OVERVIEW The first step is to start a conversion by choosing the Manage, Conversion option from 
the menu or by double clicking on Conversion in the Workspace tree. The Conversion 
Type window appears:

Highlight the type of conversion you want to perform and click Next to move to the next 
page. Click Cancel to exit Conversions.

To See

Import files into a FAP file and, optionally, check them into 
library.

Converting Files into FAP 
Files on page 274

Compile FAP files into PCL, AFP, or Metacode print files Compiling FAP Files into 
Print Files on page 275

Convert graphics files into another format and, optionally, 
check them into library (if converting into the LOG format)

Converting Logo Files on 
page 276
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NOTE: Other conversion options are currently available by running command line 
utilities. Refer to the Docutoolbox Reference for more information.

Make changes to FAP files. This includes: 
• Fixing negative coordinate on an image
• Rotating an image 90 degrees
• Retaining image dimensions 
• Adjusting X and Y coordinates 
• Changing image names 
• Changing DAL calcs into DAL scripts 
• Telling Studio to use 4-digit year date formats 
• Updating variable fields on the image from the FDB 
• Requiring unique field names 
• Deleting fields
• Recalculating coordinates 
• Changing fonts Updating DDT files from FAP files 
• Updating DDT files from the XDB 
• Combining adjacent text labels 
• Combining overlapping text labels 
• Returning to the default colors 
• Changing to print in color 
• Mapping alternative font characters
Many of these options are present in order to adjust 
situations in legacy systems. After the changes have been 
made, the files can optionally be checked into the library.

Making Changes to 
Multiple FAP Files on 
page 277

Convert graphics files into the LOG file format and check 
them into library

Converting Bitmap Files 
into LOG Files on page 
285

To See
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CONVERTING FILES
INTO FAP FILES

You can choose to convert to several file types including:

• Rich text files (RTF)

• PCL print files

• Metacode files

• AFP print files

• Docucorp Compound Document (DCD) files

• CompuSet files

NOTE: There are several utilities you can use to batch convert files into FAP files, such 
as MET2FAP (Metacode to FAP), DCD2FAP (DCD to FAP) and CSET2FAP 
(CompuSet to FAP). See the Docutoolbox Reference for more information.

Click Browse to select the files you want to convert.

Once you have selected the files you want to change, click Next to move to the Finish 
page. See Finishing a Conversion on page 286 for more information.
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COMPILING FAP
FILES INTO PRINT

FILES

You can choose to compile to several file types including:

• AFP print files

• PCL print files

• Metacode files

• Postscript files

Click Browse to select the files you want to convert.

Once you have selected the files you want to change, click Next to move to the Finish 
page. See Finishing a Conversion on page 286 for more information.
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CONVERTING
LOGO FILES

You can choose to convert to several file types including:

• Standard logo files

• Compressed Pack files

• Compressed TIFF files

• Xerox font files

• Xerox image files

• Bitmaps (.BMP)

• Overlays (.OVL)

• Segmented graphics for AFP printers (.SEG)

• JPEG files (.JPG)

Click Browse to select the files you want to convert.

Once you have selected the files you want to change, click Next to move to the Finish 
page. See Finishing a Conversion on page 286 for more information. 
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MAKING CHANGES
TO MULTIPLE FAP

FILES

You make numerous changes to a group of image (FAP) files. Typically, you would use 
this option to convert FAP files created with older versions of the DAP Development 
System into newer FAP file versions. You can also use this option to make global 
changes to a group of FAP files you select.

For instance, you can use this option to:

• Change fonts

• Change field names

• Recalculate font coordinates

• Replace specific characters

• Update FAP files from the Field Database

• Update DDT files from FAP files and the data dictionary

Click Browse to find and select files to run this conversion on. Once the files are 
selected they appear in the grid.

Once you have selected the files you want to change, click Next to move to the Image 
Conversions page. See Finishing a Conversion on page 286 for more information.
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IMAGE CONVERSIONS

The Image Conversions page lets you define changes that apply to the images you have 
selected. 

From this page you can:

To Then

Fix negative coordinates Check the Fix Negative Coordinates field. Negative 
coordinates are not produced by Studio, but some 
users have encountered them when converting print 
streams.

Retain current image 
dimensions

Studio increases an images horizontal or vertical 
dimensions if you place objects outside the images 
borders. To prevent this from happening, check the 
Retain Image Dimensions field.

Rotate images 90 degrees Check the Rotate 90 Degrees field.

Adjust X coordinates Enter the appropriate value in FAP units into the Adjust 
X Coordinates field. FAP units are 2400 units per inch. 
For instance, to adjust by 1.5 inches, you would enter 
3600 in this field.

Adjust Y coordinates Enter the appropriate value in FAP units into the Adjust 
Y Coordinates field. FAP units are 2400 units per inch. 
For instance, to adjust by 1.5 inches, you would enter 
3600 in this field.
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NOTE: Check the Match Case field if you want Studio to consider upper- and 
lowercase letters when it searches for the FAP files to change.

Once you have selected the options you want, click Next to move to the Field 
Conversions page.

Change the names of FAP files Enter the current name of the FAP file in the Old Name 
field and the name you wish to change to in the New 
Name field.

To Then
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FIELD CONVERSIONS

The Field Conversions page lets you make changes that apply to several fields at one 
time. 

From this page you can:

To Then

Change DAL calculations 
into DAL scripts

Check the Change DAL calculations to DAL scripts field.

Format dates using 4-digit 
years

Check the Use 4-digit Year Date Format field to change all 
date fields on the selected images to use 4-digit years. At 
the turn of the century, it may become difficult to tell which 
century a 2-digit year value references. Studio adjusts the 
fields input length if necessary, but makes no other changes 
to the field.

Update fields from the 
Field Database

Check the Update Fields from Database field. Studio 
retrieves all of the information stored in the field database 
except for the font ID.

Use unique field names Check the Require Unique Field Names field if you want 
Studio to check for duplicate field names and warn you if 
any are found. If Studio finds duplicate fields, it appends an 
octothorp (#) followed by a number such as 001 to the field 
name.

Delete fields Check the Delete Fields field if you want Studio to delete all 
variable fields from the images you selected. Studio does 
not delete the fields from the Field Database. You can use 
this option to turn an image into a template which you can 
reuse or as another way of creating overlays.
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NOTE: Check the Match Case field if you want Studio to consider upper- and 
lowercase letters when it searches for the field names to change.

Once you have selected the options you want, click Next to move to the Font 
Conversions page.

Change field names Enter the current name of the field in the Old Name field and 
the name you wish to change to in the New Name field. 

To Then
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FONT CONVERSIONS

The Font Conversions page lets you make changes that apply to several fonts at one 
time.

From this page you can:

Once you have selected the options you want, Click Next to move to the General 
Conversions page.

To Then

Calculate 
coordinates

To have Studio recalculate font coordinates, click the appropriate option. 
Typically, you would use the Retain Bottom, Adjust Top Coordinates 
option so the text would retain its current baselines. 
Click Retain Top, Adjust Bottom Coordinates if you want to keep the top 
coordinates. 
Click Retain Top and Bottom Coordinates if you do not want Studio to 
recalculate font coordinates.

Change font 
IDs

Enter the current ID of the font in the Old ID field and the ID you want to 
change to in the New ID field.
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GENERAL CONVERSIONS

Use the General Conversions page to make general changes to the images you 
selected.

From this page you can:

To Then

Update DDT 
from FAP and 
XDB

To update the DDT files for the images you selected using existing FAP 
and Data Dictionary information, check this field. Studio updates the 
font ID and x and y coordinates. If Studio finds a field name which 
matches one found in the data dictionary, it updates the remaining 
DDT information.

Combine 
adjacent text 
labels

Check the Combine Adjacent Text Labels field to combine text labels 
that are very close into one label. Studio combines text labels if the 
text labels use the same font and have the same baseline. If the text 
areas are located closer than half the width of a space character, 
Studio joins the labels without a space.
If the labels are more than half the width of a space character apart, 
but less than the width of a space character, Studio joins the labels 
with a space between them. If the labels are located more than a 
space apart, Studio does not combine them.

Combine 
overlapping text 
labels

Occasionally, conversions from print streams produce text labels 
which overlap. Check the Combine Overlapping Text Labels field to 
have Studio correct these kinds of problems. 
Note: When working with an image, you can use the Format, Convert 
to text label or Convert to text area options to combine text areas and 
labels you select on a specific image. This option is more often used 
to when print files are converted to FAP files and each character is 
turned into a separate label.
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Once you have selected the options you want, click Next to move to the Finish page. 
See Finishing a Conversion on page 286 for more information.

Broaden text 
area to prevent 
wrapping

Check this option to enlarge your text areas to prevent the text from 
wrapping.

Use the default 
colors

Check the Return to Default Colors field to reset all colors on the 
selected images to the default colors.

Print in color Check the Print in Color field if you want Studio to make all colors 
printable for the images you selected. This option, in effect, checks 
the Print in Color field on each objects Color Selection window.

Map alternate 
characters

Enter the numeric value (0-255) of the current character of the font in 
the Old Character field and the numeric value of the character you 
want to change to in the New Character field. For instance, using code 
page 1004, if you want to change a to ä, you would enter 132 in the Old 
Character field and 133 in the New Character field.
Note: You can test the characters by pressing the ALT key and typing 
the numeric value using the numeric keypad.
Typically, you would use this option to replace a character which 
exists in one code page, but not in another. For instance, some code 
pages include typographical quotation marks (sometimes called 
smart quotes) while others do not. You can use this option to replace 
the typographical quotation marks with standard quotation marks (“).

To Then
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CONVERTING
BITMAP FILES

INTO LOG FILES

Click Browse to select the files to run the conversion on.

Once you have selected the files you want to change, click Next to move to the Finish 
page. See Finishing a Conversion on page 286 for more information.
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FINISHING A
CONVERSION

On the Finish page you can choose to check files into the workspace library or place 
them into a directory.

Click Finish to complete the conversion.
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Chapter 13

Printing Reports

The Reports option in the Workspace tree lets you print 
a variety of system reports. A wizard guides you 
through the process of selecting the information you 
want to appear on the report.

Studio displays the result and gives you the option of 
viewing it on-screen or sending it to your printer.
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GENERATING A
REPORT

When you choose Reports from the Workspace tree, the Reports window appears, as 
shown here.

You can choose from these kinds of reports:

• Base Definition Reports

• Group Reports

• Form Reports

• Image Reports

The following steps take you through the steps for printing reports. Image reports are 
used as an example.

1 Highlight the type of report you want to print and click Next. The Choose Files 
window appears.
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2 Click Browse to choose files from the Open File window.

3 Highlight the files you want included on the report and click Ok. Press CTRL to 
select multiple files. You return to the Choose Files window.
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4 The files you selected appear in the grid. You can use the Delete Row button to 
remove a file of click Clear Grid to remove all files. Once you have the correct set 
of files listed, click Next. The Generate Report window appears.

5 Click Finish to generate the report. Studio displays the report on your screen. Here 
is an example.
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The buttons on this window let you print the current report, print all reports, move 
through the reports, restart the wizard to generate other reports, or close the window.
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Chapter 14

Handling Fonts

Click on Fonts to open and work with the various fonts 
you use on your forms. A font is a collection of letters, 
symbols, and numbers which share a particular 
design. The system lets you organize sets of fonts for 
image creation, viewing, and printing needs.
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OVERVIEW Here is an example of the window that appears:

CHANGING THE POINT SIZE

Follow these steps to change the point size when you are inserting a font:

1 Insert a PostScript font.

2 Enter the point size and click Insert.

To change the point size to something else, enter the new point size in the Point 
Size field:

Click on these tabs to set the dimensions and other properties

The system shows you 
a sample of the font.
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3 Click on the point size of 15.00, then click Change.

Studio changes the 15.00 to match the value in the Point Size field.
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Chapter 15

Testing Your Forms

Click on Test to run the forms you have created in a real 
environment to make sure they perform as you expect 
them to. 

This chapter includes these topics:

• Overview on page 298

• Using the Screen on page 300

• Creating a Test Profile on page 307

• Running a Test on page 310

• Changing Test Properties on page 315

• Modifying the AFGJOB File on page 316

• Deleting a Test on page 317



Chapter 15
Testing Your Forms

298

OVERVIEW When running a test, keep in mind Studio does not execute the GenTrn and GenPrint 
processing steps. When you select an AFGJOB.JDT file you want to use for test, Studio 
creates a copy of that file and modifies it to exclude some rules and include others. One 
of the included rules eliminates the GenTrn requirement. Aside from those top level 
rules replaced in the AFGJOB sections, all the other rules remain where they are.

NOTE: Please note that your original AFGJOB.JDT file is not changed. Studio makes a 
copy of this file and modifies it for testing purposes. Also, unlike an actual run, 
no files are saved to disk.

These rules are not imported into the AFGJOB.JDT file for a test run:

• LoadExtractData

• UpdatePOLFile

• ServerJobProc

• InitPrint

• InsNAHdr

• PrintFormset

• WriteOutput

• WriteNAFile

They could cause problems with the way Studio runs the test or else are simply not 
applicable in the case of the ServerJobProc rule.

NOTE: The Test option does not support custom Proc rules in the JDT file. 

Also keep in mind that you do not have to check in resources to include them in a test 
run. This lets you easily experiment with resources you are developing and only check 
them in once you have corrected any problems.

Breakpoints The breakpoint process stops on most other rules defined in the AFGJOB.JDT file. The 
LoadExtractData rule is, however, an exception. Since a test has no GenTrn processing 
step, the extract data is already loaded. If you execute another LoadExtractData rule, it 
means you are reading a second transaction before processing the first — effectively 
skipping ever other transaction in your extract.

Establishing origins and pagination are tasks that happen sequentially. The origin for 
each is determined when processing encounters that image, until that time the image 
may appear in an incorrect position. Furthermore, the final pagination process does not 
take place until you get to a form set- or transaction-level rule on the reverse 
processing, such as the PaginateAndPropagate rule. This means you may see some 
really long pages, until this occurs.

The breakpoint that occurs when form set reloads is a new one. This happens anytime 
the list of form set images changes outside the normal triggering process. So, if you 
have a DAL rule or some other rule that adds or deletes a form or image beyond normal 
triggering, this event will be a breakpoint.
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Messaging can give you more feedback of exactly what processed and in what order. 
When things are going along nicely, you may want to turn messaging off to reduce the 
clutter you see on the screen. When things are not working as expected, you would 
probably turn on more messaging to get an idea of what is happening.

NOTE: Changes to a logo via DAL or a rule may not appear in the Test view until the 
final document pagination occurs. The change can appear earlier if the image 
that contains the logo is also forced in-lined due to the growth of a text area.



Chapter 15
Testing Your Forms

300

USING THE
SCREEN

Studio places all the tools you need to create test profiles and run tests at your 
fingertips. The screen is your testing area. It is important to become familiar with the 
general screen layout and parts of the screen. Understanding the screen layout will 
help you work quickly and efficiently.

The main window that appears when you are testing your resources is shown here.

Title bar

Menu bar

Tool bar

Workspace

Status bar

Here you set breakpoints View area

Item Description

Title bar The title bar displays the name of the workspace you have open, 
followed by Documaker Studio, and then the name of the test you are 
running. 

Menu bar The menu bar provides the list of available pull-down menus.

Tool bar The tool bar contains a row of icons that provide quick access to 
common options.

Workspace The workspace lets you quickly access different items. It also shows 
which specific resources that are checked out (green check mark), 
which resources are checked out by another user that you would only 
have read-only access to (red check mark), and which resources are 
open in read-only mode or have never been checked into the library.
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USING THE MENU BAR

This section introduces you to the pull-down menus which include additional options 
or are only available when you are working with tests. When you open a test profile, 
Studio adds the Test menu to your menu bar.

NOTE: For information on the standard menus and menu options which are always 
available, see Using System Menus on page 14.

Using the View Menu

The View menu provides additional options you can use when running a test. When you 
select Test, this menu appears:

Status bar The Status bar shows you any messages generated by the test.

Breakpoints The Control Panel tab lets you set breakpoints that tell Studio when to 
pause the test. 

View area Depending on the tab you choose, Studio shows you the forms as they 
are processed, your AFGJOB.JDT file, your extract file, or the DAL script 
you are executing.

Menu Description

View This menu include two additional options you can use when running a test: 
Test Statistics and Test Remote Control.

Test The Test menu provides you with options for managing your tests.

Item Description
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Using the Test Menu

The Test menu provides you with tools to manage the test profiles you create and clear 
breakpoints. When you select Test, this menu appears:

Option Description

Test Statistics Use to display or hide the statistics window.

Test Remote Control Use to display or hide the toolbar icons for starting, pausing, 
stopping, or stepping through a test.

Option Description

Profile Select Use to select a test profile to run or edit.

Profile Properties Use to edit the properties you have defined for a test profile.

Clear All Breakpoints Use to remove all breakpoints you have set.
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USING THE RIGHT-CLICK MENUS

Formset View When running tests, if you click on the Formset View tab to watch the form sets change 
as they are processed, you can right click to see the following menus.

Option Description

Zoom Lets you see a larger or smaller version of the form set.

Ruler

Horizontal Select to display the horizontal ruler. Select again to remove the 
ruler.

Vertical Select to display the vertical ruler. Select again to remove the ruler.

FAPs Select to use FAP units (2400 per inch) on the ruler.

Inches Select to use inches on the ruler.

Centimeters Select to use centimeters on the ruler.

Picas Select to use picas on the ruler.

Points Select to use points on the ruler.

Print Prints a copy of the form set.
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AFGJOB File When running tests, if you click on the AFGJOB File tab to view the JDT file, you can right 
click in the view area to see the following menus.

Option Description

Enabled Lets you turn on or off the processing of a rule. The check mark 
indicates the rule is enabled and will be executed during the test.

Add Rule Lets you add a rule.

Delete Rule Lets you remove a rule form the AFGJOB.JDT file.
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USING THE TOOL BAR

The tool bar provides a quicker way to select options that may be listed on a drop down 
menu. Here is an example of the tool bar shown when you are working with test 
profiles:

Standard tool bar icons Shown below are the tool bar icons that are always available. The icons are listed as 
they appear, from left to right.

Icon Name Description

New 
Workspac
e

Creates a workspace.

Open 
Workspac
e

Opens a workspace.

Close 
Workspac
e

Closes an open workspace.

Toggle 
Workspac
e

Toggles between displaying and hiding the workspace.

New Creates a file.

Open Opens a file.

Save Saves the open file. For instance, if you are making changes to 
the AFGJOB.JDT file, this would save those changes to the JDT 
file used for the test — not your original JDT file.

Print Prints the current object.

Cut Removes an object and places it on the clipboard.

Copy Copies an object and places it on the clipboard.
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Test tool bar icons Shown below are the tool bar icons that appear when you are working with test 
profiles. 

NOTE: You can hide these icons by choosing View, Test Remote Control.

Paste Places an object from clipboard onto the current file.

Undo Reverses your last action

Redo Reverses last undo.

Help Displays the Help window

Icon Name Description

Icon Name Description

Start Lets you start a test.

Step Lets you continue to the next breakpoint

Pause Lets you pause a test. Click Start or Step again to 
resume the test.

Stop Lets you cancel a test.
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CREATING A TEST
PROFILE

Studio includes a wizard to help you set up a test profile to run. This wizard starts 
automatically if you have no tests set up. If you do have test profiles set up, the 
following window appears:

To create a new test profile, click New and follow these steps:

1 When you Click New, the following wizard appears.

Enter a name for the test profile so you can run it later without having to set up all 
the test parameters again. Click Next. The following window appears.

These tests have already been 
set up. 

To choose one, double click on 
it or highlight it and click 
Open.
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2 Here you select an extract file to use in the test. If you only want to test the 
triggers, check the Trigger Run Only field. For this kind of test, you do not need an 
extract file.

NOTE: See Running a Trigger-Run Only Test on page 313 for more information on 
running a trigger-only test.

If your extract file is in XML format, be sure to check the Extract is an XML File field.

Your extract file can include as many transactions as you like, but keep in mind 
that the more you include, the longer it will take for the test to run. The 
transactions you do include should be representative of the data you will actually 
process to get the best results.

Click Next when you are finished. The following window appears.

Click here to browse for an 
extract file.
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3 On this window you select a job definition file (JDT). This file tells the system how 
to run as it performs the test. A JDT file is a text file which tells the system which 
job and form set rules to use as it processes your data. The rules defined in the JDT 
file are run before the system runs rules assigned to specific fields. An example of 
a JDT file is the AFGJOB.JDT file.

If you do not have a specific JDT file you want to use, click the Use Generic Afgjob 
File option.

Click Finish to complete the definition of the test profile. The system then shows 
you the test window:

Click here to browse for a job 
definition (JDT) file.

Studio displays the name of 
the test profile here.

Click here to define 
breakpoints.

This part of the Test window 
shows you statistics.
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RUNNING A TEST Follow these steps to run a test profile you have already defined.

1 Open a workspace, then click on Tests. The following window appears.

2 Highlight the test profile you want to run, then click Open. Studio displays a 
window similar to this one.

To better monitor the test, you may want to resize some of the components of the 
window, like this:

NOTE: These examples only show the Test window itself. You can close the 
workspace to get additional room. When you need to restore the workspace, 
just click View, Workspace.

These tests have already been 
set up. 

To run a test, highlight it and 
click Open.
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3 You can click on these tabs to change the view:

Click here to review the JDT file 
being used during the test.

Click on this tab to see 
changes to the form set as they 
take place.

Click here to view the extract 
file being used. Studio lets you 
view extract files in either 
ASCII or XML format.

Click here to view the DAL 
script being executed

To... Click

Set breakpoints on transactions and rules, turn messages on or off. 
manually trigger form and images, and debug DAL scripts. 
Keep in mind you can change breakpoints while running a test. For 
instance, you can 

Control 
Panel

View information on the current transaction, rule, and image, Statistics

Set up a list of DAL, GVM, or overflow variables to watch. To add a 
variable, click on the plus sign (+). To remove a variable, click on the 
red X.

Watch List

Define the GVM variables for the watch list. To add a variable, click on 
the plus sign (+).

GVM

Define the DAL variables for the watch list. To add a variable, click on 
the plus sign (+).

DAL

Define the overflow variables for the watch lis.To add a variable, click 
on the plus sign (+).

Overflow
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NOTE: To see a list of the GVM, DAL, and overflow variables, click the Start icon on the 
toolbar. As Studio runs through the test, it adds the variables it encounters 
onto the appropriate tab. Once the test finishes, you can then add the variables 
you want to watch onto your watch list.

4 To start the test, click Start on the tool bar, as shown here:

When you start the test, the system runs and relevant messages are shown in the 
status bar.

To start a test, click here

Studio displays messages 
here
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RUNNING A TRIGGER-RUN ONLY TEST

When you run a trigger-only test, Studio displays the following window:

Use this window to enter the Key1 and Key2 fields you want to trigger on.

MANUALLY TRIGGERING

You can use the Manually Trigger Forms and Images option to tell Studio you want to 
manually trigger copies of the forms that comprise the form set.

When you choose this option and start a test, Studio displays the following window so 
you can specify the forms and images you want to trigger on.
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This can be useful when you need to test complicated scenarios without robust data.
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CHANGING TEST
PROPERTIES

You can change the properties associated with a test using the Test, Profile Properties 
option. This includes modifying these properties:

When you choose this option, the following window appears:

Make the appropriate changes and click Ok to accept them or Cancel to exit without 
making changes.

Property Description

Extract File Here you can specify a different extract file to use 
during the test.

Extract File is in XML Format Check this box if the extract file is in XML format.

Import a new AFGJOB Rule Set Here you can specify a different AFGJOB.JDT file to use 
during the test.

Use Library Files only Check this box if you only want to use resource files 
stored in the library.

Run as User This lets you specify the user ID you want the test to 
run under.
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MODIFYING THE
AFGJOB FILE

You can modify the AFGJOB.JDT file Studio uses when running a test by clicking on the 
AfgJob File tab, as shown here:

First, highlight the rule you want to modify, then...

NOTE: You cannot modify extract files or DAL scripts when running tests.

First, click on the AfgJob File 
tab to display the JDT file

If you then highlight a rule, 
you can enable or disable it, 
select another rule, or modify 
the rule parameters

To Do this

Enable or 
disable a rule

Click the check box in the Enabled field. If you disable a rule, Studio 
does not remove it from the file, but will skip over it when running a 
test.

Change the rule Enter a new rule in the Rule Name field.

Change rule 
parameters

Enter the new parameters in the Rule Parameters field.

Delete a rule With the rule highlighted, right click and choose Delete Rule. 
Remember that you can also disable the rule if you want Studio to skip 
it during a test. The Delete Rule option removes it from the JDT file.

Save your 
changes

Click the Save icon on the toolbar.
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DELETING A TEST Follow these steps to delete a test.

1 Click on Tests in the Workspace. The following window appears.

2 Highlight the test you want to delete, then click Delete. Studio lets you confirm 
your decision to delete the test.

Click Yes to delete the test.

These tests have already been 
set up. 

To delete a test, highlight it 
and click Delete.
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Chapter 16

Deploying a Library

You develop resources in Studio within the confines of 
your workspace and the directories you defined for 
that workspace. When you decide to move all or part of 
the resources you have developed into testing or 
production, you copy or deploy the resources to 
another location.

Studio includes features to make this process quick 
and easy to do. This chapter discusses these features 
and includes these topics:

• Creating or Running a Deployment on page 321

• Additional Resources on page 326

• INI Settings on page 327

• Processing the Deployment on page 328
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OVERVIEW You can have as many deployments as you need. For instance, you might have an initial 
test location, a secondary test site, a pre-production site, and a production location. 
Using the deployment features of Studio, you can easily manage these deployments.

You may also do temporary or occasional deployments for reasons other than testing 
and production. For instance, you might do a deployment to a secondary location like 
a backup server or a CD writer. Also, you might deploy to a laptop drive when you are 
going to take a trip and need to take resources with you. Anytime you intend to make 
a copy of development resources, it is a deployment.

NOTE: A deployment only copies resources that have been checked into the library.
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CREATING OR
RUNNING A

DEPLOYMENT

To run a deployment, double-click on Deploy in the workspace window or choose the 
Manage, Deploy option from the menu.

The Deployment wizard appears to lead you through the steps necessary to do a 
deployment of your resources. You can accept the defaults and simply do a total 
deployment or you can manage the details of the deployment via the wizard.

When you choose Deploy, the Deploy Workspace window appears.

This window includes these fields:

Click here to browse to another 
directory.

Field Description

Name The name for the deployment. This is not the same as naming the 
workspace. This name is simply a short descriptive identifier for 
how you want to refer to the deployment you creating or updating.

Path The location of the deployment. Notice the name of the deployment 
is combined with the location path to build the appropriate 
subdirectory name for your deployment.

Deployment 
Script

The deployment script to use. You can identify a previously saved 
deployment script to use or assign a name to a new script you want 
to create.

Save Deployment 
Script

Indicates whether you want the deployment script to be updated 
with the choices you make as you continue using the wizard. If you 
do not check the box, the choices you make are not saved, meaning 
this is a one-time deployment.
If you do save or update the deployment script, the choices you 
make on the remaining wizard windows are saved and will be 
available if you decide to deploy the workspace resources again.

Flat File 
Deployment

Check this box to run a flat-file deployment or leave it unchecked for 
a library deployment.
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Once you have identified the name and location of the deployment and have either 
accessed an existing script, entered a new script, and checked whether you want to 
save the new script, click Next to go to the next step in the wizard. This step differs, 
depending on whether you chose a flat-file or library deployment.

If you chose a Go to

library deployment Creating a Library Deployment on page 323

flat-file deployment Creating a Flat-File Deployment on page 325
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CREATING A LIBRARY DEPLOYMENT

For library deployments, you must choose the library type. On the Choose Library Type 
window you define the library specifications (type, effective date, and name) you want 
to use when the resources are deployed.

Depending upon the type of library database you selected, there may be additional 
questions to answer. For ODBC databases, you must first create the data source names 
using the Windows Control Panel before Studio can address the library database.

Once you have made your selections, click Next. The Library Resources window 
appears.
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Indicate if you want to use all the library resources. Not checking this option and 
clicking the Add Script option tells Studio you want to select specific library resources 
to deploy.

Add Script lets you name one or more promotion scripts you want to use to move 
resources to the deployment destination. The promotion scripts you choose are shown 
in a list. You can add or delete them as needed. In addition, you can click Edit Script to 
edit or create promotion scripts. This takes you to the Library Promotion window. There 
you can develop your script and test it before including it in your list.

Once you have identified the library resources you want to send to the deployment 
destination, click Next to move to the Additional Resources window.
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CREATING A FLAT-FILE DEPLOYMENT

In a flat-file deployment, resources are extracted from your development library and 
copied as external files (not as a library) to the appropriate directory structure in the 
destination. Studio selects the resources it will move based on the effective date you 
enter.

To do a flat-file deployment, check the Flat-File Deployment option and enter an 
effective date. 

Press ESC to close the calendar.

Once you have finished, click Next to move to the Additional Resources window.

Click here to display the 
calendar and select an effective 
date

Check this box to do a flat-file 
deployment
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ADDITIONAL
RESOURCES

You may have files that are not stored in the library but are required by your runtime 
setup. You use the Additional Resources window to include these kinds of non-library 
resources in a deployment.

The Additional Resources window lets you define a list of subdirectories that contain 
supporting files to copy to the destination deployment.

As a rule, Studio expects to copy a file to the same relative location in the destination 
as the directory name where it resides in the development source. For instance, if there 
are DFD files in the DEFLIB\ directory of your development workspace, then Studio 
expects to copy these files into the DEFLIB\ location within the deployment. Likewise, 
DAT files found in the TABLES\ subdirectory of the workspace would be copied into the 
TABLES\ subdirectory of the destination location.

This helps ensure that the deployments resemble the development environment and 
also reduces the number of configuration (INI option) changes you have to make when 
synchronizing resources.

For each major category shown on the dialog, you can include or exclude those 
resources from the deployment process by simply checking or unchecking the 
appropriate box. 

If you should want to include only certain files of a given category, you can drill down 
to the individual file list and check or uncheck the files included in that list.

The Other Resources category is where you identify files that are not known to the 
workspace. Here you can add files including the source location and destination 
location where the file should be copied.

When you are done identifying the additional resource files you want included in the 
deployment, click Next to move to the INI Settings window.
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INI SETTINGS You can modify INI options for your deployment. The INI options shown here are for 
your deployment not the currently open workspace.

By default, if this is your first time to deploy to this location, the workspace settings will 
be used as the basis for your deployment settings. 

Once you finish, click Next to move to the Processing Deployment window.
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PROCESSING THE
DEPLOYMENT

The final wizard window shows you the steps that occur to complete the deployment 
process. When you click Finish, the deployment process begins and as each step is 
started, a check mark appears next to the task item.

As the deployment proceeds, you may see messages scrolling through the output 
window. These messages reflect the details of the deployment process to your 
deployment location.

When all tasks have been completed, the Deployment wizard closes and the success or 
failure of the deployment is indicated in the Status message.
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